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Welcome

This user guide will introduce you to Store Visualizer 25.11. It provides a step-by-step approach to the most
commonly used features and will allow you to quickly familiarize yourself with the software.

We hope you enjoy using Store Visualizer !
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Technical support

You may access help and technical support resources at any time from within Store Visualizer.
Press the “Help” icon located on the left hand side of the bottom toolbar, as shown on the image below.

CI Open product manual
() sStore Visualizer quickstart guide
8

Product support
— Customized 30 environments
|k\_ License management

__ (L’,J) | Ready

Product manual

Selecting the “Open product manual’ option will open the Store Visualizer user guide, which you are currently reading. You may also
press F1 at any time to access this manual.

Store Visualizer quickstart quide

An online quickstart guide is available as a quick and easy step-by-step introduction into Store Visualizer. You can open the quickstart
guide by selecting the second option in the “Help” menu or by clicking the following link: Quickstart guide

Customized virtual 3D stores

Our 3D design studio offers virtual 3D store modeling services according to the needs of your projects. For more information, click on
the following link: Services > Virtual 3D stores

Performance

Several gauges present in the interface enable you to optimize your projects to avoid performance issues. See chapter 24 for more
information.
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Chapter 1 : Interface

Transform ——
& Take snapshot
Quick snapshet

@ Print

Preferences...

© @ | peishti ~ | prosetss o [Clditos

A Figure 1-01

01.

02.

03.

04.

05.

Toolbar and information panel
Sidebar

Contextual menu

Quickbar

Render area

The Store Visualizer user interface is divided into two distinct parts: a horizontal toolbar and information panel at the bottom and a vertical sidebar
on the right hand side. The toolbar provides functions such as navigation and interaction settings and the status of your project. The panel accesses
navigation and interaction toolbars, while the sidebar contains control, scene and project related features. The 3D visualization is displayed on the

large gray area, the render area.

Store Visualizer 25.11
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1.1 _The toolbar and information panel

The “tool” panel, located at the bottom of the screen, is divided into five separate tool bars. They can be enabled by clicking on their respective toolbar
icon on the left hand side of the tool panel (Fig. 1-01).

@ A. Navigation
This toolbar controls how the user navigates and moves through the 3D environments (see chapter 3).

B. Object placement
The object toolbar allows the placement and interactive modification of objects within a 3D environment (see chapter 5).

(

C. Environment

E

This toolbar contains lighting and environment related functions and parameters (see chapter 16).

D. Physics
The Physics toolbar is used to control and configure the physical simulation (see chapter 15).

i
£
o o]

E. Consumer Insights
This tool makes it possible to analyze consumer behavior (see the”Consumer Insights, step by step” guide).

L]

| The entire interface (Toolbar and sidebar) can be made invisible simultaneously by clicking on one of the “Hide interface” icons located to
the left and right extremities of the toolbar. To make the interface reappear, move the mouse pointer into the lower left or right corner of the
screen and click the left mouse button. You may also press the “i” key to toggle interface visibility.

| Full screen mode: press keyboard key F11 to put Store Visualizer in full screen mode. Full screen mode encompasses all elements of the
Windows or Mac interface. Press the F11 key a second time to return the application to windowed mode.

oiC

N
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1.2 The sidebar

The sidebar is the vertical area located on the right hand side of the screen. It is separated into three sections giving access to distinct feature
categories: System, tools and scene (Fig. 1-02). A section can be enabled by clicking on its respective sidebar tab.

[ (8 Project |¢” Tools | Scene
» File 4
& Current project 4l
» Command history 4
» Layers Ll

A Figure 1-02

+ | prosts: o [0

Each section contains a number of rollouts which can be open or closed. Click on a rollout header to open it and a
second time to close it again.

The sidebar is visible by default when running Store Visualizer for the first time. Press the “b” key to toggle the
sidebar visibility. This will allow for a larger view onto the 3D area.

Individual rollouts are detachable and dockable, so to make commonly used features easier for access. Click on the
“small arrow” icon on the right side of a rollout header to detach it (Fig. 1-03). Most sidebar rollouts are resizable
in their detached state, allowing a more efficient usage. They can be docked again to the sidebar by simply closing
them (Fig. 1-04).

Medel browser

EEEEEERE

A Figure 1-03 A Figure 1-04
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1.3 _The contextual menus

The main contextual menu offers the specific functions for project management. Right-click on the empty grey surface (the 3D render area). The
main contextual menu will appear (Fig. 1-05).

New
Open... ctrl-o

| 7| ]

T

Hie® & d"{i

Preferences...

& Quit Alt-Fa
About...

A Figure 1-05

< Other contextual menus are described further in the manual, including the contextual menu for libraries (pages 56, 73), the scenegraph
(page 107), layers and categories (page 96), and the contextual menu for 3D objects placed in the scene (page 74).
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1.4 The quickbar

The quickbar, located by default at the top of the screen, has a selection of icons corresponding to the basic functions of the software. Its functions
will allow you to quickly create a new project, automatically generate shelves, import your 3D models, etc. This bar offers two user profiles by default:
Beginner and Advanced. You can also create your own profiles (see chapter 23.8).

e The Beginner mode includes the following functions:

O

|:_;j ‘ LB O G B | (& | '.':J | {5} << Beginner mode

O O O O O OO0 0o

Create new project: allows you to create a new project from a generic store (see chapter 2.1).

Open a project: allows you to open an existing project (see chapter 2.3).

Open a library: allows you to load a library of 3D models into the project (see chapter 5.9).

Import a 3D model: allows you to import a 3D model into your project (see chapter 5.2).

Import an image: allows you to import an image into your project (see chapter 5.3).

Create a shelf: automatic system for generating standard shelves (see chapter 7.1).

Product viewer: allows you to view the details of a product placed in the project (see chapter 17).

Open product manual: opens a web page containing various user manuals (technical support chapter).
Quickbar settings: allows you to choose between the different modes of the quickbar (see chapter 23.8).

e The Advanced mode includes, in addition to the functions of the Beginner mode, more advanced functions:

G

|:_=J | B & B B | s Y | = | L e |Q3_; < Advanced mode

O O O OO0 0o

Shelf panel position: when shelves are selected, displays additional information about them (see chapter 6.9).
Meta data info panel: toggles the meta data panel when a 3D object is selected (see chapter 14.4).

Model to library: displays the 3D model in the library related to the 3D object selected in the project (see chapter 5).
Toggle lights: allows you to switch on and off the lights of a 3D model selected in the library (see chapter 13).
Current active layers selector: allows you to select the active layer (see chapter 10).

Start or stop the physical simulation: starts or stops the physical simulation (see chapter 15).

Physics drag mode: object movement mode specific to physics when it is active (see chapter 15.4.2).

By default, the quickbar is visible when you start Store Visualizer for the first time. You can close or open it at any time by
clicking on the “Toggle visibility of the quickbar’ icon, located at the bottom right of the screen.

More Actions  +
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Chapter 2 : Start working on a 3D project

In Store Visualizer, your work is organized around projects. You can start a new project from a store template, or download one of the available
templates from our Cloud (see Chapter 2.2) to save time during setup. You can also continue working on a recent project (see Chapter 2.3).

2.1 Cri new proj n r mpl

You can start a new project in two different ways:

<<<<<

| Right click anywhere on the gray empty area (the 3D render area). The main
contextual menu will appear.

o Select File > New.

e The “New project” dialog window will appear (Fig. 2-03).

= « ¢ PN Joo|m

A Figure 2-01

Or alternatively:

In the System sidebar tab, open the “File” panel and select Project > New.

e The “New project” dialog window will appear (Fig. 2-03).

DA O ©veor - | G Civiionn 00| 8

A Figure 2-02

20 Store Visualizer 25.11



The “New Project’ window allows you to start a project from a 3D store template. A list of available templates will be displayed. When you select one,
its details will appear in the right-hand panel.

New project x
[ search projects and templates. | promcT oETALS
B2 Open file
; *l Store dropped classic
B Recent Generic Stores Bl
Sumpiates \2) Free template by\VTales
Cloud LT I
= Template details:
o | = T e S S
b 4 with diffusers
- Size (WxDxH): 13 x 18 x 4 m (234 )
F| ) | - Store Is resizable and reconfigurable
store dropped classic = Store dropped modern Store open concrete
Store open lattice Store open steel full Store open steel
@ Manual = =i Open project

A Figure 2-03

Some Templates have been designed using the “Store generator’” module. They can be recognized by a specific icon. The advantage of these
prototypes is that they are reconfigurable : you can adjust their dimensions or appearance at any time, according to your needs. Download the Store
generator step by step manual for more explanations.

e Select a template from the list and click on Open Project.

¢ A blank project will be created from the selected template. After working on this new project, you will be prompted to save it (see Chapter
2.4). Note: The original template will not be modified.

:ﬁ By default, the Welcome Screen opens when Store Visualizer starts, allowing the user to open an existing project or start a new one. You
~_| can disable the Welcome Screen via Preferences > System > User Interface > Welcome screen.
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2.2 Download a Store Template from the Cloud

By selecting the Cloud tab, Store Visualizer connects to our server to display new store templates available for download. When you select a template,
its details will appear in the right-hand panel. These templates are not yet installed on your computer, so you will be prompted to Download them.
When new store templates become available on the Cloud, “New” banners will appear to notify you.

Welcome to Store Visualizer

x
[ search projects and templates | eroecroerans
B2 Open file = , )
® Recent Stores and malls = Circular mall - Furnished
ta \2) Freetemplate by VTales

Stores and malls
Template details:

Other environments - Customizable shopping mall

- Predefined spaces for 3 individual
stores and a large central atrium

+ Dedicated spaces for branding inside
and outside of the stores

- Grocery store, 400 m*

+ Fashion / clothing store, 400 m*

+ Perfume / Duty free store, 400 m*

oi¥
Circular mall - Furnished Circular mall - Filed Large Mall - Furnished e o o

+ Dedlicated restaurant / food area

+ Decorative cinema / entertainment

+ All stores can be fully customized and
rebranded for other use cases

+ Optimized for VR and consumer
research experiences

+ Includes shelving in all stores

See this template on Youtube

Created : 28/03/2025
Large Mall - Filled Size:24GB

Other environments

» Select a template from the list of available templates on the Cloud and click Download.

-i Please ensure that your hard drive has enough space to download the files and that your graphics card has the required video
memory to ensure optimal project performance on your computer.

EX Download

<[]

A Figure 2-04

* Once the files are downloaded, the store template will be added to the list of Templates (see chapter 2.1).

i The download speed depends on your network connection. You can interrupt the download at any time and resume it later.
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2.3 Opening a project
To open a project, you have three options:

Using the contextual menu (chapter 1.3):
* Right click on the Store Visualizer render area to open the main contextual menu.

o Select: File > Open.

Using the system sidebar (chapter 1.2):
» In the Project section, open the “File” dropdown menu

o Select: File > Open.

Or from the “New Project” window (Fig. 2-03):

¢ In the “New Project” window, click on the tab: Open file.

After selecting one of the three options provided, the “Open file” dialog window will appear:

* Browse through your computers file hierarchy to find the project you would like to open.
* Double click on a project file or select it and click on Open.

* The project will load, and a loading bar will show the progress of the operation.

The time to load a project will vary according to its size and complexity. The larger the project, the longer the loading will take.

Store Visualizer 25.11
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2.4 Opening a recent project

After working on a project, its name appears in the list of recent projects. You can reopen it by double-clicking directly on its name in that list.

You can access the list of recent projects in two ways:

From the “New project” window (Fig. 2-04):

Or, using the system sidebar (Fig. 2-05):

Newprject

[Scarch prolects and tempates

PROJECT DETALS

B Open file
& Templates
@ Cloud

© Manual

only

“| Large Mall -

Furniture

Modified : 26/0312025 17118

£ Open project

‘(ﬂ'} Project |¢# Tools |[ZJ Scene |

v File 4
L3 Project - P2 TS
MName Date

Large Mall - Furniture only_28/03

] i [ [a]¢]

A Figure 2-05

A Figure 2-04

¢ In the “New project” window, click on the Recent tab. The list of
recent projects will appear.

* Double-click the project or click Open Project to open it.

« In the Project section, open the “File” dropdown menu.

« In the list of recent projects, select the name of the desired project, then double-click it to open.

24
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2.5 Saving the project

Using the contextual menu:
* Right click on the Store Visualizer render area to open the main contextual menu.

e Select: File > Save or File > Save as.

» Save will write any modifications to the currently opened project file.

* Save as lets you save the current project under a new file name. The previous project file will not be modified.
Or, using the system sidebar:

 In the system sidebar, open the File panel, and select: Project > Save or Project > Save as.

» Save will write any modifications to the currently opened project file.

* Save as lets you save the current project under a new file name. The previous project file will not be modified.

A small disk icon appears on the bottom information panel if the current project was modified. Clicking it will save all changes to the current
project file, and is identical to the Save operation outlined above.

2.6 Closing a project

Using the contextual menu:

* Right click on the Store Visualizer render area, and select: File > Close.

Or, using the system sidebar:
e In the system sidebar, open the “File” panel, and select: Project > Close.

:g When closing a project with unsaved changes, Store Visualizer will ask whether the modified project should be saved, the modifications
discarded, or if you prefer to cancel the operation.
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2.7 _Save to folder

When you want to share a project, it's not always easy to group together all the elements that make it up (vtpr, 3dw, 13dw, etc). This function allows
you to save the project and everything in it to a new folder that is easy-to-share.

cttofo

Progress report

¥ Remnove unused models from libraries
IV Export static environment

Save Close

A Figure 2-06

Progress report
partment - MISc 17 unused models removed]

Product samples (29 unused models removed)

2 &) Saving project, please wait [
completed

= &) Exporting emvironment textures
144 textures processed

2 &) Exporting static scene
Completed

= &) Exporting emironment.
completed

5 @ Project successfully exported

4] [T

v

[ [«Iv

¥ Remove unused models from libraries

 Right-click in the rendering surface to open the main contextual menu.

e Select: File > Save to folder ...

¢ Your operating system window opens. Enter the project name and click on Save. The “Save project as folder”
window appears (Fig. 2-06). Adjust the parameters and click on Save.

o Remove unused models from libraries: When the function is active, only 3D models positioned in the
project will be saved in the library; all other models will be deleted.

o Export static environment: Included in the saved folder, the store’s static 3D environment.

e The Progress report window shows the steps involved in creating a new folder.

o Saving libraries: Lists the libraries present in the project, as well as the number of unused models that
have been deleted if you have activated this option. If models have been deleted, new libraries will display

a notification (1) behind their name. (Fig. 2-08).

& Ubrary -
Project library Q

® Project library
(&) Apartment - Furniture
E',Apartmemt - Misc - 1

A Figure 2-08

[V Export static environment
Continue Close
A Figure 2-07

File creation time depends on the complexity of the initial project and the number of libraries and 3D

E’ models it contains.

e Once the new folder has been created, you have two options: either Close the current project, or Continue
working in the new project. If you choose the latter, the new project will be automatically loaded.

26
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2.8 Merging a Project

This function allows you to merge the complete content of one project into another. The merged elements include: layers and variations, libraries and
their models, as well as the placement of these models within the project.

* Right click on the Store Visualizer render area to open the main “contextual menu”.
* Select: File > Merge.

* The “Open a project” window appears. Select the project you wish to merge with the currently open project. The merged elements appear in
your project.

ﬁ When a merged object library has the same name as a library in the original project, the notification “merged” is added to the back of the
merged library name.

o= | It is essential that merged projects have the same store area, otherwise objects may end up outside the rendering areal!

2.9 Quitting Store Visualizer
Using the contextual menu:
o Right click on the Store Visualizer render area to open the main “contextual menu”.

e Select: File > Quit.

Or, using the system sidebar:
» In the system sidebar, open the File panel, and select: Project > Quit.

:lg When attempting to quit with unsaved changes, Store Visualizer will ask whether the modified project should be saved, or the modifications
discarded.
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2.10_Current project settings

You can access and modify the currently loaded project parameters at any time by using the “Current project” panel in the System sidebar tab:

v Current project 4l

ITemp\ata - Wines

Example environment for I

A Figure 2-09

Advanced '| |B Author

Project information

D

Units & scales

I

Current project information H

Title Customer demo - Mall 2021
Author  None

Subject  None

Created  vendredi17 janvier 2020 1216
Modified  mercredi 30 juin 2021 15:51

* More information

|1 T

Category Nane
Keywords  Nane

* Project files
Project  F\PROJECTS\CUSTOMER DEMO - MALL 2021\Customer dermo - Mall

Scene  FAPROJECTS\PROJET - DRUPA 2020\Project WIP\Scenesidrupa_210:

7 Statistics
Objects 3333 Models 45

Faces 145755231

A Figure 2-11

[© advanced ~| [E Author | \- Open the “Current project” sidebar panel.
. ! The Project name is displayed at the top.
everages,

I | e This field contains the “project description”, and can be directly edited.

Current project > Advanced
* The “Advanced’ dropdown allows access to project information, project scale and security settings.

Current project > Author
A Figure 2-10 e The “Author’ button opens the project author and categorization window (Fig. 2-10).

Current project > Advanced > Project information > Project

o Title: The current project name.

e Author: The author of the current project.

e Subject: The subject of the current project.

e Created: Date and time when the project was initially created.

» Modified: Date and time of the last modification.

¢ More information: Optional comments about the project.

e Category: The optional project category name.

» Keywords: The optional keywords associated with the project.

» Project files: The physical location of the project (vtpr) and scene (3dw) files.
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Select the units for the current project:

[ Distance unit |

Wetric - milmetars Current project > Advanced > Units & Scales
Metric - centimeters

HEtie mets This dialog changes the general units used to measure distances, surface area and weight in the current project.
U.s - feet

[weight unit ¢ Distance unit: Unit of measure used for distances and surfaces.

Metric - grams

Metric - kilograms * Weight unit: Unit of measure used for weight.

U.S - pounds

A Figure 2-12

[roject author

Current project > Author

Author: |

Subject: | o Author: The author of the current project.
* Subject: Optional project subject.
» Category: Optional project category name (used for file search by Windows).

* Keywords: Optional project keywords (used for file search by Windows).

Category: |

Keywords: |

A Figure 2-13
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Chapter 3 : Navigating through a 3D environment

A 3D environment project offers great flexibility to design and organize various virtual spaces tailored to your needs. Using Store Visualizer’s design

and editing tools, you can add and customize store-specific elements such as shelves, displays, and showcases, then populate these spaces with
products to simulate shelving layouts.

Although primarily designed for virtual store environments, Store Visualizer can also simulate other types of 3D spaces, such as homes, showrooms,
industrial spaces and so on.

Store Visualizer gives you total freedom of movement in the simulated space and interaction in all the 3D models presented.
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3.1 _Navigation modes

@ » Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
* The navigation toolbar appears, and is now active.

o @ | Height: 164 cm ~ Level; 0 | Presets: Iﬁ'_lril | Click to select a camera - ‘ \r ‘ %
Several different ways to navigate through a realtime 3D environment exist:
3.1.1 The “FREE LOOK” mode
==  Click on either the “Free look” icon, the Middle mouse button (often the scrollwheel !), or the Spacebar to enable free look mode.
o The mouse cursor and the toolbar will disappear, and the free look mode is activated.

* By using the mouse or keyboard, you can freely navigate through the 3D environment:
o Moving:

= Click and hold the left mouse button or press the arrow up key to move FORWARDS

= Click and hold the right mouse button or press the arrow down key to move BACKWARDS
= Press the right arrow key to move sideways to the RIGHT
= Press the left arrow key to move sideways to the

o Turning and looking around:
= Move your mouse upwards in order to look up (see note below)
= Move your mouse downwards in order to look down (see note below)
= Move your mouse to the left in order to turn to the left
= Move your mouse to the right in order to turn to the right

o Exiting the free look mode:

= Click on the Middle mouse button (or the Spacebar) a second time, and the
mouse pointer will reappear.

hd

<
&

A

A

!

L

N

D

+

- You can modify the speed (chapter 3.2) and sensitivity of your movements (chapter 23.1). You may also flip the up and downwards
directions of your mouse (Select: File > Project > Preferences > System settings > Interactivity > Navigation settings > Invert vertical

mouse).
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3.1.2 The “WALKTHROUGH” mode

Without using the free look mode, you may still navigate through your project using the “Walkthrough” mode. The mouse pointer will stay visible
and allow normal access to the application in this mode.

Walkthrough mode is disabled by default. You can enable it in the Preferences: System > Interactivity
> Enable walkthrough.

o Moving:
= Click and hold the left mouse button in order to move FORWARDS.
= While moving, point the mouse cursor into the direction you would like to walk.

:g The walkthrough mode is more limited in movement freedom than the freelook mode, but keeps the mouse cursor visible instead.

3.1.3 Orbiting around a target

You may move in circles around a certain point or object using the “Target orbit mode” :

 Click on the “Orbit’ button. Store Visualizer will query you for an orbit center position.

« Point the cursor onto the object or location you would like to orbit around, and left click your mouse to confirm.

 To circle around the selected location, click and hold the left mouse button while moving the mouse. The camera will follow your
mouse movements while always keeping focused on the orbit location.

» To exit the orbit mode, just click the orbit icon again.

You may use the orbit mode combined with the free look mode. This will allow you to control the distance to the orbit location using the left
and right mouse buttons.

LOC

32 Store Visualizer 25.11



3.1.4 Set camera height preset

The current view height (as measured from the ground floor) is shown on the navigation toolbar. A selection of standard view height presets is
available by clicking on the “Height’ selector.

Adult Male (164.00 cm)

Adult Female (151.00 cm)
child 12 years (138.00 cm) * Select a height entry. The camera will automatically adjust to the new view height.
Child 9 years (125.00 cm)

 Click on the “Height’ selector button located on the navigation toolbar. A list of height presets will appear

Custom height

+ Lock height when moving

- Custom height b4 . . . . .
: P If you want a custom height that is not in the drop-down list, click
Height: | 164 cm « | | Presets: 57 |clic| ey 9 p '
el $ | o L II Enter viewer haight: on “Custom height’. The “Custom height’ window appears and

A Figure 3-01 || allows you to enter the desired value (Fig 3-02).

A Figure 3-02

By default Store Visualizer simulates a walking person and the selected view height stays constant while you navigate through the environment.
Certain situations may require more freedom of movement, such as store construction. For these cases, the height can be unlocked.

o Click on the “Lock height when moving” entry in the height preset list to toggle height locking on and off.

¢ When unlocked, the camera will be floating and gravity-less. When locked, it will again simulate a person’s view height and jump to the last
view height set in advance

While navigating in freelook mode, you can interactively adjust the camera height by using the Page Up / Page Down keys. You must first ensure
that the view height is unlocked (Fig 3-01).

» Press Page Up to increase the camera height (moving up).

¢ Press Page Down to lower the camera height (moving down).

:g When switching between stored cameras (see chapter 4.3), the view height will remain locked as long as the stored height is close
to the normal human height. Otherwise, the camera height will be unlocked automatically.
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3.1.5 Toggle layout view

The “layout view” mode will show your store from a birds eye perspective while temporarily removing the ceiling. This mode offers a general view of
the store floor plan and is well suited for editing the larger scale layout of your project. There are two different layout view modes: the rendering mode
and the 2D architectural floorplan mode. You will find further explanation of this function in chapter 6.8.

I e Clicking on the “Toggle layout view” icon toggles the mode on and off or press the “t” shortcut key.

il

3.1.6 Level

A 3D environment can have several levels. The number of the level on which you are located is displayed in the toolbar.

Level: O e By default, the ground floor is level 0.

When you toggle the layout view (see chapter 3.1.5), a drop-down menu with the different levels present in your project appears. Select the level you
want to work on in layout view mode. Thus, only the furniture and products positioned on this level will be visible.

0
1
2 |

Level: [0 = |

3.1.7_Align camera to nearest axis

If you have lost orientation during navigation, clicking on the “align camera to nearest axis” feature will place your view at a standard orientation.
* Open the “More actions” menu located on the right hand side of the navigation toolbar.
o Select “Align camera to nearest axis”.

* The camera view direction will automatically align itself onto the nearest X, Y or Z axis.

34 Store Visualizer 25.11



3.1.8 Manual camera entry

You can place the camera in a specific position by manually entering the X, Y, Z coordinates.
* Open the “More actions” menu located on the right hand side of the navigation toolbar.
e Select “Manual camera entry’.

* The camera view is automatically positioned on the X, Y or Z axis manually entered.

Manual entry @
Axes Position: Rotation: | © Camera metrics:
X |233.099 EI |265.00 EI Q) L] Positipn: Manual entry of the current camera positipn on the X, Y and Z axes (project scale).
i = Rotation: Manual entry of the current camera rotation around the X, Y and Z axes.

Y || [oe01s [Z] Jooo [Z] &

z |160.000 EI |161.62 EI & o Camera.vigw Iockipg: . . . ' '
= Clicking the view lock icons will prevent the camera view from changing on the respective

axes. Clicking the icons again will release the lock.

3.1.9 Enable camera collision

This function only affects the camera when it is moving, when collision is activated (by default). The camera cannot cross through the walls and floor
of 3D environments. Camera collision is enable even where physical simulation is not!

* Open the “More actions” menu located on the right hand side of the navigation toolbar.

¢ Select “Enable collision detection”.

|¢:‘ You can temporarily deactivate camera collision by pressing the Alt key as you move.
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3.2 Navigation speed

You may change the speed of your movements through the 3D environment using the speed selector button:

| * The speed selector is located on the right hand side of the navigation toolbar.
» Click on the Select navigation speed to open the “speed preset list* (Fig. 3-03).

o Select an appropriate speed level.

Wery slow

| The speed selector contains five presets, from very slow to very fast. The “Normal’ preset represents the
Slow average walking speed of an adult.
+ Mormal

Fast
Wery fast

=
Marmal - n:-:-I

=

A Figure 3-03

3.3 Going up or down stairs

You can use stairs to go up or down a floor. To do this, simply stand in front of the staircase and move forward normally using your standard navigation
tools.

The camera collision must be active (see chapter 3.1.9) and the view height must be locked (see chapter 3.1.4).
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Chapter 4 : Using cameras

@ » Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
* The navigation toolbar appears (Fig. 4-01), and is now active.

O @ | Height: 164 crm -« Lewvel; 0 | Presets; lﬁ':lr:l |"'_|ic|* to select a camera

oo | B

A Figure 4-01
4.1 Create new camera

'ﬁl}' o Click on the “Add a new camera” icon.

* The “Camera settings” dialog will open (Fig. 4-02). Enter the name of the new camera.

New camera is the default name.

4.2 Camera list

New camera The list of currently stored camera views can be easily accessed from the toolbar by using the camera selector. When
Camera 1 choosing one of the available cameras, the 3D view will automatically switch to the location and view direction stored
Camera 2 with the camera entry that was selected.

Edit camera settings...

Click to select a camera -

.@ Select “Edit camera settings” at the bottom of the list to open the camera properties dialog

4.3 Next and previous camera

o Click on the “left arrow” to switch to the previous camera.
 Click on the “right arrow” to switch to the next camera.

:l§ The Ctrl-Left and Ctrl-Right keyboard shortcuts can be used to easily cycle through all available camera presets.
These shortcuts are also available in freelook mode.
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4.4 Edit camera settings

The “Camera settings” dialog can be opened in two ways:

» Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
* Open the camera presets and select “Edit camera settings” at the bottom of the list.

Or:
» Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
* Open “More actions” on the right hand side of the toolbar and select “Edit camera settings”.
* A window with all stored cameras will appear (Fig. 4-02).
Camera settings =]
SES & o Add new entry: Create a new camera preset at the current location.
4 o Edit camera position allows the modification of an existing preset. Click on the “Edit camera
| & position” button to enable modification mode. Use the usual navigation functions to move your
< camera to the new position. Click the “Edit camera position” button again to store the new
position and view direction for the selected preset.
Description
* o Remove entry: Remove the selected camera preset from the list.
i o Move entry up/down: Use these buttons to reorder your camera presets within the list.
Camera path
{ Mevement speed: ‘
A Figure 4-02
38

Store Visualizer 25.11



4.5 Camera path

When you select a camera preset, Store Visualizer will create a trajectory along which the camera will move starting from your current position to the

selected destination. Store Visualizer will automatically handle acceleration, deceleration and the rotation angle of the camera along the path, so to
make the movement smooth and natural.

Use the “camera path” settings to change the speed of movement along the trajectory.

* Open the “camera settings” dialog (see chapter 4.4).
» Click the “movement speed’ button and select a speed.
o Camera presets (Fig. 4-03) will now use the selected speed for the movement along their trajectories.

* Inatantl}" o Instantly: The camera jumps to the selected preset instantly, no path is generated.
o Fast: The movement speed along the camera path is high.
Fast o Medium: The movement speed along the camera path is average (this is the default).
Medium o Slow: The movement speed along the camera path is low.
Slow
A Figure 4-03

A camera path does not handle collision situations with objects in the environment, even if collisions are enabled. When creating
camera paths through your store, you should position your presets such that no large objects (for example shelving) is blocking the
trajectory of movement when switching from one preset to the next. Adding a transitional preset between start and end points can
help avoiding these situations. You can also modify the position of existing presets using the “Edit camera position” feature in the
“Camera settings” dialog (see chapter 4.4).
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4.6 Film and lens settings

» Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
* Open the “More actions” menu located on the right hand side of the navigation toolbar and select “Film and lens settings”.

* A window with all available camera lens and film settings will appear (Fig. 4-04).

TrE T = o The Lens section defines how the camera optics will see the 3D scene.
-Lens . . . . . . .

Frld ofview: [ TE] degrees . F!eld of Ylew. Indlcatles the view angle of 'the camera lens in degrees. It will bg |nt'erpreteld as

s - either horizontal, vertical or diagonal opening angle depending on the angle direction settings.

gth:  [950.0 [2] mm Other v . ina i i
» Focal length: Defines the focal length of the camera optics in mm. Several presets are available.

- Film fermat:

Image size: 1680 E x [1050 E mm . . . . . .

o The Film format section describes the size of the virtual camera film:
Image presets: |Fit current display reselution ~ . K . . X K
S —— * Image size: Dimensions and ratio of the virtual film image.
—— * Image presets: Several commonly used film size presets are provided.

A Figure 4-04
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Chapter 5 : Product manipulation mode

Store Visualizer exposes three construction modes: product manipulation, shelf creation and store design. Each mode targets a specific process
in the work flow of creating the layout and shelving of a retail space and filling it up with products.

This chapter focuses on the “product manipulation mode”. A product is defined as any 3D object that is not part of the shelving, store furniture or

larger scale construction structure of the store.

Most object manipulation functions shown here (such as movement or creation) are also available in other construction modes. Chapter 8 describes all

available construction modes used to build your store.

g * The object placement toolbar appears (Fig. 5-02), and is now active.
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A Figure 5-02

» Select the object placement toolbar by clicking on the “Object control’ icon (Fig. 5-01) located on the bottom panel bar.

Model libraries

In the Tools sidebar, open the “Library” panel. This
panel will give you access to your 3D models that can
be placed into the environment. It also offers features
to organize, import and manage your 3D models.

Model browser

Open the “Model browser” panel. This panel shows a
graphical 3D representation of the models selected in
the model library and allows the visual inspection of a
model before placement.
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5.1 Using model libraries
¥ Libraries /ﬂ,/o Models: Show or hide all 3D models contained in the library (this should usually be switched on).
o Assemblies: Show or hide all assemblies contained in the library.

G
EJ & -  Clicking on the “Library” button will reveal the “External library” management menu:

| S .
T| <||[®a|| o New: Create an empty external library.
J Project library L Library ﬁ_ o Load: Load an external library and add it to the project.
Mew... o Close: Close the selected external library.
Load... ||

o Save: Quicksave the selected external library.
o Save as: Save the selected library as an external library file.

o Library settings: Open the external library settings dialog (see chapter
5.9.2).

o Show complexity: Shows a complexity gauge in front of every 3D model
Show complexity entry, representing the models’ geometrical complexity (see chapter 5.4).

Search entries: The search function filters the displayed entries in the library panel according to your

4] ] [ 4[] search terms.
) B | B | | The “Project Library”, which is loaded by default into every project, is a special internal library. Its
- - 0w B contents are stored directly into the project file, while external libraries are merely referenced to. You

We 5-03 cannot close or specifically save the project library.
Import model or resource: Insert an external 3D CAD model file into the library.
o Import image: Insert an external image file into the library.

o Create a new model or resource: Contains the functions for creating new models or resources. See chapter 7 for more
information.

o Copy: Copy the currently selected entry to the clipboard.
o Cut: Copy the currently selected entry to the clipboard, and remove it from the library.
¢ Paste: Insert the content of the model clipboard into the library.

o Delete: Delete the currently selected model from the library.
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5.2 Importing a 3D model or an external resource

You may import a 3D model from a CAD program into your library for manipulation in Store Visualizer:
¢ On the sidebar, select the Tools tab, and open the “Library” panel (see chapter 5.1).

e Select the library or folder you would like to add the 3D model to. This can be the Project Library, an external library or any folder therein. You
may also select an existing model. The new 3D model will be added to the same library as the previously selected model.

o Click on the “Import model or resource’ icon (Fig. 6-04) or press Ctrl+i.

@@ B D& 0| 88 | <roeso

» The “Import 3D file” dialog will open. Navigate through your file structure and select the 3D files you would like to import. Several files can be
imported at once.

——— Store Visualizer can import several standard CAD formats depending on the available import plugins. By default, you can import the
following formats: .3ds, collada (.dae, .zae), .fbx, .vrml, .obj, .stl, .dxf, gITF (.gltf, .glb).

» Confirm your choice by clicking on Open. Cancel will abort the import operation.

o The “Import 3D file” window (Fig. 5-05) will appear. It will enable you to select the import parameters for the 3D models such as shading, lighting
of models containing light sources, and texture properties.
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5.2.1 3D File Import Options

| mpert 30 file | e The file format of the imported 3D model.
* Options If you import multiple 3D models from different file formats simultaneously, you can adjust their
[collada (+2ae) T (Mo resoluion mt___-] settings individually by selecting the desired format from the dropdown list (Fig. 5-05).
¥ Merge specular maps Two sided geemetry
'_l SR T“”ada Rl il s LR ¢ The available options adjust according to the file format selected from the dropdown list:
?iﬁfzﬁ ﬁiﬁ:ﬁ o Merge specular maps (*.zae, *.dae): If the imported model specifies a secondary specular
map, the importer will merge it with the primary specular map. This significantly reduces memory
Ambient shadows consumption and improves rendering speed. On rare occasions it may generate slight visual
» Dynamic lights artifacts.

[ Mapping

o Smooth Normals (*.fbx, *.glb): Improve the visual rendering of curved surfaces if this information
is not already specified in the imported file.

| Details

A Figure 5-05

o Flip YZ axis (*.obj): Allows you to invert the two axes.

o Override scale: Most modern 3D CAD formats supply their own object scale, which Store Visualizer
will use. Sometimes however, that scale may be incorrect. Older 3D CAD formats may not supply a
scale at all. In these cases, you can manually specify the object scale by using this option.

¢ Texture resolution: By default, the resolution of images embedded in the imported 3D model is not limited. However, you can click on the
dropdown menu to apply a resolution limit to the textures.

In the 3D rendering the image resolution depends on two factors: the settings of the library the model is a part of (chapter 5.9.2)
and your texture resolution preference settings (chapter 23.4).

e Two sided geometry:

The two sided geometry mode can be independently set for opaque and transparent geometry. Two sided faces are generally not useful on
opaque geometry, unless the 3D designer specifically required them in the design process. They can negatively impact performance, and
should therefore be disabled. However, they can significantly improve visual quality on transparent materials, and should be enabled by
request from the 3D file (Auto setting).

o Never: Never use two sided geometry, even if the 3D file specifically requests it.

o Auto: Automatically decide whether to use two sided geometry or not, following the requests of the 3D file.

o Always: Always use two sided geometry, even if the 3D file doesn’t request it. Note that this option should only be used in specific
cases, such as when dealing with defective 3D files, as it can significantly impact performance.
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5.2.2 Ambient shadows
This settings page controls how lighting and shadows are applied to the 3D object.

Ambient shadows simulates self shadowing of objects. Strongly concave objects (for example open
boxes, trays, displays, etc) will project significant shadows onto themselves. If you look into an open
box, for example, you will notice that the bottom is much darker that the top part. This is due to self
shadowing or occlusion. This effect can be simulated with the ambient lighting feature.

Ambient shadows are enabled by default to ensure optimal visual quality for your 3D models. However,
keep in mind that the more complex an object is, the longer the calculation of ambient shadows during
import may take. Additionally, Store Visualizer will use more memory if lighting is calculated at high
resolution. A map resolution of 1 cm typically strikes a good balance between quality and performance.

o Vertex only: Use vertex lighting only (for geometrically complex objects).
o Vertex and maps: Use both vertex and mapped lighting on the model (for regular objects).
o Maps only: Use mapped lighting only (for large or geometrically simple objects).

Impart 30 file
U options
** Ambient shadows
,m Map resolution:
I~ Adjust for shelf lighting [1.00 H[m -]
[ Dynamic lights
[» Mapping
| Details
A Figure 5-07
Disabled Vertex and maps

u

Disabled

Enabled

Adjust shelf lighting: Option allowing more realistic shadows to be created for store furniture and on
large 3D models with a complex and concave geometry (such as pallets, certain furniture that is open

nderneath, cars, etc.).
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5.2.3 Dynamic lights

= Dynamic lights

[custom fight type

Detail leval:

Adaptive shape:

|Nurma\ 'l

[strong (75 %) -]

Light range:

100.00 :

I” Bottom closed
™ Top closed

5.2.4 Mapping

The Dynamic lights section enables 3D models containing dynamic light sources to be configured.
For further information about importing and using 3D models that contain dynamic light sources,
please refer to chapter 13.

Mapping coordinates control the way textures are applied onto the surface of a 3D object. Typically, these coordinates are added when a model is
designed in a CAD application. Store Visualizer will automatically make use of these coordinates, if they are available.

Sometimes however, you may want to override the original mapping and replace it with your own. Some 3D file formats may not support mapping
coordinates at all. You can use the mapping options to create and add new mapping coordinates to any imported model.

Checking the “generate custom UV mapping’ box will enable mapping coordinate generation. This will override any existing coordinates on the
imported object. If you would like to use the original mapping coordinates available with the 3D object, then leave this box unchecked.

Import 3D file

Store Visualizer supports the following mapping modes:

U ptions

[ Ambient shadows

- Dynamic lights

< Mapping

¥ Generate eustom UV mapping

Box mapping, adaptive unwrapped box -/

Options
I” Replace materials
¥ Compact layout

Flat direction axis:

X - front and back

pattern image
IV Create a pattern
' Low resolution

& Medium resolution
" High resolution

| Details

A Figure 5-06

Box mapping, adaptive unwrapped box
Box mapping. adaptive unwrapped box
Flat mapping. front and back labels
Cylindrical mapping, circular label with caps

* Box mapping: this will treat the model as a folded box (Fig 5-07). All six sides will be equally mapped
and unfolded onto a common texture image (Fig 5-08).

e Flat mapping: this will map the model from two sides (Fig 5-09), which can be selected using the
direction axis button. This mode is useful for adding two labels (typically front and back) to a relatively
thin object, such as a flat bottle or a pouch (Fig 5-10).

¢ Cylindrical mapping: this mode should be used on cylindrical objects, such as bottles or cans. It will fit
a circular label around the model and will optionally add top and bottom caps.
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Replace material: when checked, the original materials will be removed from the object and replaced by a new material covering the entire model

according to the selected mapping mode.

Generate caps: This will generate special mapping for the top and bottom caps in cylindrical mode.

Flat direction axis: In flat mapping mode, this drop down button selects the sides the two labels are added to.

Create a pattern: When this is checked, Store Visualizer will generate an image along with your model file, that will contain a pattern of the layout used
with the selected mapping mode. You can use this pattern as a guide when drawing your own graphics onto the model. These can then be applied to

the model using the material editor (see chapter 12).

The following options select the resolution of the pattern image file. Note that this resolution is just a base for the pattern image. You can freely modify

the final image resolution from within your drawing application.

Frong o

Bluoi2si00

A Figure 5-07

edue

BlU® 2800

A Figure 5-09

Top

Left Front Right

A Figure 5-08
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A Figure 5-10
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5.2.5 Import

Once you have adjusted the import settings to your needs, you can start the actual import process:

Import 3D file

7 Options

[collada (+zae)

1.00 H |m

¥ Merge specular maps

I override Collada scale

- | [Mo resolution limit -

Two sided geometry

Opaque Transparent
=, i® Never T Mever

| Auto @ Auto

 Always  Always

[» Ambient shadows

[ Dynamic lights

[ Mapping
[

A Figure 5-11

& Import

75% | Details

A Figure 5-12

~ Libraries

K] ~ Modsl browser. )

[ ey -] [G ®

50 project lbrany

| E— 1
dERlLE s

Laundry detergent Q

Laundry detergent

EEEEERERE]

veadauw [Sije]

Sample 3D model for Store.
Visualizer.

RIUB 27|00

e Click on the “Import’ button (Fig. 5-11).
* A progress bar showing the import process appears in the window (Fig. 5-12).
 Click on the “Details” button to open the “Import tasks” window (Fig. 5-13), which displays the import

process in detail. Using the two icons, you can “Show import task list’ (Fig. 5-13) or “Show detailed
import log” (Fig. 5-14).

If a 3D file could not be imported, it will be marked as failed. Select the failed file in the list
and click on the “Show detailed import log” icon to have more detailed information about the

failure.
= >< e x
Status | Model *Temporary file: CAUsersjames\AppDatalLocalvTales gr[a]
& Done  Bottle 01 * Reindexing complete.
& Done  Bottle 02
& Done  Bottle 03 # 0 dynamic light sets exported
@ Failed  Bottle 04
@ Done  Bottle 05 # writing 3DW file:
& Done  Bottle 06 * Internal subtype is set to: library.

@ Aborted Bottle 07

+Label <LIGHTMAP>: 1 maps written
2 Queued Bottle 08

* Label <AMBFIELD>: 1 ambient shadow fields written (c/q
* All done

® The file was successfully imported. =

gl I

B Q&

A Figure 5-13 A Figure 5-14

e Once the object is imported without errors, press OK to add it to the model library. It can now be
accessed as a standard Store Visualizer model.

* Pressing Cancel will discard the imported model without adding it to the library.

The larger the imported 3D file, and the more complex the lighting options, the longer the
import process will take.

* The imported object appears in the “Library” panel at the chosen place and is shown in the “Model
browser” (see chapter 5.4).
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5.3 Importing an external image

Images may be directly imported as models. Store Visualizer will automatically map them onto an extruded 3D panel which can be placed into the
3D environment like any other 3D model.
» On the sidebar, select the Tools tab, and open the “Library” panel (see chapter 5.1).

o Select the library or folder you would like to add the image to. This can be the Project Library, an external library or any folder therein. You may
also select an existing model/image. The new image will then be added to the same library as the selected model / image.

e Click on the “Import image” icon (Fig. 5-15).
q-j;J| L_ah | EJ % _._ | ﬁ < Figure 5-15

¢ The “Import image file” dialog will open. Navigate through your file structure and select the image files you would like to import. Several files
can be imported at once.

« Confirm your choice by clicking on Open. Cancel will abort the import operation.

» The “Import image file” dialog will appear (Fig. 5-16). It allows you to change the way images are imported, how they are extruded to 3D and
how their 3D dimensions are obtained. It also specifies how shadows are generated.

:g Store Visualizer can import several standard image formats depending on the available import plugins. By default, you can import
the following formats: .jpg, .png, .tif, .bmp, .tga.
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5.3.1 Image import Options

Import image file

 Options

|Image panel (+.png) " ‘Na resolution limit "

Thickness:
[s.00

Pixels per size unit:
[1000  []perm - B [mm ~

W Use embedded physical resolution if available

™ Use fixed dimensions

W Width: 10,00 [=f m =
[ Height: [10.00 [2] [m -

[» Ambient shadows

I Dynarmic lights

' Mapping

| Details

The size settings define how image resolution in pixels relate to physical model dimensions (in distance
units such as centimeters or inches) when the image is imported as a 3D model.

o Thickness: Specifies the thickness of the resulting 3D image panel. This value can be zero, resulting
in a panel without any thickness.

/

* The dimensions of the extruded image panel can be determined using the follow methods:

o Pixels per size unit: Determine dimensions automatically based on a fixed pixel size. When using
this method, you specify how many image pixels fit into a given unit size. The image dimensions will
then be automatically calculated based on this value. For example, if you specify 100 pixels per inch
(100 DPI), the physical width of a 2000 pixel wide image will be 20 inches.

o Use embedded physical resolution if available: The PNG file format can optionally contain the

actual physical size of the image. When checked, Store Visualizer will make use of this data if it is

A Figure 5-16

¥ Libraries K ¥ Model browser a

s
Display_Beautylpng Q

5 O project library

Display Beautyl.png

vVaduw 0
Imported image panel [
I — 1 E
JElelLe w8 vl

PO 2F B0

available.

o Use fixed dimensions: This method allows the manual specification of the precise physical
image dimensions, regardless of the image resolution. If only one of width or height is specified,
the respective other dimension will be automatically generated by using the image ratio. This is
recommended, as it will avoid distortions. Alternatively, you may also specify both width and height
manually. Please note that distortions will appear if you do not respect the image ratio in this case.

:ﬁ When an image with an alpha chan_nel is imported, then_a clipping mask wiII_ automatically
be generated. The alpha channel will be used as an opacity mask. The material parameters

and the use of the alpha channel can be controlled in the material editor (see chapter 12).

e The imported image appears in the “Library” panel at the chosen place and is shown in the “Model
browser” (see chapter 5.4).
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5.4 Using the model browser

Once you selected a model in the library, it appears as an interactive 3D view in the “Model browser” panel. This view helps at inspecting the object

before placing it into the environment.

v Model browser 4

While the mouse cursor hovers over the 3D view, you can press and hold the middle mouse
button to move the object. The mouse wheel will zoom in and out.

[¢]® qQ

VEdwe
Champagne bottle sample
model for Store Visualizer

t

-
kU@ 2L DO

e The box tool will auto-recenter the model, so that it fits perfectly into the model browser view.

» The “model view options” button opens a list of standard backgrounds for the model browser. You
can choose between a white or dark pattern, a constant color or a color gradient.

» View or assign model sides defines the front and top sides of the model (see chapter 5.5).

/~ Clicking show model dimensions will display the sizes of the imported model.
Double-click on one of the model’s three dimensions to modify its size.

The “AOF button allows to manage the Areas of Interest of a model (see Consumer Insights Step by
Step guide for more explanation).

This informational icon appears if the models contains transparency or refraction.

Model description: This field contains a description of the 3D model. By default, the model import
format is shown in the description. Click the edit field to change the model description.

The “flag” icon will select all objects in the environment that are derived from the selected model.

o The “refresh” button will reload the model from disk. Use this feature if you modified the original 3D
model or its texture images, and you would like the model in Store Visualizer to reflect these changes.

» The “show or edit anchor points/anchor lines” buttons open the anchor point and the anchor and
snap lines dialog (chapter 8.2 and 8.3).

NN

» The “Edit raytracing surfaces” icon allows you to manage the raytracing surfaces used with refractive
materials (chapter 12.6.6 and 12.6.7).

A Figure 5-17

* The “Model settings” icon groups together several advanced model parameters, such as shadows,
LOD mode, etc. (see Chapter 5.6).

* The “Select reflection environment’ icon opens a drop-down menu with a series of environments
available for the reflections applied to the model browser. The model displayed in the browser will
reflect the environment you have selected. This function only affects the model visible in the browser.
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5.5 Assign model sides

Many operations in Store Visualizer refer to a specific side of an object: front, bottom or left side for example. In order to function properly, Store
Visualizer needs to know how your model is oriented with respect to its front and top sides. This information is usually not available in imported 3D
files, so it has to be manually set.

To easily view and assign the front and top sides of a model, click on the “view or assign model sides” icon in the model browser.

v Model browser 4l

e QU e a@e

| Select the side to assign: front or top side of the model.

Click on the model face that represents the selected side.

o Currently assigned sides are shown with arrows. The arrow is green for the side you are currently
editing (front or top).

Often newly imported models have incorrectly assigned sides. It is important to correct
these. Typically you will only assign the sides once, after importing a model. Your side

assignment is stored with your library and can be modified at any time later on, if needed.

Orange juice sample model
for Store Visualizer

EI T

O |2l D
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5.6 Model settings

¥ Model browser 4 Several advanced parameters related to your models are grouped together in a specific window. By default, these
®QU @ o @ | settings are conﬂgured for good rendering performance, but for artistic reasons for example, some of these parameters
may not be appropriate.

L{:} e The “Model settings” icon opens the “Model settings” window (Fig. 5-18).

odel settings

~ LoD mode

Enable LOD everywhere -

~ Shadows

@Ak Clo Shadow: [100 %
¥ Transparent lighting effects
Champagne bottle sample i
[=]

: Cast dynamic shadows
model for Store Visualizer - X

ploelz<(®o

A Figure 5-18

5.6.1 LOD mode

The level of detail (LOD) system dynamically simplifies objects that are far away from the current view, dramatically increasing rendering performance.

While this simplification is barely noticeable on most common objects, some specific 3D models (such as hollow objects like trays, POP displays, and
models with transparent or refractive effects) are less suited and may display visual artifacts when they are viewed from a distance. Store Visualizer
uses an automatic heuristic to detect these models and will automatically disable LOD or select a more conservative LOD mode for them.
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You can manually select the LOD mode for a model by clicking on the desired mode in the drop-down menu (Fig. 5-19). It is recommended to not
modify the automatically selected mode unless you encounter heavy visual artifacts, as an incorrectly chosen mode may severely degrade rendering
performance.

Madel settings n . . . . .
o Disable: Entirely disable LOD on the model. Only use this mode if the LOD system generates
= LoD mode unacceptable visual artifacts on the model.

o Enable LOD in reflections: Objects are removed from reflections when they are far away, but no other
Enable LOD everywhere b LOD is used for them. Only use this mode if the LOD system generates unacceptable visual artifacts
|Disable LOD on the model.

Enable LOD in reflections

o Enable LOD everywhere: Enable the use of LOD on the model. This is the preferred LOD mode.

Enable LOD everywhere

A Figure 5-19

5.6.2 Shadows

This section (Fig. 5-20) groups together the various shading parameters for the model selected in the library.

o Shadow: Use the shadow intensity control to change the strength of the shadows generated by objects

¢ -t created from this model.

Shadow: |[100 % L ) o
T o Transparent lighting effects: Enables or disables the shadows and dynamic lighting on the transparent
¥ Transparent lighting effects surfaces of the selected model.

" Cast dynamic shadows

o Cast dynamic shadows: activates a drop shadow when the 3D object is exposed to dynamic sunlight
(see chapter 16.5). This option may cause a decrease in performance and it must therefore only be
activated on 3D objects that are or will one day be exposed to dynamic sunlight.

A Figure 5-20
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5.7 Organizing the model library

v Libraries

4

[ Library -

|Champagne

= @_Project library
B & Models
El New folder

Bl Champagpe & Wing

Glass bottle clear

U Glass bottle green

U Glass bottle brown

El'water - Plastic bottles
U PET water bottle

JE I B|L& D

I

|_» You can change the name of a folder or model by typing it into the name area of the “library” panel.

Click on a model to highlight it. This will select it for subsequent operation (eg. object creation) and make it
appear in the “Model browser”.

|_» If the “show complexity” function is enabled (see chapter 5.1) a model complexity gauge will appear in
front of every 3D model in the library. This gauge represents the geometrical complexity of the model.
Complexity is a function of the amount of polygons in the model and also depends on the visual effects
used (for example transparency). The higher the complexity of the model, the more the gauge will fill up
and become red. Adding many complex models to your 3D environment may negatively impact rendering
performance.

The Copy/Cut/Paste and Delete icons can be used to move, duplicate or delete the selected models and
folders within their own or across several libraries. Press the Ctrl key while clicking the left mouse button to
select multiple libraries, templates or folders at the same time.

| &8 |EpTT

Press and hold the Alt key while moving the mouse up and down to drag the selected items within the library hierarchy.
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5.7.1 _Using the contextual menu in the Library

g = Right click on a library (the project library or an external library), a folder, a model or a selection of models
- 3 [E] L
2 Library to open the “contextual menu”. The library contextual menu provides a quick and easy way of accessing
|project library Q various frequently used functions.
eyl aleclad Create folder: Enables the creation of folders and sub-folders. This function will help you to organize
E_, BE[:? Mew... . .
large libraries.
Load...
lose It is very important to create well optimized 3D models in your CAD application ! Models should
use the amount of polygons needed for the required quality, but no more. Adding more polygons
will not improve visual quality, but can significantly degrade rendering performance. Many 3D
models available on the Internet as part of generic 3D libraries are not well suited for realtime
| Create folder | simulation.
Tools N

Tools: Opens a drop-down menu of useful functions for managing 3D models in your libraries.

= Select used models: Selects all the 3D models used in the project from the library currently
highlighted in blue.

Select used models

Select unused models = Select unused models: Selects all 3D models not used in the project from the library currently
highlighted in blue.
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5.7.2 Display as an icon

In order to have an overview of all your 3D models present in a library, you can display them as an icon. Display as an icon only appears when the
Libraries drop-down menu is detached from the control panel (see chapter 1.2).

* On the sidebar, select the Tools tab and open the “Library” panel (see chapter 5.1).

 Click on the “arrow” icon on the top right of the “Libraries” panel to detach it (Fig. 1-03).

&) Lbrary ~ [GET SET FRIDGE OPEN BLUE zae

0 ALCIS_FRAGRANCE_S[*]
[ ALCIS_FRAGRANCE_S|
E ALCIS - Hydratant cream
0 ALCIS_HYDRATANT_2
L ALCIS - HYDRATANT (|
O VIEW_ALCIS_HVDRAT/
B ALCIS - Shower gel
O ALCIS_SHOWER_GEL |
L ALCIS_SHOWER_FOR |
O ALCIS_SHOWER_FOR_|
L ALCIS_SHOWER_FOR |
O ALCIS_SHOWER_FOR_| |
E GET SET - Bottles
[ GET SET_BOTTLE_BLL
[ GET SET_BOTTLE_GRE
J GET SET_BOTTLE_OR/
UJ GET SET FRIDGE OPEI|
U GET SET FRIDGE OPEI|
U GET SET FRIDGE CLO%|
U GET SET FRIDGE CLO¥|
U GET SET FRIDGE CLO%
[ GET SET_BOTTLE_OR/
B GET SET_BOTTLE_GRE
[ GET SET_BOTTLE_BLL
EGIN
H GIN BOTTLE zae
U CARTON_OPEN.zae
[ CARTON_CLOSED.za¢
B GET SET - Pouch drinks
[0 GET SET_POUCH_GEL
U GET SET - DISPENSEF|
O VIEW_GET SET DISPEI|
U GET SET_POUCH_DRII
[ GET Q‘FT FlOOR IDI‘QI
i

@@\E\Qﬂ | 8

GET SET_BOTTLE_GREEN

GET SET FRIDGE OPEN
BLUE.zae

GET SET FRIDGE OPEN
ORANGE.zae

‘I'\

GET SET_BOTTLE_ORANGE.

GET SET FRIDGE OPEN
GREEN.zae

GET SET FRIDGE CLOSED
BLUE.zae

BT

e The “Toggle library icon view” icon appears. Click on it to open icon display mode (Fig. 5-21).

™~ Change icon size: opens a drop-down menu enabling you to choose between
three display sizes for the icons.

o Toggle library icon view: opens and closes the icon display mode.

=

A Figure 5-21

You can reduce or increase the size of the Libraries window when it is
detached. Place the mouse cursor over edge of the window until a double
arrow appears. By clicking and holding down the left mouse button, you
can drag and thus change the size of the window. The window can also
be moved to a second screen.
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5.8 Create copies or variations of a model

A set number of identical copies or several variations of a model can be quickly created from a previously imported 3D model, without having to repeat
the import process.

Right click on a model name in a library to open the “contextual menu’” related to 3D models.

Create copies...
Create variations...

5.8.1 Create copies

The Create copies function enables the quick creation of a set number of identical copies of the model selected in the library.
e Clicking Create copies opens the “Model copies” window (Fig. 5-22).
Model copies l |

Create identical copies of the selected model.

Number of copies: |1 E

| oK | ‘ Cancel |

The model copies created will be separate from the original model.

A Figure 5-22

o Type the number of copies that you would like to create and click OK. Cancel will abort the copy creation operation.

e The copies will be created in the library under the original model. They will have the same name as the 3D model copied and will be
followed by the # symbol and a number.
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5.8.2 Create variations

The Create variations function enables the quick creation of one or more variations of a model selected in the library, by replacing the color layer of

one of the materials with one or more images.

 Clicking Create variations opens the “Select images” window.

e Select the image files that you wish to import to create your variations of the model. You can import several image files simultaneously.

e Confirm your selection by clicking Open.

e The “Model variations” window (Fig. 5-23) will appear. It will indicate the number of variations that will be created.

e Click the drop-down list to display the materials that you can modify (Fig. 5-24). Select the material.

Model variations ‘ ‘i Model variations l M
Create a model variation from an image. Create a model variation from an image. l The IISt COntallnS the mat.erlals Wlth a
Select the material to modify: Select the material to modify: color Iayer aSSIgned toan Image.
Label bottom @\\ I Label bottom
¥ Use the image names for the created models Cn:% e
Top fail
| oK ‘ | Cancel | Label top

Label circular

A Figure 5-23

A Figure 5-24

e Select the “Use the image names for the created models” box, to name the variations based on the name of the selected images.
If the box is not selected, the variations will have the same name as the 3D model copied and will be followed by the # symbol and a

number.

e Click OK to start creation of variations. Cancel will abort the variation creation operation.
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5.9 Using external libraries

You can create customized external libraries that can be reused in different projects and shared between several users. These libraries support all
features of the project library, including subfolders and hierarchies for easy organization and product classification in larger projects. External libraries
promote the reuse of data and improve efficiency, since time consuming operations such as object imports become unnecessary.

B by -] [O]E Creating an empty external library:
MNew... —
Load... - ¢ On the sidebar, select the Tools tab and open the “Library” panel (see chapter 5.1).

¢ Select Library > New. Anew empty external library will be created. You may now start adding models or assemblies
to it (Fig. 5-25).

Show complexity

v Libraries 4

!
|Nsw library Q

A When you create a New library or modify an existing one (eg. copy, move or import models) an asterisk appears

15 New librar, *) behind the library name. This is a reminder that you need to save the library in order to keep the changes. Store
Visualizer will remind you again before closing the project.

A Figure 5-25

Loading an external 3D library:
» On the sidebar, select the Tools tab and open the “Library” panel (see chapter 5.1).
e Select Library > Load. The “Load model library” dialog will open.

|€." The file format extension of library files is 13dw.

You may import an external 3D CAD model into your New library, so to use it as a model within Store Visualizer (see chapter 5.2):
¢ Select the library you would like to add the model to.
¢ On the sidebar, select the Tools tab and open the “Library” panel (see chapter 5.1).
e Click on the “Import model or resource” icon. The “Import 3D file” dialog will open.
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5.9.1 Saving a project with modified libraries

Library in use

==

( i\ Closing the library will remove 20 objects from the scene
and delete the undo history. Proceed 7

Unsaved changes

==t

{ i\J Would you like to save the modifications to the library 7

Eves ) | No | |

Cancel

5.9.2 Settings for Library

==

Settings for New library

Author:

subject:

Contents:

Comments:

is library uses high detail textures

[e]

O O O

& s ) [516

A Figure 5-26

INew library

Q

= L préject library
| F5 Jew library *
U champagne

U wine

This message appears when trying to close a library, and one or several models of that library are
currently placed in the project environment. By clicking Yes Store Visualizer will remove all instances of
these models from the project and close the library.

This message appears when attempting to close a library with unsaved changes or a project containing
such a library. Clicking Yes will save all modifications before proceeding. No will close the library without
saving, all changes will be lost. Cancel will abort the operation.

The following fields can be used to describe the library. All of these fields are optional.
Author: The author of the new library.

Subject: Subject of the library.

Contents: Library content description.

Comments: General description or comments related to the library.

In order to better control the performance and memory use of very large and complex

3D products, priorities can be assigned to each imported library. Higher priority products
(consisting of high detail textures), such as the ones from a customer during a presentation,

can be displayed at the best possible quality level. Regular products (consisting of regular
textures), acting as fillers, can be optimized for speed, leading to better performance and
lower memory consumption. See chapter 23.4.

o An important library is symbolized by a “green book” on the library icon. The priority
status can be changed by using the check box on the library settings (Fig. 5-26).

The texture detail level settings for high and low priority libraries can be configured in: Preferences > 3D settings > Textures.
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5

.10 Placing an object

@ e Each object is derived from a library model. You need to select the model to be used in the library panel.

* On the object placement toolbar, enable the placement mode by clicking on the “Create a new object’ icon.

* Move the mouse pointer to the surface you would like to place the object onto. If the placement is possible, a symbolic representation
of the object will appear.

» You can use the mouse wheel to change the orientation of the object on the placement surface:

o A green arrow symbolizes the front face of the object.

o Avyellow arrow symbolizes the back face of the object.

* Once you have determined the position and orientation of the placement area, press the left mouse button to create a new instance
of the object at the selected location.

:i You can place more than one object by repeating the last two steps as many times as you need. In order to place a different
model, simply select the new one in the library panel.

e Once you have finished placing objects, press the “Create a new object’ icon again in order to disable the placement mode.

Creating an object will automatically switch to the appropriate construction mode. While the examples in this chapter focus
on product manipulation mode, they will work the same way for models using other construction modes, such as shelves.
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Place: | On any surface /4-|

On flat surfaces
On any surface
Anywhere upright

|®Create on transparent

* When you select creation mode, you can choose how the placement surfaces are managed and how objects are
positioned on them using the “Placement’ drop-down menu.
o On flat surfaces: You will only be able to create objects on horizontal surfaces.

o On any surface: You will be able to create objects on any surface. The object is aligned on the highlighted
surface.

o Anywhere upright: you will be able to create objects anywhere without aligning them on the highlighted
surface.

e The “Create on transparent’ function allows you to place objects on transparent surfaces. By default, the objects
are created behind the surfaces.

The Placement and Create on transparent functions are also available when creating an object array (see chapter 5.21).

Store Visualizer 25.11

63



5.11 Selecting the construction modes

Please find detailed information about construction modes in chapter 6.

PdeUCt mnde - ¢ Click on the construction mode selector and choose a construction mode to switch to.

|€._‘ By default, Product mode (product manipulation mode) is active when Store Visualizer is opened.

5.12 Selecting an object

[\} « On the object placement toolbar, enable selection mode by clicking on the “Select objects” icon.
 Position the mouse pointer over the object you want to select and press the left mouse button.

By default, selected objects are shown with an open yellow box around them. You can change the color of the selection box
in the preferences.

* Holding the Ctrl key while clicking the left mouse button will add the object to the current selection.
« Holding the Alt key while clicking the left mouse button will remove the object from the current selection.

* You can select or unselect several objects at once by using a selection area. Clicking the left mouse button, and dragging the mouse
while holding the button down will create a selection rectangle. All objects within the area will be selected or unselected.

 Clicking onto an empty area without an object under the mouse pointer will clear the current selection.
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5.13 Moving a selection of objects

* Enable movement mode by clicking on the “Move selection” icon.
@ * Movement is started by clicking onto a selected object with the left mouse button, and moving the mouse while holding the button.
* The movement axes are shown by the axis indicator on the placement toolbar:

Axis: w 2

o Click on the X, Y or Z axes in order to limit the movement to the requested directions.

Ao A
v Y]

o If you press the Ctrl key while still holding the left mouse button, the object will move along the direction perpendicular to the selected
axes. For example, if the X and Y axes are selected (the default), then the object will move on a horizontal plane. If you press Ctrl, the
direction will toggle to the Z axis, and you may move the object up and down.

» Pressing the Alt key, the movement is carried out in 5 cm / 5 inches increments.

Usually, movement will be performed along two axes simultaneously. But it can be useful to restrain movement to a single axis, when higher
positional precision is needed. At least one axis must be selected in order to allow movement.

5.14 Rotating a selection of objects

—] e Enable rotation mode by clicking on the “Rotate selection” icon.
@ » Rotation is started by clicking onto a selected object with the left mouse button, and moving the mouse up and down while holding the
button.

» The rotation axis is shown by the axis indicator on the placement toolbar:

Axis:

o Click on one of the X, Y or Z axes in order to rotate around the requested axis.

v V2]

» Pressing the Ctrl key while holding the left mouse button will increase the precision of the rotation.

» Pressing the Alt key, rotation is performed in 45-degree increments.

o= | Rotation can only be performed around a single axis at a time.
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5.15 Scaling a selection of objects

« Enable scaling mode by clicking on the “Scale selection” icon.
s e Scaling is started by clicking onto a selected object with the left mouse button, and moving the mouse up and down while holding the
button. By default, scaling is isotropic, ie. it will preserve the axis size ratio of the object:

» Click one of the X, Y or Z axes to individually select the scaling axis. You will then be able to change the size of objects in an anisotropic
manner.

* Pressing the Ctrl key while holding the left mouse button will increase the precision of the scaling.

ﬁ Scaling will always change the size of the individually selected objects, and never the size of their parent models in the library. If you wish
to modify the dimensions of the 3D model without re-importing it, please see chapter 5.4: Show model dimensions.

5.16 Duplicating (cloning) a selection of objects

You can easily duplicate a single object or a set of objects in your project while preserving the original relative positions, orientations and scales:
* Select the object or the objects you would like to duplicate.
* Enable movement mode, as described in chapter 5.13.
* Press and hold the Shift key, and click on a selected object with the left mouse button.

* While still holding both the Shift key and the mouse button, drag the mouse as if you where to normally move the selection as described
in the chapter 5.13.

» Release the Shift key, but keep holding the left mouse button. The cloned selection is now attached to your mouse pointer, and can
be moved around freely until the mouse button is released.

The cloned objects are completely independent of the original objects used for the duplication.
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5.17 Auto select

When "Auto select’ is checked, then objects will automatically be selected while using the move, rotate or scale tools, without having to explicitly use
the selection tool prior to an interaction. The Ctrl and Alt modifier keys for creating multiple selections are also available in this mode (see chapter

5.12).

¥ Auto select

Unchecking “Auto select’ will freeze the current selection while manipulating objects with the move, rotate or scale tools.

The selection tool (see chapter 5.12) is used to explicitly change the selection.
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5.18 Pivots and coordinate systems

The pivot defines the reference point around which objects are rotated or scaled, as well as the attach point when objects are created. It can be
changed by clicking on the “Anchor’ selector.

Ccenter o Center: Set the pivot to the geometrical center of the object or selection.
Local origin o Local origin: Use the local origin of the object as the pivot.
* ?;’;mm o Local sides (bottom, top, etc): Use the center of an object side as the pivot.
Front
Back > X P
Left b > ..
. = 2 :
Right Wiy o iy =
+ Use anchor points | e ‘
Anchor: | Bottom - = ':,ll -~

In object placement mode, the pivot is graphically represented as a , and defines the point at which the object is attached to the placement
surface. The arrow always shows the bottom - top direction within the local coordinate frame (pointing towards the top):

By default, the object is attached to the local Bottom pivot, which is most appropriate for standard products on horizontal shelves.

For products hanging from hooks (eg. blister packs), other application sides (eg. back) or anchor points should be used instead. You
can easily modify this reference point by holding down the Ctrl key while scrolling the mouse wheel.

o Anchor points: Use a user defined anchor point as the pivot (if one or more anchors were defined). See
chapter 8.2 for further information on the anchoring system.

The transform coordinate system selector defines the reference coordinate frame where all object operations take place in:
::::Lt o World: Use the global world coordinate system for all selected objects.

Pivot o Local: Use the local coordinate system of each selected object.

Aligned o Parent: Use the local coordinate system of the parent object (if any).

World -

o Pivot: Use the native pivot coordinate frame of the object (if one was defined).
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5.19 Replace model

The replace tool works on objects and groups created in “Product manipulation mode”, as well as on object arrays.

“n

e” key to replace the model.

L»-Q * “Replace model’ replaces all objects in the current selection with the model currently selected in the library. You may also press the

If you replace a frame or a shelf, please ensure that it does not differ greatly from the old model in order to avoid positioning problems.

5.20 Removing a selection of objects

» Select the object or the objects you would like to remove from the project.
* Open the “More actions” menu located on the right hand side of the object toolbar.

* The “Delete” action will remove all selected objects.
Alternatively you may simply press the Delete key to remove the currently selected objects. Cmd-Backspace can also be used on the Mac

version of Store Visualizer.

:g Only the selected objects will be removed, their parent models in the library will not be affected. In order to remove a library model, please
use the library control features described in chapter 5.1.
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5.21 Multiple object placement
5.21.1 Create multiple object placement

The “Object array” feature can be used to quickly fill an area or volume with multiple objects arranged in specific patterns.

L-r,‘éj,

* Make sure the object placement toolbar is currently enabled and select a model in the library.

» Click on the “Create an object array” icon. The blue surface selection cursor (Fig. 5-27) will appear and the “object array settings”
dialog will open (Fig. 5-29).

[

A Figure 5-27

A Figure 5-28

Use the mouse to select the surface you would like to base the new array on. The blue surface cursor represents the starting
point of the filling volume. This point is shown as a small blue cross at the center of the surface cursor.

%77 '@ The blue arrow at the edge of the surface cursor represents the FRONT of the filling volume. You may use the
mouse scroll wheel to change the orientation while still selecting a surface.

e Once you have selected a surface and starting point, press and hold the left mouse button. When moving the
mouse while holding the left button, an outline will appear. This outline defines the volume of space used to
arrange the objects on the surface. This volume is delimited by a frame. Move the mouse until you are satisfied
with the size of the filling volume.

Release the left mouse button in order to finish the creation of the array. The blue surface positioning cursor will
reappear and you can continue creating additional arrays. Click the “Create an object array” button again (or press

‘f’) to leave the array creation mode.

Object array

Ordered box =

Object orientation

[Front facing— +|

stat  [000  [E] [oo0 [ Jooo [em

Azimuth:  [90

ed  [575 BE bv Bl oo [EHem

Heading: [o 5] | | Fendom [ooo ] o0 & fooo  [em
o see o Bl e B Fa Elen
Fotate: [o ] © | | Bxtend [10035 [&] 3035 [&] 5151 [elem
offset: o [5] @ | | count [10 El [ = B Bl

You can access and modify the properties of any selected array through the “Object array” dialog.

® You can access the array settings dialog at any time by opening the “More actions” menu on the object
toolbar and selecting “Array settings”. You can also press the Shift-F keyboard shortcut.

e Select the array you would like to modify.

o The parameters of the selected array will appear in the “Object array” dialog (Fig. 5-29) and can be
adjusted as needed.

A Figure 5-29

[.E, The “Object Array” dialog will open automatically when creating an array.
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5.21.2 Placement and filling option

Spacing [100  [5] [1oo  [5] Jooo  [Z] em
Random [0.00 [5] Jo0o [5] Jooo [E]em

= » Mode:
- o / o Even: The spacing between objects will remain the same, taking into account object sizes.
N Eloo o o Count: The spacing will be adjusted automatically to keep the number of objects constant.
ed s [ v B oo [ o Grid: The objects will be aligned on a regular grid, regardless of object size.

B

xtend  [10439 [5] [30.15 [2] [3131 [E]em
unt 10 B Bl 8]

e The three columns represent the X, Y and Z axes respectively. The placement parameters, like alignment
mode, spacing, or object count, can be modified independently for each axis.

B ees [ 1ot Elem

\

Start: Defines the margin between the start of the filling volume and the first object.

cuer: | End: Defines the margin between the last object and the end of the filling volume.
\A Figure 5-30 Spacing: The empty space inserted between two successive objects along the axis (Fig. 5-24).
o Random: Sets the amount of random variations applied onto the placement along the axis.

- Object orientation o Size: Shows the dimensions of a single object in the volume (can not be modified).

o Extend: The current size of the entire filling volume.

azimuth: [50 T5) o Count: The amount of objects inserted into the volume along the respective axis.

Elevation: [0 |2 ™ The “Object orientation” section controls how individual objects are oriented (rotated) within the array. The preset list

Heading: [0 2] contains a predefined selection of commonly used orientations. You may also customize the orientation manually through the

' Azimuth, Elevation and Heading fields (Fig. 5-31).
A Figure 5-31

A Figure 5-32 A Figure 5-33
e Clicking on “Settings” will allow access to additional array options and features:

Settings ~ Clutter:

o Allow automatic resizing: Enabling this options allows Store Visualizer to dynamically resize the filling volume extends

+ Allow automatic resizing

Delete current array
Ereak to objects
Fit minimal extend

Generate report. .

if more space is needed.
o Delete current array: Removes the currently selected array.
o Break to objects: Allows access to the individual objects in the filling volume, by making them independent of the array.

o Fit minimal extend: Refits the extends of the filling volume, so that it encompasses all objects without start or end
margins.

A Figure 5-34

o Generate report: Generates a PDF placement report from the selected array (see chapter 19).
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5.21.3 Array randomizer

Sometimes, product sets created with an array will look too ‘perfect’ and aligned for a real world store scenario. Adding random perturbations into the
process of positioning product onto shelves will improve the realistic aspect of the products.

Objectary | Use the Randomizer function to slightly vary the individual spacing and orientation of objects within the
Z:::i:;m =] (s object array on the X,Y,Z axes, in order to simulate the imperfections that would be found in a real-life
[Fromfang =] | | Stert  [ooo Bl [ooo [ Jooo [Eem context (Flg- 5'36)-
ity | End [s79  [FE] 217 [E] Jooo  [Elem
Elevation: ,D_E Spacing 1.00 E 1.00 E 0.00 E:m/

Heading IO_E Random {0.00 E 0.00 E 0.00 E:m

R sz [ss [ [B6s [ 131 Eem
Rotate: [0 [5] © Extend  [104.39 3005 2] [3131 [Z]em o Random X,Y,Z
offset: o [2] ;\ Count  [10 IERE El & o Rotate 118°

\
s |
A Figure 5-35
A Figure 5-36 A Figure 5-37
e Randomizer settings:
Randomizer i E . . . . .
o Random X,Y,Z : Randomly displaces the objects along the respective axes (Fig. 5-37).
Rotate: |0 E & Extend E

Rotate : Adds a random rotation to the objects in the array (Fig. 5-38).
Axis of rotation : Selects one or several axes to apply the rotation too.
Offset : Randomly moves layers of objects on top of each others.

Random snap : Randomly rotates the object by multiples of a fixed angle (eg. randomly rotate in
steps of 45 degrees) (Fig. 5-38).

offset: IO E Enable X axis

Enable ¥ axis

O O O O

+ Enable Z axis

& settings - Random snap »

A Figure 5-38

o Clutter: The Clutter function allows you to randomly remove a number of objects from the object array.
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5.21.4 Break to objects

Multiple object placement allows you to create a volume composed of a number of identical 3D objects. Once an array has been created, objects can
be detached from the volume and manipulated individually.

e Right-click on the array whose objects you wish to detach, to open the “contextual menu” for objects in the 3D scene (Fig. 5-42). Select
Break to objects (Fig. 5-42). All objects will then be automatically detached and selected (Fig. 5-40).

* Or, in the “Object array” dialog, click on “Settings” (Fig. 5-34) and select Break to objects from the drop-down menu. All objects will then
be automatically detached and selected (Fig. 5-40).

A Figure 5-39

A Figure 5-40

Breaking objects from an array is an irreversible action, unless you use the Undo function. Once broken, the individual 3D objects
can no longer be reintegrated into the original multiple placement.

5.22 Export a 3D model

+ Libraries 4
& ubrary ~ [B]®] & You can export the 3D models into a library in *.fbx format.
Frame 122 x 215 cm Q 3 B ) X
S ot ooy * Right click on a model in a library to open the “contextual menu”.
& [ Models
oy * Select Export. The “Export Model” window will appear.
Cut
’;f; C t . ¢ Confirm your choice by clicking on Save. Cancel will abort the export operation.
T

If the function is grayed out, it means that the 3D model cannot be exported due to copyright restrictions.
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5.23 Contextual menu of objects in the 3D scene

The object contextual menu offers an easy and quick way to access several commonly used features.

* Right click onto an object or a selection of objects to open the contextual menu:

Rotate
Scale

& Move
\Zp
H Assembly

Hide
Freeze

8 Delete

Ungroup
Explode
E open group

Model to library

Product viewer

b

A Figure 5-41

o Move: Enables object movement mode.
o Rotate: Enables rotation mode.
o Scale: Change the object size.

o Transform: Selects the axes affected by movement, rotation or scale operations.
o Assembly: Create or update an assembly from the selection (see chapter 9).

o Hide: Hide an object.
Freeze: Freeze an object.
Delete: Delete all selected objects.

O O

Group selection: Group all selected objects.
Ungroup: Dissociate a group.

Explode: Dissociate the hierarchy below a group.
Open group: Open / close a group.

O O O O

[}

Hide selection: Hide all selected objects.
Freeze selection: Freeze all selected objects.

[}

o Model to library: Select the model of the object in the library.
o Product viewer: Enable product view mode on the selected object (see chapter 17).

o An object array offers additional options in its context menu (Fig. 5-42)

B8 Breakto objects
Fit minimal extend

A Figure 5-42

o Break to objects : Allows access to the individual objects in the filling volume, by making them independent of
the array (see chapter 5.21.4).

o Fit minimal extend : Refits the extends of the filling volume, so that it encompasses all objects without start or
end margins.
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Chapter 6 : Construction modes

6.1 Introduction

Store Visualizer exposes three construction modes: product manipulation, shelf creation and store design. Each mode targets a specific process
in the work flow of creating the layout and shelving of a retail space and filling it up with products.

» Select the Object placement toolbar by clicking on the “Object control’ icon (Fig. 5-01) located on the bottom panel bar.
- I The object placement toolbar appears and is now active.
 Click on the “Change manipulation mode” button and enable the desired construction mode (Fig. 6-01).

— . ---Hﬁ“"'---
Product manipulation mode T

| Shelf creation mode ~< Figure 6-01
Store design mode

Product mode <« | L} L L.'J‘:'\.»l—‘ @ &

o Product manipulation mode: This is the standard manipulation mode active when you start Store Visualizer. It focuses on the
manipulation of products on shelves. You will use this mode to place and interact with products in your store and for physical
simulation.

o mode: This mode is mainly used to quickly modify the shelf configuration within existing units. You can quickly
access individual shelves, move them and create new ones.

o Store design mode: In this mode you may easily create and manipulate larger shelving units as a whole, creating aisles and doing
larger scale manipulation of the store layout.

ﬁ Construction modes relieve you from complex and unintuitive manipulation of the freezing and grouping features of Store
Visualizer, by fully automating it.

The typical workflow in Store Visualizer would look as follows:

1) Create your shelf frames using the shelf generator, import your own 3D shelf frames or load a library containing shelf frames.
2) For imported shelves, define shelf type and metrics of the individual parts.

3) Design the basic store layout using the store design mode.

4) Adjust shelving in the shelf creation mode.

5) Place your products on the shelves.

All these steps can be mixed and repeated as required. The following sections explain the steps in more detail.
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6.2 Store design mode

Store design | b L;} dLl_r (@) @ | ¥ Auto select ‘Mlsm_

o Enter Store design mode by pressing the button on the toolbar or by selecting a shelf frame model in the library and enabling creation
mode.

vedu

Tmported X3OW object

RPOY 27|
» Model lighting «
» Model physics «

D) & L Moreactons -
GowE |

You may now select and manipulate large shelving units as combined blocks. An optional snapping mode is available for quickly

and accurately aligning units and creating aisles. When selecting a unit, all shelves and products positioned onto the shelves are
automatically selected and will be moved along.

The snap between shelves function can be enabled or disabled by clicking the “Snap and alignment settings” icon and by
selecting “Snap to frames” in the drop-down menu (Fig. 8-05).
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6.3 Shelf mode

Shelf mode A|

R

& | ¥ Auto select | Axis: K\-‘YE Warld -

e Enter Shelf mode by pressing the button on the toolbar or by selecting a shelf model in the library and enabling creation mode.

Gsyatem] & Tools

¥ Libraries

vaeaadauw

imported X3DW object  [2]

5l
velawleo
— 3

=hEs ‘ |[_shelf mode

g [

AL @

D @ G Morendtions ‘

RN —

This mode allows the manipulation of individual shelves within a unit. A special shelf snap is available for extremely easy creation
and positioning of shelves. Products placed on a shelf can be automatically moved with the shelf without additional selection.
==

The precise positioning of shelves within a frame is controlled by the shelf metrics.
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6.4 Product manipulation mode

Product mode 4|| b L o @ & @

» Once you are satisfied with the placement and configuration of your shelves, enter product manipulation mode. This is the standard mode
allowing you to place and interact with products on shelves (see chapter 5).

» Enter Product manipulation mode by pressing the button on the toolbar or by selecting a standard model in the library and enabling
creation mode.

Store Visualizer 23 aa

o [ |

 Libraries <

[ vbrery -] []8)
e

Q

Jeleloec s

'+ Model browser <

o mlvslavive
> Model lighting “
» Model physics «

D O o vorsnctens |
FlC N E—

:g Enabling this mode will automatically freeze all shelving, so to not interfere with your product interaction. It will also automatically
re-enable physics, which were disabled during store and shelf construction.
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6.5 How to build a complete store?

o8 o JE== B

JOEIIH o 05 6 O mome
1. Store design mode (F4) 4. Shelf creation mode (F3) 6. Product manipulation mode (F2)
2. Create and manipulate your shelf frames 5. Create and manipulate your shelf panels, 7. Create and manipulate your products
3. Create the layout of your store according hook racks, baskets, etc 8. Fill up your aisles with products

to your floor plan. Create aisles, add displays
and branding elements to your store

6.6 Quick mode switch

In addition to the manipulation mode selector on the object placement toolbar, a quick mode switch and keyboard
shortcuts are available.

When in either shelf creation mode or in store design mode, a respective icon will appear on the top left corner of the
screen. Clicking this icon will open a menu with quick access to the three construction modes.

Product manipulation made

Shelf creation mode

Store design mode

This feature is particularly useful when working in fullscreen mode and with hidden user interface.

|€." The keyboard shortcuts F2 to F4 can be used to switch construction modes.
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6.7 Defining and adjusting shelf models

When a model is imported into Store Visualizer, it is considered a standard model / product by default. As such, it will be available in “product
manipulation mode’. If the imported model represents a shelf, a component of a shelf or a component of the large scale store infrastructure, then it
will have to be declared as such to make it available in the appropriate construction mode and to have the correct shaders applied.

Shelf metrics

=]

| Model browser “ o Select the 3D model in your library.
Cleauenga

Standard model

Click on the “Edit shelf metrics” button to choose / change the model type. The
“Shelf metrics” dialog will open (Fig. 6-02).

“ Occlusion

I™ Enable occlusion

By default a 3D model imported into Store Visualizer will be a standard model.
You will have to change the type if your model is not a product, so to make it
available in other construction modes.

TR

Select shelf frame if your model is a shelf frame, a support, an individual
backplate or any other shelving unit with a closed backpanel.

Select shelf panel if your model is a shelf panel, a basket rack or similar.

Select shelf hooks if your model represents a hook rack.

Select generic furniture if your model is a table, display fridge or similar
furniture.

A Figure 6-02

Select structural component if your model will be a part of the store geometry
(walls, doors, banners, etc). The lighting shader is adapted when this model type
is selected, so to offer maximal visual quality for large scale elements.

Standard model
Standard model
shelf frame
Shelf panel
Shelf hooks

Generic furniture
Structural component
Shelf component

A Figure 6-03

Select shelf component if your model is a component, whether or not it attaches
to the shelf or panel.

e Once you have selected the model type, you may proceed to adjust its metrics.

:g Shelving models provided with Store Visualizer are preconfigured and do not require any further adjustments. If you import your own
shelving models and need assistance in optimally adjusting the metrics for best quality, then we recommend contacting your reseller about
available training options.
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6.8 Layout view modes

When layout
when editing

When layout

view is enabled, your current project will be presented from a top-down perspective (Fig. 6-04). This floor plan view mode is very useful
the layout of your store on a larger scale, such as creating aisles, defining areas or changing large structural store components.

mode is active, Store Visualizer will jump to store design mode by default. While this is the most commonly used mode for floor plan

editing, you may use any desired construction mode while in layout view.

@

» Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
* The navigation toolbar appears.

 Click the “Toggle layout view” icon to activate or deactivate the layout view.

between two layout view modes: rendering mode or

r o Using the dropdown menu, you can choose
2D architectural floorplan mode.

Ry

o Use the mouse wheel to zoom in and zoom out. You
can also move the “View height’ slider to quickly
position the view at a given height.

o Press space to toggle “freelook mode”. While in
freelook mode, move your mouse or press the arrow
keys to move around.

o Use the standard object manipulation tools of Store
Visualizer to interact with the objects in your store.

o Press the “Reset view position” icon to move the
view to a default position.

31635 ¢

v %
] err—— Y

o Click on the “Rotate view” icon to rotate the view by

‘u@%

90°.

A Figure 6-04

I‘:—- Click on the “layout view” button again or press ‘t’ to switch back to standard 3D view.
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6.9 Shelf positioning

The shelf positioning dialog allows access to all shelf related data in a unified way. You can use this dialog to precisely adjust the heights and distances
of individual shelf panels and to view additional meta-data associated with the products positioned on each shelf.

» Select the Object placement toolbar by clicking on the “Object control’ icon (Fig. 1-01) located on the bottom panel bar.
| eThe object placement toolbar appears and is now active.

* Open the “More actions” menu and select “Edit panel positions”. The panel positioning dialog will appear (Fig. 6-05).

o When a shelf is selected in (see chapter 6.3), its associated positioning and meta data will automatically
appear in the shelf positioning dialog.

o The shelf column lists or shelves available in the current unit,
including the bottom shelf.

o The distance column shows the distance of the respective shelf
panel to the one just below it. You can edit and modify this value
by double clicking on it.

Tostance[reige
Sezsem 12385 em

o The height column shows the absolute ground height of the
respective shelf panel. You can edit and modify this value by
double clicking on it

Shelf entries in the list can be opened by double clicking on them.

Below each shelf entry the amount of products placed onto the shelf is

listed, aggregated by type. Selecting a product or shelf entry will display

additional meta data about the item.

i = 5

- Shelf meta d
Products: 40
weight:  40.00 kg

o Products: Total amount of products on the selected shelf entry.

o Weight: Total weight of the selected product entry (see chapter
15.5 about assigning model weights).

o More meta information can be displayed depending on the installed
plugin modules.

A Figure 6-05

Selecting a shelf entry in the list will automatically select it in the 3D environment. Double clicking on a product entry will select all
products of the specified type on the shelf and will switch to product manipulation mode.
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Chapter 7 : Create a new model or resource

Store Visualizer offers various functions that allow you to automatically generate several types of 3D model without the need for a CAD program. The
3D models will be created based on the parameters and options that you have configured and will appear in your library to be used like any other
model in Store Visualizer.

7.1 Create a shelf frame
e o On the sidebar, select the Tools tab, and open the “Library” panel (see chapter 5.1).
Eleauoeowuld

e Select where you want to create the 3D shelf model. This can be in the project library, an external library or a folder
within the external library. You can also select an already-existing model. The new model will be added to the same
library as the model selected.

e Click the “Create a new model or resource’” icon (Fig. 7-01). A drop-down menu opens (Fig. 7-02).

SBIE) D& | 8| oo

i : \
| H: 160.00 cm =
W5103.00 cm g i |@ | = & LU | (%] ‘
D: 75.44 cm
veaduwe u ICreate a shelf framel
Create a shelf panel

A Figure 7-02

e In the drop-down menu, select “Create a shelf frame”. The “Create a shelf frame” window opens (Fig. 7-03).

o Configure the shelf frame according to your requirements (see next page) and confirm your choice by clicking OK. Cancel will abort the shelf
frame creation operation.

e The “Generating models” window will appear while the shelf frame is being created. Once the 3D model has been generated, it will appear in
the “Libraries” panel in the selected location and can be viewed using the “Model browser” (see chapter 5.4).

The generated shelf frames are configured and do not require any further adjustment. The materials of the generated shelf frames
can be adjusted in the same way as those of an imported model (see chapter 12).
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You can create numerous types of 3D shelf frames using the “Create a shelf frame” function. A list of shelf frame presets supplied with the software
allows you to quickly generate a 3D shelf frame model based on standard EU and US dimensions.

Create a shelf frame

“" Presets

El Standard EU frames
Height 140 cm
E Height 160 cm
Frame 66.5x 160 cm
Frame B0 x 160 cm

Frame 100 x 160 cm

“ Back panel

Width 125.00 cm Height |[200.00 E cm
Type | Single backpanel hd |

= Uprights

Width m cm Depth m cn ||
Upright hole metrics:

Width m cm Height m cm
Spacing m cm Type

" Base deck

¥ Frame has a base

Depth &7.00 cm Height |16.00 E cm
Brackets | EUtype 1 - |
Price tag | Price tag type 1 - |

Front owver IS.OO E cm [¥ Add kick plate

| oK ‘ Cancel |

A Figure 7-03

Presets: contains a list of standard EU and US shelf frame dimensions. Double-click the selected
entry to automatically fill in the related input fields. You will then be able to modify the settings for the
selected preset shelf frame if necessary.

Back panel: lists the options for the shelf frame back panel..
= Width: the width of the shelf frame back panel.
= Height: the height of the shelf frame.
= Type: drop-down menu proposing different types of back panels (single backpanel, standard
panels or large panels).

Uprights: defines the dimensions of the uprights positioned on the left and right of the shelf frame.
= Width: the width of the uprights.
= Depth: the depth of the uprights.

Upright hole metrics: contains the dimensions of the upright hole.
= Width: the width of the upright hole.
= Height: the height of the upright hole.
= Spacing: the vertical spacing between two upright holes.
= Type: offers two types of uprights (single, double).

Base deck: defines the dimensions and options concerning the base deck of the frame.
= Frame has a base: click if you wish to add a base to the shelf frame.
= Depth: the depth of the base.
= Depth: the depth of the base.

= Brackets: opens a drop-down menu proposing various types of brackets to support the base
panel.

= Price tag: opens a drop-down menu proposing several types of price tag.

= Front over: panel overhanging the front of the base.

= Add kick plate: click if you wish to add a kick plate to the base.
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7.2 Create a shelf panel

Model browser [ = |

* On the sidebar, select the Tools tab, and open the “Library” panel (see chapter 5.1).
e aueawd \

e Select where you want to create the 3D shelf panel model. This can be in the project library, an external library or

a folder within the external library. You can also select an already-existing model. The new model will be added
to the same library as the model selected.

o Click the “Create a new model or resource” icon (Fig. 7-04). A drop-down menu opens (Fig. 7-05).

\ SR D& L8| e

H: 10.60 cm
W:125.00 cm

5 Blo&D|& |
: 51.65 cm
vadue U

Create a shelf frame
ICreate a shelf panel |

A Figure 7-05

o In the drop-down menu, select “Create a shelf panel’. The “Create a shelf panel” window opens (Fig. 7-06).

o Configure the shelf frame according to your requirements (see next page) and confirm your choice by clicking OK. Cancel will abort the shelf
frame creation operation.

e The “Generating models” window will appear while the shelf frame is being created. Once the 3D model has been generated, it will appear in
the “Libraries” panel in the selected location and can be viewed using the “Model browser” (see chapter 5.4).

The generated shelf panels are configured and do not require further adjustment. The materials of the generated shelf panels can
be adjusted in the same way as those of an imported model (see chapter 12).
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You can create numerous types of 3D shelf panels using the “Create a shelf panel” function. A list of shelf frame presets supplied with the software
allows you to quickly generate a 3D shelf frame model based on standard EU and US dimensions.

Create a shelf panel

S Eresets

=l Standard EU panels
[# Width 66.5 cm
= Width 80 cm
Shelf panel 80 x 37 cm
Shelf panel 80 x 47 cm
Shelf panel 80 x 57 cm

~ Settings
Width 125.00 Ecm Depth Id?.UU Ecm
sove [0 Bl oee
Brackets  [EUtype 1 1
1|
Price tag | Price tag type 1 '”
|
|
| oK | | Cancel H
1
A Figure 7-06 \
Flat +
Flat
Wire, wide
Wire, fine

o Presets: contains a list of standard EU and US shelf panel dimensions. Double-click the selected
entry to automatically fill in the related input fields. You will then be able to modify the settings for the
selected preset shelf panel if necessary.

o Options
= Width: the width of the panel.
= Depth: the depth of the panel.
= Slope: allows you to define a sloped shelf panel. Specify the desired slope angle between 0
and 45 degrees.

= Type: select the type of panel you want to create from the drop-down list: with a flat surface,
wide wire, or fine wire.

\

H:10.60 cm
L+ 100.00 cm
P:51.65 cm

H:10.85 cm
L: 100:00 cm
P:51.90 cm

Type: Flat Type: Wire, wide Type: Wire, fine

= Brackets: opens a drop-down menu proposing various types of brackets to support the panel.
= Price tag: opens a drop-down menu proposing several types of price tags.

86

Store Visualizer 25.11



Chapter 8 : Anchor points and snapping

8.1 Introduction

It can sometimes be difficult to precisely place an object against another one or attach two objects at a specific point. Hanging blister packs onto a hook
is a typical example. The anchor function enables an easier placement of an object with an anchor point onto an anchor line.

8.2 Creating an anchor point

&

o Select the model you would like to add an anchor point to. It will appear in the model browser.
 Click on the “Edit anchor points and lines” icon. Click on “Edit anchor points”. The “Edit anchor points” dialog will open (Fig. 8-01).
» Click on “New entry” to create a new anchor point. It appears in the model browser as a small blue box gizmo near the model. Click on

the box and drag it to the desired location.
* Use the “model side view” feature (Fig. 8-02) to help you position the anchor point.

a4aw U

Select or edit anchor points L [ [ + Modelbrowser 4 + Model browser 4

slllleauenwe | |Heac@aae

"
Top

) Left
Back

. Bottom
Right

u

Impdxted Collada object
4

Plu®i@se oo

Imported Collada object
i

PlOB| 2s8B O

A Figure 8-01

from the list to make it the default

A Figure 8-02

=4

The center of the cross in the
gizmo represents the exact
position of the anchor point.

The entry currently selected in the list of anchor points is the default anchor. A model can have several anchors. Select another anchor
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8.3 Creating an anchor line

o o Select the model you would like to add an anchor line to. It will appear in the model browser.
ﬁ » Click on the “Edit anchor points and lines” icon. Click on “Edit anchor lines”.The “Edit anchor lines” dialog will open (Fig. 8-03).

» Click on “New entry” to create a new anchor line. The line appears in the model browser with two small blue box gizmos at each end,
near the model. Click on the end points and drag them to the desired location.

* Use the “model side view” feature (Fig. 8-04) to help you position the anchor line.

Editanchor ines

v Model browser 4

Cleauepoy s

New line anchor

Model browser

=]
N
8 ikt

| EEEEEERE \
R g

V]

aqoe T eduw

Imported X3DW object

Imported X3DW object

(K1 Y

PIOB| RSB0 RO 2890
A Figure 8-03 A Figure 8-04

Anchors lines added to a model are not active by default. Their use as snapping lines can be enabled or disabled on the “Snap
and alignment settings” (see chapter 8.5).
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8.4 Positioning an object with anchors

Store Visualizer 23 -]
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¥ Libraries a
[ens Tong shirt 02086 | &
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@Polo
 Sweaters

@ short sleeve
B Long shitts

g shit 0
UMens long shirt 02
UMens long shirt 02

@jeans

@pants

 shoes 5
a e

ol lLe e

'+ Model browser «

EEEFRERE

Veduw o

Imported Collada object E

=]

RO 2P 00

» Model lighting «

» Model physics a

TR J \ O ’
A Y )\ LW SA B i

&) B Comamn ]| b [G]os & © B | acn T o || Mes e (§)w S\ et
[ 8 ® [reawv =R —

o Before positioning your model, ensure that the “Anywhere upright” option in “Placement’ is selected (see chapter 5.10).

e Select the “Snap to anchor lines” option located in the drop-down menu of the “Snap and alignment settings” button (see chapter 8.5). This
automatic snapping will facilitate creation of the object.

* Enable object creation mode. Click on the “anchor selector’ button and check “Use anchor points”. The default anchor point for the selected
model will now be used as the creation attach point. See chapter 8.2 if you wish to change the default anchor.

» In the above example, the t-shirt uses an anchor point and the hook an anchor line. When moving the mouse near the anchor line of the hook
during creation, the anchor point on the t-shirt will snap onto the hook and will be guided along its anchor line. A blue arrow will temporarily appear
along the anchor line when creating objects.
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8.5 Snap and alignment settings

The snap and alignment settings increase the precision of placement when creating objects. The drop-down menu containing the snap settings
changes depending on the type of model selected in the library (product, shelf panel or shelf frame).

=

» Activate the Object placement toolbar by clicking the “Object control’ icon (Fig. 5-01) located in the toolbar.

» Click the “Snap and alignment settings” icon to open the drop-down menu (Fig. 8-05).

+ Snap to anchor lines

+ Snap to frames
+ Snap to walls

A Figure 8-05

o Snap to anchor lines: enables use of anchor lines for magnetic snapping when creating objects.
o Snap to frames: enables magnetic snapping between the shelf frame bases.

o Snap to walls: enables magnetic snapping between the shelf frames and the main walls present in the 3D
store environment.
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Chapter 9 : Assemblies
9.1 Creating an assembly

Combinations of objects can be joined together into assemblies and stored in a library. This allows the storage and easy reuse of constructions involving
multiple objects, groups and arrays.

» Select the library you would like to add the new assembly to (in the library panel, see chapter 5).

» Select the objects you would like to combine into an assembly. In this example, a shelving unit with one shelf panel (Fig. 9-01).

* Right click to open the contextual menu and select Assembly > Create new assembly.
e The assembly will be created in the “Assemblies” section of the library you selected earlier (Fig. 9-02) and will appear in the model browser

when selected.

» You can now create instances of this assembly using the normal object creation tool (see chapter 5.10). The object construct represented by
the assembly will be recreated in your 3D environment. Once created, the new objects will be independent of the assembly they originated

from.

A Figure 9-01

v Libraries q i Model browser 4l
2 ubrary -] [E](# _ ® QAU ® B0 g @‘
|Newassembly / Q

= & project library

B @ Models
B standard shelving
Ostd 133 x3dw

|_ghelf_133_57cmx3
U std /shelf_grid_front.x3c

|_side2.x3 I ]
33cm-va.C S . . . {
= W Assemblies _ et iy ‘
New assembly
4] ] [ [«]r]
JelelDe o s e4au
A Figure 9-02
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Assemblies act as blueprints. They contain the instructions needed to build the object construct they represent, but they do not directly contain the
models. Instead, they reference models in the same or in another external library. If these models are unavailable, then the assembly referencing them
is considered broken and cannot be built (see chapter 9.3). Loading an external library containing the referenced models will automatically repair all
assemblies using them.

Don’t forget to assign the front and top sides of a new assembly, in the same way as you do for newly imported models (see chapter

5.5)1

9.2 Updating an assembly

An existing assembly can be modified or updated with new content at any time.

» Select the assembly you would like to update in the library panel.
e Select the objects that will replace the contents of the selected assembly. In this example, the original assembly will now be updated by a

shelving unit with multiple shelf panels (Fig. 9-03).

* Right click to open the contextual menu and select Assembly > Update assembly.

e The assembly will now contain the new object construct.

i |

A Figure 9-03

+ Libraries L

8 ubray -] [G][¥

|New assembly Q

= U project library
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Bl Standard shelving
Ustd_133x3dw
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U std_shelf_133_57cmx3
U std_shelf_grid_front.x3c
U std_shelf_grid_side.x3d

U std_shelf_grid_front2.x3

O std_shelf_grid_side2.x3:

U Top banner 133c¢m-v2.C
B Assemblies

4] 1l [ [a]¢]

P IEDED| 8

¢ Model browser

4l

gl Q U
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A Figure 9-04
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9.3 Incomplete assembly

An assembly is considered incomplete when one or more models required to reconstruct the combination of objects cannot be found in the libraries
loaded, either because they have been deleted or because the assembly contains models found in a library that has not been loaded.

If the models present in the incomplete assembly have been deleted from the library, you will have to recreate the assembly.

e In the “Assemblies” section of the library, an icon will appear in front of the incomplete assembly (Fig. 9-05).
« In the “Model browser” (Fig. 9-06), a red notification “Assembly is incomplete!” warns you that the assembly does not contain all of the
objects that were used to create it. The “Model browser” displays the assembly as is without the missing objects.

However, you can still create instances of this incomplete assembly by using the normal object creation tools (see chapter 5.10).

o Click the “Assembly is incomplete!” notification to open the Broken assembly window (Fig. 9-07). This window contains a list of objects
missing in the assembly.

o Load the external library or libraries containing the models referenced in the assembly so that it can be automatically repaired.

+ Libraries 4 + Model browser 4
&) Library - @QUG)QJ@"
INew assembly o )J) Assembly is incomplete ! | [ Broken assembly T

— &) The folloving cbjects are part of the assembly and use models that
= & Project library () Could not be located in any loaded ibrary:
B @ Models
E Standard shelving
O std_133 x3dw
B #_Assemblies
1@ New assembly

Frame

4] I [ [AT¥] A Figure 9-07
SJE B ID& D88
A Figure 9-05 veau

A Figure 9-06
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Chapter 10 : Layers and variations
10.1 The layer concept

Layers are like transparent overlays on which you organize and group the 3D objects in your project. Layers can help you organize the content of a
project at a higher level, by grouping objects, for example, in relation to their function, location or type. You usually use layers to control the visibility
of objects or to easily toggle between different variants of an entire group of objects.

For example, let us assume you are working on a project that represents a shopping center with multiple stores. You can create a different layer for
each store, then assign all the objects of a store to its respective layer, or you can organize the layers according to the categories of objects, such as
furniture, accessories, marketing, signage, etc. In another typical instance of use, you can create a layer for each aisle of the store, for each product
category or for areas containing specific brands.

In all these cases, you can toggle the visibility of each layer in order to work only on aspects of the project of immediate interest, quickly hiding the rest
so that it does not interfere with your work.

* On the sidebar, select the Project tab and open the “Layers” panel (Fig. 10-01).

A new project always contains a Base Layer by default. All 3D objects you place in the scene will be added to this layer by default.

¥ Layers

W

0 = Base layer

A Figure 10-01

Add new layer: adds a new blank layer to the project. The name of the new layer is automatically generated

(“Layer 17, “Layer 2", etc.) but can be renamed by right-clicking on the layer.

Assign current selection to layer: all 3D objects currently selected in the scene will be assigned to the
layer marked with a pencil. You can thus assign 3D objects to a specific layer at any time.

Add avariation: click on the “Add a variation” icon to create a new variation for your layer. Any manipulations
of 3D objects that you make in this variation will only affect this variation. See chapter 10.4.1.

Remove a layer or a variation: by clicking on the icon, the currently selected layer will be deleted from the
list.

Hide layer: toggles the visibility of the currently selected layer.

Lock variation: when you no longer want to make changes to your variation, you can lock it. It will thus be
always be preserved and can never be modified.
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10.2 Working with layers

When you start a new project, Store Visualizer creates a special default layer: the Base Layer. You cannot delete or rename the Base Layer. If you
have no other layers, all 3D objects you create in the project will be placed in the base layer by default. If there are other layers, new 3D objects are
added to the currently active layer. After creating 3D objects in the scene, you can always assign them to another layer.

10.2.1 Creating new layer

¥ Layers 4| e On the sidebar, select the Project tab and open the “Layers” panel.

——e Click on the “Add a layer” icon. A new layer is added to the list of layers and is selected and active by default (Fig.
10-02).

o Activate a layer: all 3D objects newly created in the project are assigned to the active layer. Only one layer
can be active at a time. A “pencil’ icon appears next to the active layer (Fig. 10-02). Click on a layer to make
it active.

The Base layer is activated by default when a project is opened.

A Figure 10-02

v Layers P o Layer color: when creating a new layer, a default color is automatically assigned to it. Click on the color icon
o 8 @6 next to the layer entry to customize it (Fig. 10-03). By default, the color of the «Base layer» is yellow.

[=)Base layer

When selecting objects in your scene, their selection boxes reflect the color of the layer to which
the objects belong

a layer 2

In the example opposite, the first pair of shoes is in the Base
Layer (yellow selection box) and the second pair of shoes is in
Layer 2 (blue selection box).

A Figure 10-03

Store Visualizer 25.11 95



10

.2.2 Assigning a 3D object to a layer

¥ Layers 41

& @0

[ Base layer

B Laye

¥ Layers 4

LRI S @5

[= Base layer

il = Layer 2 7

S

Rename

Hide layer

A Figure 10-04

o Assign current selection to layer: when a 3D object is placed in a project, it is systematically assigned to the
active layer. However, if you created the 3D object by selecting another layer, you can still change the layer
assignment of the 3D object at any time.

Select in the project, using the classic selection tools, the 3D object(s) that you want to assign to another
layer. Then select the layer to which you want to assign the new selection and click on the “Assign current
selection to layer’ icon.

A 3D object can only be assigned to one layer!

Example: the first pair of shoes was assigned to the Base Layer (its selection box is yellow). After the operation
described above, it is now assigned to Layer 2. When the pair of shoes is selected now, it can be seen that
their selection box has turned blue. Both pairs of shoes are now assigned to Layer 2.

o Select objects: available by right-clicking on a layer in the list of layers, the contextual menu enables you
to select all objects in the scene that are part of this layer (Fig. 10-04).

o Rename: in the contextual menu you can also use the “Rename” function to rename a layer or a variation
(Fig. 10-04). The Base Layer present when a project is created is the only layer that cannot be renamed!
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10.2.3 Hiding a layer

¥ Layers 4

FRAGE [@)a

[= Base layer -
il o Layer 2 ‘
=]
id

A Figure 10-05

A Figure 10-06

o Hide a layer: click on the ” icon to toggle the visibility
of the currently selected layers. The pencil symbol is replaced
by the layer symbol. When a layer is hidden, all objects
assigned to the layer are removed from the scene (see example
opposite). When the layer is visible again, 3D objects are
recreated.

When a project with hidden layers is open, the resources used by the objects on the hidden layers
will not consume memory on your graphics card. When a hidden layer is made visible, its resources
will be loaded on demand. The hiding of layers can be used as a way to manage limited video
memory, enabling you to partially open a project on a graphics card with lower specifications that
would otherwise not be able to manage the project in its entirety.

o It is impossible to create a 3D object when the selected layer is hidden. The selection box
surrounding the 3D object is replaced by a rectangle topped by a cross (Fig. 10-06). A warning
message also appears in the information bar (Fig. 10-07).

T = o T R
G NEREILIN O @
O cnnot create an object on s hidden laver L

A Figure 10-07

|¢:‘ If you delete a layer that is hidden, all 3D models assigned to this layer will be deleted from the project.
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10.3 The variation concept

There can be several variations of a layer, representing different options or variants of the layer’s content. Variations enable you to easily switch from
one variant to another, without affecting other project layers.

For example, a layer represents an aisle in a store. This aisle is available in various versions with different shelf configurations and product design
options for you to compare. Each version will be a variant of the aisle layer. By toggling the variation currently visible, you can quickly compare the

different configurations and options, or for example conduct consumer research on each variant.

10.4 Working with variations

A layer can have several variations, but only one of these variations can be visible at a time. When you add a new layer, a Default Variation is

automatically created.

10.4.1 Creating a new variation

¥ Layers

4

o (R— oo

[l= Base layer
D ELayer 1

Default variation

@ I lew variation

s

-

o Select the layer in which you want to add a new variation.

v

A Figure 10-08

Click on the “Add a variation” icon. A new variation is added to the list of layers and is selected by default (Fig.
10-08).

o Activate a variation: double-click on a variation to make it visible (or click on the variation symbol that

precedes its name).
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10.4.2 Deleting a variation

¢ Select the variation you want to delete.

[® Base layer
D ElLayer 1

Default variation

I®@ Mew variation

—e Click on the “Remove a layer or variation” icon (Fig. 10-09). The marked variation will be deleted. You cannot
delete an active variation.

Attention: if you delete a variation, all 3D objects placed in the scene relating to this variation will be
permanently deleted.

A Figure 10-09

10.4.3 Locking the variation

When you have finished working on a variation, you can lock it. This option enables you to save the current state of the variation and prevent any
changes to it. It is recommended to lock a variation when, for example, you plan to use your project at a trade show, during a demonstration at a
customer’s premises, to carry out consumer research, etc. You will thus always have the safeguard of saving an “initial” version of your project.

e Select the variation you wish to lock.

¥ Layers 4
LR @ }
[1= Base layer =

|:|EI Layer 1 /

—e Click on the “Lock variation” icon (Fig. 10-10). The marked variation will be locked. Click on the icon a second time
to unlock the variation.

A Figure 10-10
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10.4.4 Modification of a locked variation

As seen in the previous sub-chapter, a locked variation cannot be modified but this does not mean that all 3D objects forming part of this variation
are frozen! Even if a variation is locked, you can still therefore manipulate 3D objects that are part of this variation. However, in order to ensure the
integrity of the locked variation, a new variation will be created automatically when a 3D object that is part of the locked variation is first manipulated.

In the example below, we have a layer that presents three variants of a store window. The Valentine’s Day window is currently displayed in the project
and it is locked. During the demonstration with the customer, we have moved a 3D object placed in the window that is part of the locked variation. A
new variation is then created automatically below the locked variation (Fig. 10-11) to enable us to make changes.

¥ Layers

4

oL G

sesl oo

[1@ Base layer
|:| E Layer 1

Z

-

Default variation

Valentine's da

&8 op valentine's day (cha

[4*]

o Starting with a locked variation (Fig. 10-10), in your project you manipulate a 3D object that is part of this locked
variation.

A new variation automatically appears in a colored box below the locked variation (Fig. 10-11). This new variation
uses the name of the initial locked variation with the additional changed indication.

=

-

Any changes you subsequently make in your project to 3D objects that are initially assigned to the locked
variation will be consolidated in this changed variation.

A Figure 10-11

At the front of the changed variation, two icons enable you to choose at any time whether you want to save (+
symbol) or delete (X symbol) the changes made to the locked variation. If you click on the save changes icon, they

¥ Layers 4
GO L | s @86
[= Base layer =
DE! Layer 1 (/

Default variation
) valentine's day

@ Valentine's day #2

Season's Greetings

will be copied into a new variation.

If you click on the delete changes icon, all changes made in the modified variation will be deleted and the initial
locked variation will be activated again.

e The “Delete or save changes” icons appear in the layer menu (Fig. 10-11). These two icons enable you to save or
delete changes made to locked variations on all layers.

When you close your project and changed variations are still active, the Unsaved changes window

A Figure 10-12

<y
| opens, enabling you to choose whether or not you want to save the changes made to the locked
variation(s) through all your layers.
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Here is a concrete example to facilitate understanding of the layer and variation tool. Starting with a clothing store, we create two layers. The base
layer includes the contents of the store (furniture and products) and the second layer is dedicated to the various designs for the window. Each window
design will be a variation. Our example has two variants of the window. One variation includes the decorative elements for Valentine’s Day and the

other variation includes the decorative elements for the end-of-year festive season.

s

CERINE s [E]

[ = Base layer

[ = window displays
Default variation

P
U@ \'alentine's day

_ Season's Greetings

K10

| Default variation

| v Layers 4
@@ & @06
[J& Base layer =
[1= window displays 7

[4¢]
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Chapter 11 : Using the scenegraph

Introduction

141

The scenegraph is a tool that regroups all interactive elements present in the current project. lts purpose is the organization of the structure and the

relationship between project elements.

e Select the Scene tab on the sidebar and open the “scenegraph” rollout (Fig. 11-01).

v Scenegraph

4

Qv

& Shelves

B Products

H Helpers

4] T | ]
FOB8lec

O O O O

Store: Contains all modifiable structural elements of the store.
Shelves: Contains all the shelving present in the store.
Products: Contains all the products placed onto shelves and into the store.

Helpers: Contains all helper gizmos.
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11.2 Scene elements
Displays a list of all elements of the p

roject and shows their hierarchical relationships. You can individually mark items by clicking on them with the left

mouse button. Use the Ctrl key to mark several items. Click the right mouse button to open a context menu for the marked elements, see chapter 11.8.

v Scenegraph 4
|Spray with liquid #2 Q/{
Bl Store alll
A
o
H shelves
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o
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E Products
B |2 Beauty shelf
W
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5 | @ Spray Wlth ||qU|d #:z
Helpers

L

4] |
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The Search entries function filters the entries displayed in the scenegraph by name.
o The “Filter entries” icon opens advanced filter functions (see chapter 11.3).

The Store section contains all structural elements (chapter 6-07).
o The Shelves section contains all Shelf frames and in the store.
Store Visualizer will automatically group shelving units. It is not recommended to modify
this grouping!
o The Products section contains all Products in the store.
All objects in the products section will automatically be grouped according to the shelf they

are placed on. This grouping adapts automatically when moving a product from one shelf
to another.

| o The “Array” icon represents an object array. Clicking on it will change the visibility:

= |f the icon is blue (active) then the associated array is visible.

= |f the icon is gray (inactive) then the associated array is hidden.

——o The “Object’ icon represents a single object. Clicking on it will change its visibility:
= If the icon is blue (active) then the associated object is visible.
= If the icon is gray (inactive) then the associated object is hidden.

——o The “Group” icon represents an element group. Clicking on it will change the group visibility:
= |f the icon is blue (active) then all elements of the group are visible.
= If the icon is gray (inactive) then all elements of the group are hidden.

;o A group may be closed or open. The latter case is reflected by a changed group icon.

o The “Flag” icon displays which element is selected in the 3D scene. Click on it to select or unselect the
associated element:

= |[f the icon is red (active) then the associated element is selected.

= If the icon is gray (inactive) then the associated element is unselected.

™ Frozen elements cannot be selected or manipulated. This state is indicated by a “Lock” icon and a
grayed out name. (See chapter 11.6)

A Figure 11-01

Scenegraph control panel. For details, see chapter 11.4.
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11.3 Filter entries

In addition to filtering scenegraph entries by name, the advanced filter options allow the entries to be filtered by various object related states. You can,
for example, display only selected objects or only frozen ones.

v Scenegraph 4

| a(@)

List only hidden objects
List only objects with lights

11.4 Scenegraph control panel

The control panel is located below the scenegraph.

FFrUolBo8a

/- Select the type of advanced filter from the drop down to enable it.

| Changes of object states in your project will not automatically affect the currently displayed entries when an

' lJ i advanced filter is enabled. Press the “Refresh filter’ icon to propagate any changes to the filtered entries.
List only frozen objects As an example, the ‘selected objects’ filter will display all entries that are selected at the time you enable the
List only unfrozen objects filter. If you subsequently modify the selection, the entries shown in the scenegraph will not change. Pressing
List only visible objects refresh will update the filter to the new selection.

e Uncheck the filter icon to disable an advanced filter.

It contains functions used to manipulate and restructure scenegraph elements.

Select none: Clears the current selection.

Select all: Selects all elements in the scenegraph.
Show or hide objects: See Fig. 11-02.

Freeze or unfreeze object: See Fig. 11-03.
Toggle group mode: Opens or closes a group.
Group objects: See chapter 11.7.

Dissociate current group: Dissociate a group.

Explode group: Explode the hierarchy below a group.
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11.5_Show or hide objects

The show or hide objects button regroups features to modify the visibility states of one or several elements in the scenegraph.

¥[cle e o
Show all |
Show selected

Show all: Unhides all hidden elements.
Show selected: Unhides only the currently selected elements.
Hide all: Hides all elements in the scenegraph.

O O O O

Hide all
Hide selected

Hide selected: Hides only the currently selected elements.

A Figure 11-02

11.6 Freeze or unfreeze objects

By freezing an element all interactions with the object are temporarily disabled. An object should be frozen to avoid accidental manipulations such
as movements or rotations while interacting with other objects nearby.

o Freeze marked: Freeze the currently marked scenegraph element.
Freeze selected o Freeze selected: Freeze the currently selected elements.

o Freeze unselected: Freeze all objects that are not currently selected.
Freeze all o Freeze all: Freeze all objects in the project.

o Unfreeze marked: Unfreeze the currently marked scenegraph element.
Unfreeze all o Unfreeze all: Unfreeze all currently frozen objects.

A Figure 11-03

Right clicking on an entry in the scenegraph will open a contextual menu offering an easy access to the most commonly used functions.
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11.7 Using groups

Elements that are logically or physically linked together can be placed into a group. Manipulations performed on the group will be applied to all
contained member elements simultaneously. The relative distances between all group members are preserved. All object types are groupable. Groups
can also be nested, creating subgroups.

11.7.1 Creating a new group
Click on the “Group objects” icon to open the group drop-down menu. The context menu also includes these functions.

BlB |5 &

dite  Group marked
| Group selected

o Group marked objects: groups all the elements marked in the scenegraph.

o Group selected objects: groups all the objects selected in the 3D scene.

|c The new group will appear in the scenegraph above its member elements. You can easily change its default name by using the name field
on the top of the scenegraph area.

11.7.2 Dissociate current grou

A group of elements can be dissociated, rendering all member objects separate again.

ﬁ » Select the group to dissociate and press the “Dissociate current group . Again, this action can also be performed by using the context
menu.

Removing a group will not remove any of its member objects ! It will only break the logical link between them. The dissociated member
elements can be regrouped at any time.

11.7.3 Explode current grou

The explode group function can be used to completely dissociate all member elements and subgroups of a group at once, through the entire
hierarchical branch.

{.} o Select the group to explode and click on the “Explode current group” icon. The same features is available through the context menu.

Exploding a group will not remove any of its member objects except subgroups ! It will break the logical link between all elements in the
group and all of its sub groups.
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11.8 Scenegraph context menu

The scenegraph context menu provides a quick way to access commonly used functions when one or more items are marked (highlighted in blue) in
the scenegraph. Use the Ctrl key to mark several elements.

* Right click on one or more models in a library to open the “context menu”.

v Scenegraph

4

| Qv
Store
Shelves
Bl Products

E Select

5 Unselect

|| Freeze

I Unfreeze

= Group

J

o

J

| collapse all #2
Helpers

YUbBlBo& U

A Figure 11-04

Select: selects all the elements marked in the 3D scene of the scenegraph.

Unselect: unselects all the elements marked in the 3D scene of the scenegraph.

Freeze: freezes all marked elements.

Unfreeze: unfreezes all marked elements.

Group: creates a group with all the elements marked in the scenegraph.
Ungroup: ungroups all marked groups.

Open group: opens all marked groups.
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Chapter 12 : Material editor

Store Visualizer allows you to easily modify the visual appearance of a 3D model. You can edit the surface color, assign artwork, change the reflectivity
or select a different material for your model. The material editor regroups these options in a central location.

e On the sidebar, select the Scene tab, and open the “Material editor” panel. Fig. 12-01 will appear.

e Select a model from a library. A list of the materials making up the model will appear in the “Material editor’.

Only models that were initially imported with the “Modifiable Materials” option checked will allow access to their materials. See
chapter 5.2 for more information about this option.

v Material editor ]
[ cork
[@ Bottle /

B Label

4| Liquid

[Erandardrn ]| § ©
Standard | Advanced
\

=

“ Surface appearance

Color: 4
Reflect: 15 [2]% &
Gloss: 100 % QY
Emboss: |75.0 E q
7 Transparency

Opacity:  [100 [2]% 4 &2

I~ clipping mask
+ Reflections
I Planar reflections )

A Figure 12-01

Material: The top section of the material editor panel lists all materials available in the currently selected model.
Click to select the material entry you would like to modify. Double click on an entry to change the material name.

o The drop-down “Material shader “ menu lists the shaders applicable to the material. Additional extensions may
provide other types of shader.

The color of the icon in front of the material name represents the shader applied to the material (see
shader list below).

standard HDR | ~| = Standard HDR: The default shader used for 3D models.

l e . .Refracti've: Applies the refractive shader to the selected material. See chapter 12.6 for more
information on refraction.

= Disabled: Makes it possible to disable a material. The parts of the model using disabled
material will become invisible.

Pick a material from a model: If this function is activated, click a material directly on a model displayed in the
model browser or an object positioned in the scene to select it. The material will be briefly highlighted and its

properties displayed. To select a material placed behind a transparent surface, hold down the “Shift” key during
selection.

You can also press the shortcut key “K” to quickly select a material on a model.

o Material actions: Opens a drop-down menu for copy operations.

o Material presets: Opens the “Material presets” window showing a list of materials supplied with Store Visualizer
as well as customized materials (see chapter 12.5).
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¥ Material editor ]

la cork
[@ Bottle

4 Liguid

[andedon [ & 0 &
= surface appearance
Color: ’

| —O
Reflect:  [as [ % & ‘7; Modify image: These buttons will open the layer image modification window for the respective layer (see chapter

/3 Surface appearance: This section describes the color and reflective properties of the material (see chapter 12.1).

Image viewer: Pressing one of the viewer buttons will display the image currently assigned to the respective layer.

Gloss: 100 [5]% 4 A 12.3).

Emboss: I?S‘O E Q E/

“7 Transparency

G el o o Transparency: This section controls the transparency and translucency of the material (see chapter 12.2).

Fitr, = o Clipping mask: (see chapter 12.2.3).

I Clipping mask

R o Reflections: Allows you to position one or more reflection planes on a surface, enhancing the realism of existing

I Planar reflections = reflections and facilitating the creation of display cases, mirrors, glass doors, etc. (see chapter 12.7).

o Advanced settings: This section covers more specific and advanced material settings, see chapter 12.4.
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12.1 Surface appearance

This section allows you to specify the color and the reflective properties of the surface. These properties are vital in defining the visual appearance

of a material. By simply changing the following settings, you can create a wide range of materials such as paperboard, plastics, metals, glass and
much more.

12.1.1 Color
The color layer will add a constant color or a color image to your models, like for example a label:

A

No color Constant color Color image

12.1.2 Reflect

The reflect field controls the overall surface reflectivity, ie. how reflective your model is. A low value will create a rough and dull surface material, such
as paper. A medium value will simulate varnished or coated surfaces, as well as smooth materials like plastics. Very high values, up to 100%, will
simulate mirror like reflections, such as from metals.

Reflect: 0 Reflect: 50% Reflect: 100% Reflectivity image

- By default, the elements visible through an object’s reflection come from the reflection point and zone in which it is located (see chapter
16.3.1). If your model consists of a flat surface and you require a more precise reflection (such as a mirror), you can use a planar reflection
(see chapter 12.7).
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12.1.3 Glossiness

The gloss field changes the glossiness of the reflection. A value of zero represents a very matte surface, while a value of 100 will make your model

extremely shiny.
W W

Gloss: 0 Gloss: 50% Gloss: 100% Glossiness image

Each of these layers (color, reflect and glossiness) can also be controlled by an image. Applying an image to the color layer will, for
example, add a graphical artwork to your model. See chapter 12.3 for more details on layer images.

=

12.1.4 Embossing

You may add embossing or a relief to your model by using this section. The embossing mask is supplied by a grayscale layer image or an XYZ normal
map. The strength of the embossing can be controlled by changing the scale field. Both positive and negative embossing can be simulated. Use a
negative scale value to flip the direction of the embossed areas (inwards becomes outwards and vice-versa).

No embossing Positive embossing Negative embossing
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12.2 Transparency
12.2.1 Opacity

A model can be transparent, such as one made of glass or transparent plastic, or can have translucent parts. This section controls the opacity of the
material (how much light is absorbed) and its color. An opacity value of zero will create an entirely transparent material, while it will be fully opaque
at 100%.

Opacity: 100% Opacity: 50% Opacity: 25% Opacity image

12.2.2 Transparency filter

Adding a transparency filter will create a material that tints anything seen through it (such as green bottle glass, for example). Two filter modes are
available: color and layer. A color filter works with a single user supplied color, while a layer filter uses the color surface layer.

No filter Color filter Layer filter
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12.2.3 Clipping mask

Store Visualizer supports a special transparency mode, available through the “clipping mask*“ checkbox. When enabled, fully transparent parts of the
opacity image will be entirely cut away from the rendered image. This mode is useful if the opacity image (or the alpha channel of the color image)
contains a contour or shape mask rather than an actual transparency. A typical example is a shaped label.

Without clipping mask With clipping mask

o Without clipping mask: The transparent parts around the label are rendered as a fully transparent material. The label appears as if it was
printed on a sheet of transparent plastic.

o With clipping mask: The transparent parts around the label are cut away. The label appears correctly.

Using clipping masks instead of normal transparency can improve rendering performance. It should always be used if the
transparency layer of a material represents a mask or a clipping path. However clipping masks should never be used if the

material contains semi-transparent areas or if actual transparency is needed.
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12.3 Layer images

Each of the aforementioned material layers (color, reflect, gloss, embossing and opacity) can be controlled by an image. Press the edit image layer or
the add image layer button next to the respective layer, as shown to the left. The image layer control window will appear (Fig. 12-02).

o

=

» Press the “Modify image layer’ button next to the respective layer.

[ 2]

Color layer

—

o Enable: Checking this box will enable the respective image layer
IV Enable:

o o] voe o] oo e o Image selector: Press the image selector button in order to load and apply an image to the layer.

Clicking on the image opens a small window with a larger rendering of the image and its
resolution

A Figure 12-02

o X/Y Move: Reposition the layer by moving it horizontally and vertically.
o X/Y Size: Change the horizontal and vertical dimensions of the layer.

Pressing the Ctrl key while operating the move or size spinners will increase their precision
for fine tuning.

o Lock layer: When pressed, the position and size of this layer will automatically follow any modifications
applied to the color layer.

o Channel: The UV mapping channel used by this layer. Store Visualizer supports up to 16 independent
channels. By default the first available channel is used.

[ Texture viewer =]
@ |4 afpmw I A small preview of the current image is shown on the right hand side of the image layer window.
&5 WIN EVER If you would like to see a larger preview or get more information, use the “Image viewer’ buttons
- label gree

to the right of each layer entry in the material editor panel.

\: Information: Displays the name, type and resolution of the image. “Display information
about the image” is activated by default.

o Save Image: Saves the image on your hard drive.
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12.3.1 Loading a new image

Press the “Image selector’ button to open the “Image loading” dialog. Store Visualizer supports all commonly used image formats such as jpg, png,

tga, tiff, webp, bmp, ppm and pdf.

A Figure 12-03

Automatic

Repeat image
Clamp image

12.3.2 Refresh image

W Enable: | Soda label (

X Move: |0.000 3 X Size: [1.000 E [T Locklaye
YMove: [0.000 [2] vsize: [Looo 2] chi [T 2

Invert alpha channel: If this option is clicked then the system will invert the alpha channel of the loaded
image.

Flip embossing in/out: Flips the direction of embossing masks. A positive displacement becomes
negative, and vice-versa.

Alpha coverage: Enhances the detail of images incorporating an alpha channel. This function is
particularly useful for elements such as plant leaves.

Image tile: this setting defines how repeating images are handled.
= Automatic: Automatically select the most appropriate mode (this is the default).
= Repeat image: Repeat the image by tiling it.
= Clamp image: Clamp the image at the edges.

Cut out label stencil: Enabling this option will add a transparent border around the image. This is useful
if the image is a label. The border makes it easy to freely position the label on a product without affecting
the other materials.

o Refresh image: After loading a new image into the layer, the “Refresh image” icon
appears next to the image name. Click on this icon if, for example, you have made changes
to the image using graphics software and wish to update the image in your project.
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12.4 Advanced settings

This section gives access to advanced optical properties of the material, altering the way light interacts with it. These properties are required to make
certain types of materials more realistic. Depending on the selected shader, this section may contain additional parameters.

+ Material editor Ll

B Banner
[a] metal

Standard HDR : G E
Standard l Advanced I

“ Secondary specular
™ Color: . - d o7
Reflect: ’—1‘.‘--

“ Advanced settings

Fresnel:  [100 %

Falloff: 0 E Y%

[ Metallic reflections
" Glossiness in reflect alpha
" Opacity in color alpha

= Color correction

Hue: 0 3 degrees

Saturate: 100 Yo

Brightness: |100 %

+ Self illumination

Intensity:  [15.00 2]

Secondary specular: Certain multi-layered materials, such as some metallic paints, use a second reflective
layer below the main one, with different reflective properties and color. This typically results in a hazy and colored
reflective halo surrounding the main sharp white reflection.

Fresnel: Certain materials exhibit an optical phenomenon called the Fresnel effect. In these materials, the strength
of the reflections changes with the viewing angle. A varnished wooden floor, for example, may only be moderately
reflective when seen from above, but will almost turn into a mirror when viewed at a shallow angle. You can control
the Fresnel effect by changing the value in the Fresnel spinner. At 100%, reflections are independent of viewing
angle, and there will be no Fresnel effect. At 0%, the effect will be very visible through a strong dependency on
viewing angle.

Falloff: The falloff effect simulates view dependent absorbency within transparent materials. The effect can be
used to improve the visual realism of hollow objects made from a refractive transparent material (glass bottles, for
example). When increasing the falloff value, the outline of a transparent object will look increasingly thick. A value
of zero disables the effect.

Metallic reflections: Metallic materials will tint their reflections while other type of materials will not. A gold bair,
for example, will have gold colored reflections, while a blue plastic bottle will not have blue reflections. This option
should be enabled if you are simulating a non-varnished metallic surface.

Glossiness in reflect alpha: When enabled, the glossiness layer will be sourced from the alpha channel of the
reflectivity layer image.

Opacity in color alpha: When enabled, the alpha channel of the color image layer will control the opacity of the
material.

Color correction: Use these functions to modify the hue, saturation and brightness of a base material.

Self illumination: Allows you to add a backlighting effect to the material, giving the impression that it's emitting
light (see chapter 12.8).
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12.5 Material presets

Materials can be independently stored by adding them to the material preset list. Material presets are automatically available from any environment

and can be applied to models with a simple mouse click. Presets can store complete materials with all surface properties, duplicating the full original
material. They can also store partial materials, only affecting specific layers or individual material settings.

Various commonly used standard materials already come with Store Visualizer. You can also add your own custom materials to the preset list.

 Click on the “Open material presets” icon (Fig. 12-01) to open the window “Material presets”. Fig. 12-04 will appear.

Material presets @
IGIass materials o8 Bl

= () Default materials
Paper
Glass
Metal
Plastic
®varnish
Miscellaneous

= & User materials

MR Glass materials

A Figure 12-04

12.5.1 Create new preset

o Default materials: Default materials contain a collection of generic standard materials.
o User materials: User materials contain your own custom presets.

o Create new preset: add a new preset using the material currently selected in the material editor (see
chapter 12.5.1).

o Remove current present: permanently delete the selected preset or folder.
o Add folder: add a new empty folder to the custom material collection.

o Activate current preset: press this button to replace the material selected in the material editor by a preset.

You cannot create or modify the presets in the “Default material’ branch. Before creating a new

material preset, make sure that either the “User materials” item or one of your own custom folders
is selected.

When creating a new preset, you will have to define what parts of the current material are to be stored. By default everything is stored, and the preset
represents a perfect replica of the original material. Some presets might only modify parts of an existing material. For example, a varnish will modify

the reflectivity and glossiness of a material, but not its color or transparency. In such cases, you may freely choose the parts of the material that will
be affected when the preset is activated.

Preset name:

|

-Apply preset to; ————
I Color layer
 Reflactivity
¥ Transparency
¥ Embossing

¥ Color correction

Preset name:

o Preset name: Enter a name for your new preset in the top entry field.

[l
-Apply preset to:
¥ Refraction
W Inner liquid

o Apply preset to: Select the settings and layer maps the preset applies to. By default, the new
preset will apply to everything.

- o Press Create to create the new preset.

A Figure 12-05

Parameters specific to refractive materials are displayed if the currently selected material
is defined as refractive (Fig. 12-05).
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12.6 _Refraction

The refraction shader uses realtime raytracing to simulate transparent and refractive materials such as glass and liquids in a photorealistic way.
e Click on the “Material shader’ drop-down menu and select the “Refractive” option. The “Material editor’ will display the refraction options (Fig.

12-06).

v Material editor

This option is only available for models imported from Store Visualizer 16.1.1. Models imported into
earlier versions of the software must be reimported.

=]

) cork

[ Bottle
[ Label
1 Liquid

T o @

&)

7

| Container with liquid

/D

By default, the refractive material will simulate a container with a liquid inside. Other types of refraction are possible.
Open the drop-down menu to select the type of refraction you want to apply to your material.

= Refractive volume: Simulates a refraction volume without liquid, such as a solid
block of glass for example.

Refractive volume
Container with liquid
Container inner wall

“ Color overlay

Color: 100 2%

| —

“ Refraction

Fresnel: 5.1 E %

Rough: 34 E %

IOR: 115 5]
Filter: Il.OO E
“ Liquid

Volume: |92.00 :l%

IOR: 133 5]
Fiter:  [HEEM -] [100 [5]

“ Advanced settings

" Multilayer refractions

\

A Figure 12-06

= Container with liquid: Simulates a refractive container with liquid inside.

= Container inner wall: Carves out the refractive volume to make space for a liquid.
See chapter 12.6.5.

Refraction settings: Additional parameters to refraction.

= Fix issues with bottom: Some 3D models may have modelling defects that will alter
the refraction effect, especially in the bottom of the model (the bottom of a bottle for
example). By activating this function, some of these defects can be corrected.

~ Raytracing

™ Fix issues with bottom

* Material thickness

= Set manual thickness: When the 3D model is not correctly modeled, it is possible

™ Set manual thickness . . .
to define the container wall thickness manually.

Thickness: [o.0 |5 mm

Color overlay: Applies a color overlay on the refractive part (see chapter 12.6.1). See chapter 12.3 on layer
management.

Refraction: This section controls the refraction parameters of the volume or container (see chapter 12.6.2).

Liquid: To obtain a perfectly realistic refraction, we simulate a liquid in a procedural way. This section controls the
refraction parameters and properties of the liquid (see chapter 12.6.3).

Multilayer refractions: See chapter 12.6.4
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12.6.1_Color overlay

This function allows you to apply a color overlay on the refractive part of a model. This will allow you to add, for example, a label or a layer printed
directly onto the refractive surface.

Add or modify color map: Used to manage the color overlay layer. See chapter 12.3 for more information on
= Color overlay layer management.

Color: 100 E% Q

o View color image: Opens the “Texture viewer’ window with additional information on the color map, such as
the image alpha channel, image resolution, etc.

Color: Allows you to change the opacity of the color overlay. A value of 0% will make the overlay completely
transparent while a value of 100% will make it opaque. The opacity of the overlay will also be affected by the
= alpha channel of the image assigned to the color layer.

s

Alpha channel

Without color overlay With color overlay

The image format imported in the color overlay must include an alpha channel used for the opacity mask (image formats with alpha
channel: png, tif, tga).
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12.6.2 Refraction parameters

This section controls the refraction parameters of the volume or container.

o Fresnel: The Fresnel field controls the reflectivity of the model surface. A low value will create a shiny surface, a high value a metallic
appearance.

Fresnel: 0% Fresnel: 5% Fresnel: 25%

o Roughness: This parameter adjusts the transparency of the refraction. A value of 0 corresponds to a perfectly transparent surface, while a
value of 100 creates diffuse refraction, giving a blurred or frosted appearance to the transparency.

Rugosité: 0% Rugosité: 50% Rugosité: 100%
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o IOR: The refractive index of the material. You will find common IOR values in the drop-down menu to the right of the value field.

IOR: 1.00 Air IOR: 1.15 Plastic IOR: 1.50 Glass

o Filter: The color filter changes the color of the refractive material. You can modify the filter power by modifying the value field to the right of
the color selector.

ST

A

Filter: white 0.10 Filter: green 5.00 Filter: green 15.00 Filter: white 0.10 Filter: blue 5.00 Filter: blue 35.00
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12.6.3 Parameters of the liquid

It is possible to add liquid to your container in real time and to animate it when you move it.

o Volume: Represents the volume of liquid in the container as a percentage.

Volume: 00% Volume: 50% Volume: 95% Volume: 00% Volume: 55% Volume: 75%

o IOR: The liquid refractive index simulates the behavior of the light in liquids. You will find common IOR values in the drop-down menu to the
right of the value field.

If your container already has a liquid modelled in 3D, you must first disable this material or put it in the “Container inner wall” (see
chapter 12.6.5).
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o Filter: The color filter allows you to modify the color of the liquid. You can modify the filter power by modifying the value field.

Filter: red 0.50 Filter: red 1.50 Filter: red 5.00

o Viscosity: A function that allows you to animate the liquid in a refractive container. By default, viscosity simulation is disabled. Select the
viscosity of the liquid from the drop-down list to activate simulation. When you move the object, the liquid will move according to the viscosity
selected.
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12.6.4 Multilayer refractions
Some models made up of highly concave parts may present rendering artefacts in the refraction. In the example below, the foot of the glass is not
visible through the top of the glass. The multilayer refraction function makes it possible to compensate for this.

Multilayer disabled Multilayer enabled

12.6.5 Container inner wall

If the imported model has an empty space inside the refractive part, and this hollow part is modeled by geometry using a different material to that of
the refractive volume, then this material must be defined as an inner wall. This will carve out the refractive volume and allow you to fill it with liquid. If
the material of the inner hollow part is identical to the material of the refractive volume, then the inner wall assignment will be automatic.

Example: You import the model of a bottle. The internal liquid is modeled as a separate object and

i y ;\‘ material. You will need to define this material as an inner wall, so that the modeled liquid creates a
% | hollow space inside the body of the bottle. Otherwise, the bottle will be treated as a single block of
solid glass.

Refractive models imported from Esko tools intended for Keyshot rendering will always
have a modeled liquid that will have to be defined as an inner wall.

Without inner wall With inner wall
Solid block of glass Hollow area inside
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12.6.6 Raytracing surfaces

By default, the elements visible through a refractive object come from the reflection sphere in which it is located. If the refractive object is close to other
objects (e.g. a transparent bottle on a table), the latter will not be visible through the refractive object. See chapter 12-07.

The raytracing surfaces will increase the realism of these situations. For a nearby object to be visible through a refractive material, one or more
raytracing surfaces must be applied. The raytracing surfaces generally apply to models close to refractive objects and not to refractive models
themselves!

In the example below, we see a glass bottle on a table. By default, the table will not be visible through the bottle (Fig. 12-07). By adding a raytracing
surface to the table, it will become visible through the refractive object (Fig. 12-08). Note that there is no raytracing surface on the bottle!

A Figure 12-07 A Figure 12-08

A raytracing surface is applied to the table and another raytracing surface is applied to the cardboard model.

:I§ Raytracing surfaces are generated automatically when you create a shelf frame or shelf panel (chapter 7) or when you import a model
and define it as a shelf frame or shelf panel support (chapter 6.7). You do not need to create them manually in these models, but you
can still modify them or add more.
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12.6.7 Create and modify raytracing surfaces

+ Model browser 4

e In the library, select the 3D model to which you wish to assign one or more raytracing surfaces. The 3D model
QUG o) & appears in the “Model browser”.

¢ In the “Model browser”, click on the “Edit raytracing surfaces” icon (Fig. 12-09). The “Raytracing surfaces”
window opens (Fig. 12-10). This window contains a list of all raytracing surfaces linked to the 3D model selected
earlier.

Add new entry: Add a new raytracing surface to the selected model. When the icon is clicked, it turns red
(Fig. 12-11) and invites you to select a surface in the model browser. Click the left mouse button on the
desired 3D model surface (Fig. 12-12). A blue gizmo, representing the raytracing surface, appears on the
selected surface (Fig. 12-12).

v . @ 7 ] | RS [&][[7 Model browser W e [5]|[=_Modelbrowser T
imported X3DW object — (@ EEEEEERE Top0.00 cm \:\ Ceauenya
2 B B
o - Y/
®lo®l #lg)ee ;
= & &
A Figure 12-09
Raytracing surfaces N | e e il
e ledw 0 vaaw 0
Imported X3DW object E Imported X3DW object E
- Bl SR e e I [ s s R I
& CEORCAR Y ) RlU® 2 vo0
v A Figure 12-11 A Figure 12-12
&

A Figure 12-10

:ﬁ A 3D model may have several raytracing surfaces. For best performance, we recommend you only add the surfaces required to
~_| obtain the desired visual effect. If your graphic card permits, you can increase the number of raytracing surfaces when rendering:
Preferences > 3D settings > Transparency and refraction > Raytracing > Amount of surfaces.
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Raytracing surfaces @

/ Remove entry: Deletes the previously selected raytracing surface from the list.

Top 0.00cm

o Pick surface: When a raytracing surface has been assigned incorrectly, select it from the list and click
on the Surface selection icon. The icon turns red and you can select a new surface on the model.

o Automatic surface adjustment: If you click on the icon when selecting the surface in the model
browser, the dimensions of the raytracing surface created will be adjusted automatically.

&< & 8 O
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12.7 Planar reflections

Planar reflections can be used to create precise, realistic reflections on flat surfaces, such as mirrors, display cases or shiny surfaces. By default, an
object’s reflections come from its assigned reflection point and area (see chapter 16.3.1). By activating the Planar Reflections function and adding a
reflection surface to the desired material, you can achieve more detailed and realistic reflections. This feature is ideal for enhancing the visual quality
of a project by adding a high level of detail to reflections.

Planar reflections can only be applied to flat surfaces. For curved or irregular surfaces, the reflection will come from the point and
zone of reflection (see chapter 16.3.1).

In the example below, you'll notice that the environment reflected in the oven’s glass door (Fig. 12.13) is not very realistic. By default, the reflection
visible on the door comes from a reflection point positioned in the environment, making it less accurate. By adding a planar reflection surface to the
glass oven door material, models and the environment surrounding the oven will be reflected more realistically (Fig. 12.14).

A Figure 12-13 A Figure 12-14
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v Material editor 4

B oven door
[a] oven handles
@] oven part 02

IStandardHDR : R |

[ Standard | Advanced |

“ Surface appearance

Color: & &
Reflect: I?E % Ly
Gloss: I?E % b &7
Emboss: m: e T

“ Transparency
Cpacity: |0 E% = T
Fiter: z

™ clipping mask

“ Reflections
@anar reflections @

— L

o Select from the library the 3D model to which you wish to assign one or more planar reflection surfaces. The 3D
model appears in the “Model browser”.

™ In the “Material Editor”, select the material to which you wish to assign a planar reflection.

Click on the “Reflection surfaces” icon (Fig. 12-15). The “Reflection surfaces” window appears (Fig. 12-16).
This window lists all planar reflection surfaces associated with the selected material.

o Create new entry: Adds a new planar reflection surface to the selected model material. When you click on
the icon, it turns red (Fig. 12-16) and prompts you to select a surface in the model browser. Left-click on
the desired reflection surface in the 3D model (Fig. 12-17). A blue gizmo, representing the planar reflection
surface, appears on the selected material (Fig. 12-17).

A Figure 12-15

=l
RPlOB| 28| B©

v Model browser R v Model browser 4
equegyea Feaueaya
( +| Reflection surface
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B
. O

V88w e (= % VaE@uwe Eo
Imported X2DW object = ——

imported X3DW object E
2]

RPlOUB| 2SO

A Figure 12-16

A Figure 12-17

Activate or deactivate the planar reflection of the selected material by checking the “Planar reflections” box
(Fig. 12-15). When this function is deactivated, the reflections visible on the material will come from the point of
reflection, resulting in a less realistic rendering (Fig. 12-13).

Adjust the percentage of reflection and gloss of the material to enhance the effect of the planar reflection (see chapter 12.1). The
higher these percentages, the sharper and more precise the reflection.
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12.8 Self illumination

| + Material editor 4

Standard HDR : L O ER
Standard | Advanced

“ Secondary specular

I~ color: . - 57
Reflect: 100 [=]%
Gloss: 0 [H%

“ Advanced settings

Fresnel: 100 %

IO E%

[T Metallic reflections

Falloff:

" Glossiness in reflect alpha
" Opacity in color alpha

“ Color correction

Hue: 0 E degrees

Saturate: 100 Yo

Brightness: |100 %

@ baical \

* Self illumination

15.00 [Z]

Intensity:

The self illumination function adds a backlighting effect to the selected material, giving the impression that it is emitting
light. This feature is ideal for simulating objects such as luminous screens, LED panels, signs or decorative elements,
giving them a luminous appearance.

In the “Material editor’, select the model material to which you wish to add self illumination.

» Adjust the intensity value to suit your needs and, if necessary, change the filter color too.

~RUNNING CLUB-

o™

Without self illumination With self illumination

Intensity: 15.00
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Chapter 13 : Management of dynamic lights

A project can contain two types of lights: static lights, which includes all light sources that were pre-calculated when creating the 3D scene (see
chapter 16.1), and dynamic lights, which encompass the 3D models containing one or more light sources that have been imported into a project.
Only dynamic lights can be positioned and moved in real time in the project.

13.1 _Import a model with one or more light sources

Importing a 3D file containing light sources is done in the same way as importing a standard 3D file (see chapter 5.2). In the “Import 3D file” window,
select the Dynamic Lighs section (Fig. 13-01). This section enables you to configure the 3D models that contain the dynamic lights.

Import 3D file

[ Options

[» Ambient shadows

= Dynamnic lights

|-: ustomn light type /]
Detail level: Adaptive shape:
|Nnrmal " |Strnng (75 %) "
Light range: I™ Bottom closed
100.00 : cm - I~ Top elosed
» Mapping

| Details

A Figure 13-01

Light type presets: Opens a dropdown list (Fig. 13-02) containing common light source types.
Selecting a light type will automatically modify the lighting parameters. If you used a preset type, you
still have the option of subsequently adjusting the lighting import parameters.

Generic open lamp

Table or desk lamp

Furniture or shelf frame with integrated lighting
Shelf panel with downwards lighting

<< Figure 13-02

Spotlight or downlight, short range
Spotlight or downlight, long range I
Narrow beam spotlight or downlight -

Detail level: Controls the resolution of the energy field created by the light source. By increasing the
detail level, you will increase the quality, but will consume more memory.

Light range: Controls the maximum range of the light on the environment.

Adaptive shape: Represents the direction/diffusion of the light beam in the environment according to
the contours of the source. A highly focused source, such as a spot light, presents a higher adaptive
shape than an omnidirectional source, such as a bare bulb.

Close bottom: If checked, the energy field will be cut off below the floor in order to not waste
memory. This function is useful for all 3D models placed on the floor.

Close top: If checked, the energy field will be cut off above the source in order to avoid light artefacts
from lights placed on thin surfaces (e.g. a line of LEDs positioned on the bottom of a shelf).
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13.2 Modify the model lighting

e In the sidebar, select the Tools section and open the “Model lighting” panel (Fig. 13-03).

e Select a 3D model containing a light source from a library. The lighting parameters of the model will be shown in the “Model lighting” panel.

+ Maodel lighting

4l

/O

¥ Lightsource

Luminous flux: 5000
Temperature: |4000 E
l P,

I

K

a

‘ Custem spectrum

s |

[ Advanced settings

A Figure 13-03

+ Model browser 4

[FleaueBnda

s BB |

Ve & » g

A Figure 13-05

source.

Light sources: The top part of the panel shows a list of independent light sources present in the 3D model.
Click an entry to select the source that you want to modify. Double-click an entry to modify the name of the

o Bulb icon: The bulb icon in front of the name of the light source acts as a switch to turn the light source on

or off.

o Luminous flux: Controls the quantity of light emitted per unit time, in lumens (Im). For example, a 75 W
halogen lamp is equivalent to around 1190 Im.

Temperature: Controls the color temperature of the light source in Kelvin.

Custom color mode: Clicking on the “Custom color” icon replaces the color  [[rrconr [ 3
temperature selection cursor with a custom color cursor (Fig. 13-06). Click on E 7
the color square to open a window that enables you to choose the color you =

want.

Incandescent
Halogen
Fluorescent warm
Fluorescent neutral
Fluorescent cold
Fluorescent daylight
Metal Halide HMI
Sodium vapor

4]

A Figure 13-04

A Figure 13-06

o Light type presets: Opens a dropdown list (Fig. 13-04) containing
common types of light sources. Selecting a source type will automatically
adjust the color temperature.

e Click the “Display model with light range” icon (Fig. 13-05) to show a red gizmo representing the light range for
the 3D model. Click the icon again to hide the light range.
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13.3 How to create a 3D model with lighting using CAD software
In order for Store Visualizer to be able to recognize, during import, that your 3D model contains one or more light sources, you have to use a certain
method when modelling the 3D model with CAD software.

¢ In the CAD software, select the mesh or object that will produce the light (bulb, neon tube, etc.).

» Add the term Lightsource at the beginning of the mesh or object name. For example, the name could be Lightsource neon 1. All meshes
or objects for which the name begins with Lightsource are identified as light sources by Store Visualizer.

e You can also specify the luminous flux by indicating the number of lumen (Im) after the term Lightsource in the name. To do this, you
have to leave a space or underscore _ between Lightsource and the number of lumen followed by Im. For example, Lightsource 25Im
or Lightsource_25Im. If you do not specify the luminous flux in the name, a default value will be used. You can always modify the value of
the luminous flux in real time after importing the 3D model into Store Visualizer.

e Export the 3D model in a format that is compatible with Store Visualizer.

o Import the 3D file into Store Visualizer (see chapter 13.1). After importing, the 3D model will appear in the library and you will be able to
adjust the lighting parameters (Fig. 13-07).

Edaroge du modec E
1 Lightsource 2sim
Luminous flox: [25 5] m
Temperature:  [4000 5] K

A Figure 13-07

:g Currently, if you import a 3D model containing several light sources, all the sources will be combined into a single light source to
avoid excessive memory consumption and overly long calculation times when importing.
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Chapter 14 : Management of model meta data

Store Visualizer gives you the option of adding meta data to the 3D models and displaying it in real-time. The meta data can be input manually or
imported from a database or a planogram file.

* On the sidebar, select the Tools tab, and open the “Library” panel (see chapter 5.1).
o Select one or more 3D models to access their meta data. You can also select one or more folders or a library to access the meta data of the
models that they contain.

|€.‘ By default, the models imported into the software do not display meta data.

* On the sidebar, select the Scene tab, and open the “Model meta data” panel (Fig. 14-01).

The model meta data is displayed in two columns, a field name and its value. The field, also called a metatag, describes the type of information
represented by the meta data (e.g. manufacturer, price, product color, etc.) The value encodes the content of the meta data for each model.

¥ Model meta data 4] o Add new fields: Opens the “Add meta data” window (Fig. 14-02) which enables new tags as well as their
|q}‘ o s e initial value to be added.
Field name |\,fa|ue | | o Import meta data: Enables *.CSV files to be imported from a database containing meta data.

o Remove selected fields: Deletes the selected tags as well as their values.

o Show product meta data: Displays the meta data of the 3D objects selected in the scene in a floating
window (see chapter 14.4)

o Edit product meta data info panel: Allows you to select and present the meta data relating to the
products that will be displayed in the information panel (see chapter 14.5).

A Figure 14-01 o Field name: Shows a list of all tags used by the selected 3D models.

o Value: Shows a list of values associated with the tags.
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14.1 Add a new metatag
e In the “Model meta data” drop-down menu, click the “Add new fields” icon (Fig. 14-01). The “Add meta data” window opens (Fig. 14-02).

o Click the “Add new entry” icon. A drop-down menu appears in the Field name section (Fig. 14-03) and in the Value section (Fig. 14-04).

Add meta data
L= Add meta data B
Add the following meta tags:

Add meta data

Add the following meta tags:

Add the following meta tags: -
Field name

UPC/EAN

Field name

Field name Value | |

Product ID Leave empty

Manufacturer a Model name
Brand = Model description
Category
Subcategory 1
Size
o
oK Weight :l oo’ oK | ‘ Cancel
Iy Color -

A Figure 14-02 A Figure 14-04

A Figure 14-03

o Select the entry that you wish to add to the model in the drop-down menu (Fig. 14-03). The list contains a selection of tags commonly used in
the packaging and retail sector.
e Select in the Value drop-down list (Fig. 14-04) the initial value relating to the tag.
o Leave empty: The value of the tag will be empty. You can then modify it manually or by importing from a database.
o Model name: The value of the tag will match the name of the 3D model.
o Model description: The value of the tag will match the description of the model.

o Custom value: Double-click in the value column in order to insert the desired initial value for the tag.
o Repeat the process if you wish to add several tags.
:lg If your 3D model contains the UPC/EAN number in the “Model description” entry field (Chapter 5.4), it is possible to automatically

retrieve it and display it in the value of the UPC/EAN tag. In the Value drop-down list, select the Model name or Model description
option to retrieve the UPC/EAN number and have it automatically displayed in the UPC/EAN tag.
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14.2 Manually modify the values of metatags

e Double-click in the Value column, across from the Field name (tag), to modify the value manually (Fig. 14-05).

v Maodel meta data L]
oo RS

Field name |\.-’a|ue | |
UPCJEAN 1234567890
Manufacturer

Brand

A Figure 14-05

14.3 Import meta data

¢ In the “Model meta data” panel, click the “Import meta data” icon (Fig. 14-01). The “Load database file” window opens.

o Select the database file that you wish to import.

|c Store Visualizer imports *.CSV files.

o Confirm your selection by clicking Open. Cancel will abort the import operation.

e The “CSV table import” window (Fig. 14-06) will appear. This enables you to choose how the CSV fields will be assigned to the metadata fields.

|€-.- The Values contained in the CSV file will replace all the Values of tags already present.
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The “CSV table import” window allows you to configure how the CSV file will be linked to the 3D models selected in your library, as well as choose
the assignment between the fields available in your CSV file and the metadata fields (metatags) in Store Visualizer.

C5V table impa

Encoding: |Latin 1, 150 8859-1, CP-1252  ~|

Separator: |; j

Please select the row containing the field header names:

o Encoding: Enables the type of encoding used when creating the CSV file to be

selected to correctly display the information from the imported file. If the CSV encoding
is incompatible, the following notification will appear in the import window

< No header line >

T

EAN;Manufacturer;Brand;Category;Subcategory;Cost;3D models;Color
5410228085805:AB InBev:Jupiler:Beer:Can:-;jupiler can 50cl;
5410228142027:AB InBev;jupiler;Beer:Bottle:-jJupiler beer:
5410228141303;AB InBev;Stella Artois;Beer;Can:-;Stella Artois can 50cl;
5410228141235;A8 InBev;Stella Artois;Beer:Bottle;-;Stella Artois;

4 I [ [«

Choose how the €SV fields map to meta data fislds:

CsV field Meta field Match with
Manufacturer

Brand

Category

Subcategory

Cost

3D models

Color

[» Advanced matching

A Figure 14-06

[» Advanced matching

Unicode (UTF8)

Latin 1, IS0 8858-1, CP-1252

Separator: Enables the type of separator used when creating the CSV file to be
selected. In the example shown, the separator is ;

Row selector: Enables the header line of the CSV file containing the field names to be

selected.

CSV field: Shows a list of column headers in the CSV file.

Meta field: Drop-down list showing the metadata fields (metatags) available in Store

Visualizer.

Match with: Drop-down list containing the various ways of linking the lines in the CSV

file with the 3D models (Fig. 14-08).

o Use the “Meta field” drop-down list (Fig. 14-07) to assign a corresponding meta field (metatag) to the CSV field. If you do not want to assign a

tag, select the option None.

Choose how the CSV fields map to meta data fields:

[csv field

|Meta field IMat:h with

Manufacturar

MNone
Category UPC/EAN
Subcategory Product ID
Cost Manufacturer
3D models Brand

Color Category
ubcategory

[* Advanced matching S
- ISize

Weight
Color

A Figure 14-07
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o Use the “Match with” drop-down list (Fig. 14-08) to define how each line in the CSV file is linked to the corresponding 3D model, selected in

your library.

Choose how the CsV fi

elds map to meta data fields:

csv field

[Meta field [atch with

EAN
Manufacturer
Brand
Category
Subcategory
Cost

30 models
Color

[+ Advanced matching

Model name
Model deseription

UPC/EAN
Product ID

Manufacturer

Brand
Category
Subcategory
size

Don't use for matching

s

[

e Import your file by clicking OK. Cancel will abort the import operation.

A Figure 14-08

=

i

In the example (Fig. 14-08), the CSV file has a “Name” field which lists the
names of the 3D models. It is therefore via the name of the 3D model that we will
be able to link the CSV file to the 3D models present in the library.

In certain complex cases where there is no direct equivalence between the
name displayed in the CSV and in the 3D model, Regex filters can be used to
customize the comparison (Advanced matching).

e Once importing is finished, the “Info” window appears and informs you whether the CSV has been properly loaded and the number of 3D

models to which the metadata has been assigned.

v Maodel meta

data 4

ool sz

Description A
Description B
Description C
Description D
Logo

Field name ||\value

UPC/EAN 4578000000101
Manufacturer||Esko

Brand Healtic
Category Health
Subcategory |[Vitamins
Weight 200

Price 9,89

Combo green
Natural Health De
BE
Healtic_Combo_G
[El Healtic.png

[ [4v]

A Figure 14-09

e Select a 3D model in your library to which you have assigned metadata. These will appear in your “Model
meta data” panel (Fig. 14-09).
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14.4 Display product meta data

@ * On the sidebar, select the Scene tab, and open the “Model meta data” panel (Fig. 14-01).
» Click the “Show product meta data” icon to activate the display function. When you select a 3D object in the scene, a floating window

(product info panel) will appear displaying the metadata for the product (Fig. 14-10). Unclick the “Show product meta data” icon to
deactivate the display function.

» The product meta data displayed in the information panel is editable (see chapter 14.5).

—

VVELEDR

glell

Eojoeee@ s8I0 K

9,89, 9,89

neaitic
NATURAL@lI Healtic-
SyT—— a ealtic-
Healtic s

HeART
I\‘J‘M‘UQAL 7 A a_,,'\‘\é,
Healtic-

| ealtic 9,89 (

HEART

NATURAL /

e e T

0w

Store Visualizer 23 Bz

(g Project | g7 Tools | (Jscene |

[+ scenegraph a

9,89,

| » Material editor 4

Healto

HEA 18

M—

altic

—_——

S

‘bH@mm

(o o

HEART N\

[

| * Model meta data 7]

RS I ()7
feld name

UPC/EAN 4578000000101
Manufacturer Esko

Brand Healtic
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A Figure 14-10
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14.5 Edit product meta data info panel
La' » On the sidebar, select the Scene tab, and open the “Model meta data” panel (Fig. 14-01).

o Click the “Edit product meta data info panel’ icon. The “Edit product info window” appear (Fig. 14-11).

Edit product info window x 1. Click the Add new entry icon to create the different sections that will make up your Product
TLogo,orand] 1E| Info floating panel. In this example, the information window has 5 sections (Fig. 14-11). You can
= enter any text you would like to appear as part of the section.
[Subcategory] o
[DescriptionA] - 2. Use the meta tag dropdown to insert product specific data into the section text. You can insert
multiple meta data tags into a single section. When multiple consecutive tags are separated by
[DescriptionB] commas, the first available tag for a product will be used. The appearance of the text can be
customized for each section individually (font size, color, alignment).
Elbiicel Click on the “separator’ icon to insert a visible separation line below the section in the price
board.
[verylarge =] [Right =] [ ~| & | [nsermetatan v‘|2
A Figure 14-11
Insert meta tag -
s B If you have a logo or an image added in the model meta data panel, it will be
- ;ﬁ:ufa‘:turar = displayed on the price board if you insert the respective Logo or Image meta
[Logo,Brand] i tags into a section. (Fig. 14-12).

Subcategory
[Subcategory] -

Weight
T Color

[DescriptionA] Price

AP

A Figure 14-12

[DescriptionB]

3. Hover your mouse over a section separation line, press the left mouse button and drag the
€[Price] mouse up or down to change the size of a section.

A Figure 14-13
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Chapter 15 : Physics

Store Visualizer comes with a physical simulation module which allows you to simulate collisions and the application of physical forces onto your
products. Amongst others, it can be used to interactively visualize shelf placement constraints or gravity feed shelving systems.

Yok » Select the physics toolbar by clicking on the “Physics” icon (Fig. 1-01) located on the bottom panel bar.
t‘ﬁéﬁ * The physics toolbar appears (Fig. 15-01), and is now active.

= * x1 ; -
I_) | Physics will run in automatic mode (v - | (RS L i | Cad | E

A Figure 15-01

15.1_Simulation control

When a project is opened, all the objects in it will be affected by the physical simulation. This is indicated by the message “Physics will run in
automatic mode’. If you are working on a project with a very large number of products or your computer is not very powerful, you can assign the
physical simulation to a specific part of the scene (see chapter 15.1.3).

D * The Play/Stop button controls the current status of the simulation. Press “Play” to start running the simulation, and “Stop” to interrupt
it. Once the simulation is running, all objects placed within the environment will be subject to physical laws. They will collide with other
lE.I objects and will be affected by gravity and other external forces. Objects that were placed in an unstable position will slide, roll or fall.

+ Automatic simulation « Click the “Simulation mode” icon to choose the parts of the project the physical simulation is applied
Simulate selected objects to. Select a mode according to the project complexity and your requirements in terms of the simulation.

Simulate the entire scene

i

[ |

e | The simulation mode is set to automatic by default.
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15.1.1 Simulating physics in automatic mode

When simulation in automatic mode is started, the physics will exclusively affect the objects that you have selected and that you will manipulate, taking
into account the environment around them (shelf frames, shelf panels, other products). For example, if your row of shelf frames has shelf panels aligned

at the same height, you can pull a product along the shelf panels while pushing the other products located on them. All products located on the floor will
be affected by physics when starting the simulation in automatic mode.

However, physics is not simulated in automatic mode when you take a product from a shelf panel and move it to a shelf panel that is not adjacent (a
shelf panel located above, below, or on another shelf frame). In this specific case, your product will cross the other products! You will have to again
select the product positioned on this new shelf panel to start the simulation.

oy » Click on the “Change simulation mode” icon and select “Automatic simulation” in the drop-down menu. The message “Physics will
t:_g_; 2 run in automatic mode” is displayed.

o Click on the “Start/stop simulation” icon to start the physical simulation in automatic mode. The message “Physics is running in
automatic mode’ is displayed.

This simulation mode is recommended for virtual reality simulations and for projects presenting many 3D
objects.

15.1.2 Simulating physics on the entire scene

_ e When the physical simulation is running in automatic mode or on part of the scene (see next chapter) and you want the entire scene to
G.Ji‘:r A be affected, click on the “Simulate the entire scene” icon. The current physical simulation process will stop automatically. Press the
“Start’ icon again to start the simulation.

To avoid performance issues, it is recommended to simulate physics on the entire scene only on small projects.
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15.1.3 Simulating physics on part of the scene

You can assign the physical simulation to a specific part of the scene such as a display space, a shelf, a rack, a tray, a POS or similar (partial
simulation).

N ¢ Step 1: Click on the “Change simulation mode” icon and select “Simulate selected objects” in the drop-down menu. The message
Q;_g_; * “Physics will affect parts of the scene” is displayed.

| e Step 2: Select the 3D objects to which you wish to apply the physical simulation. Then click on the “Add all currently selected objects
Lq_‘j_,- to the simulation” icon.

To assign the physical simulation to all the products present on a shelf, on a rack or in a display space, you must first change
construction mode (see chapter 8) to select the shelf, rack or display space to which you want to assign the simulation. Once you have
selected it, click the “Add all currently selected objects to the simulation” icon. Return to product mode (F2) to proceed to step 3.

All 3D objects created while the physical simulation is running on part of the scene will automatically be affected by the
physics.

e Step 3: Press the “Start’ icon to activate the simulation. The message “Physics is running on parts of the scene” appears. All

products selected in step 2 will be affected by the physics. Press the “Stop” icon to interrupt the simulation.

A 3D object affected by a partial physical simulation will pass through all the other objects not affected by the partial
simulation, except shelving, which will always be affected automatically.

Store Visualizer 25.11 143



15.1.4 More actions

Several additional options, influencing the physical simulation modes on the selected objects or on the entire scene, are available through the “More
actions” menu located to the right of the physics toolbar.

* Open the menu “More actions” located to the right of the physics toolbar.

: o Sleep all objects on run: At the start of the physics, all objects placed in the scene in an unstable position
+ Sleep all objects on run will remain in place. If the function is not active, they will fall at the start of the physics.
+ Sleep objects on shelf

o Sleep objects on shelf: At the start of the physics, all objects placed on a shelf in an unstable position will
remain in place. If the function is not active, they will fall at the start of the physics.

Maore Actions A| ‘

A Figure 15-02

15.2 Put scene to slee

= | e In certain situations some objects may become unstable and jitter or shake slightly. In order to stabilize such objects, select them and
Cﬁ’j press the “Put scene to sleep” button.

Alot of physical instability issues are due to problems in the geometry of imported 3D models. Please use your CAD modeling
application to make sure that your imported models have clean geometry and a planar base. The “Show collision envelope”
tool in the Store Visualizer model browser can help you to identify such problems.

15.3 Simulation time scale

*1 The time scale slider controls the speed at which the simulation runs. By default, the simulation will run in realtime, corresponding
Lo to a scale of 1x. Dragging the slider to right will increase the speed of the simulation, creating a time lapse effect. Dragging it to
the left will put the simulation into slow motion, allowing you to observe physical effects that would otherwise be too fast to see.
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15.4 Moving objects with the physics module

You can interact (move/rotate) with objects under physical simulation the same way you learned in chapter 6. However when a simulation is running,
a number of physical restrictions apply. You may not push an object through a shelf panel or another object, for example.

While you are moving or rotating an object, certain physical laws are temporarily disabled. This makes it easier to manipulate the object. Once you
stop interacting with it, by releasing the left mouse button, all physical laws come back into effect. For example, you might move a product out of a
shelf, holding it floating in the air. Once you release the mouse button, gravity will make it fall down.

15.4.1 Toggle between physics or conventional move

{:{—_3 ¢ The Toggle between physics or conventional move button selects how collisions between the object and the environment are handled.

o If the icon is clicked, the displacement force of the object is reduced and proportional to its mass. The object collides with the
other objects in its environment without unduly affecting them. This is the mode used by default.

o If the icon is not clicked, the displacement force of the object is very significant, ensuring its accurate movement. The objects
located in the environment will be affected by it, giving priority to the moving object.

\ le="| The object move, rotate or scale mode must be active in order to interact with objects. See chapter 5 for more information.
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15.4.2 Drag object

&

» Dragging is an alternative mode of moving an object. It is only available while a physical simulation is running. It works by grabbing the
object at a point, and pulling it as if it was attached to a rubber band. Dragging is a very flexible mode of interaction, and it is the most
physically correct. All physical properties are taken into account while dragging, including mass, momentum and friction.

« Enable dragging mode by pressing the “Drag object’ icon. Now click on the object you would like to move at the point you would like
to attach the virtual rubber band. Hold the left mouse button and move the object.

o If you press the Ctrl key while still holding the left mouse button, you may move the object up and down. Without the Ctrl key pressed,
your movements will be on a horizontal plane.

Drag object Drag object + CTRL
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15.5 Physical properties

In order to react realistically, the simulator needs to know about a number of physical properties, such as the models weight and surface.

¢ On the sidebar, select the Tools tab, and open the “Model physics” panel. Fig. 15-03 will appear.

v Model physics

L]

¥ Enable physics
[ Lock object position

Mass: |1.000 E kg

= collision accuracy
Collision envelope:
| Global box - |

~ Material properties

= Packaging
l:_:_l Carton
[:3) Plastic
(2 Glass
2 Aluminum
= Construction
(551 bte

Bounciness (%): I0.00 :]
Friction (CoF): IO.GO E]

[ Joints

A Figure 15-03

o Enable physics: Enable or disable physical simulation on objects created from the selected model.

o Lock object position: Objects created from models with this option enabled will be glued to their position in
the environment. They can still be moved by the user, but not by external forces such as those generated from
collisions or by gravity.

o Mass: Defines the mass of the model in the weight unit active for the current project. Heavier objects will have
more momentum when they collide with other objects, and they will require a larger force in order to be moved. The
default mass is 1kg (2,2Ib).

o Collision accuracy: See chapter 15.6 for details of the collision envelope parameters.

o Material properties: Use the Material properties section to assign a certain surface material to your model. The
surface type will change the way objects react when they are in contact with other surfaces or objects. A rough
surface material such as cardboard is less likely to slide (it has higher friction) than a smooth plastic surface, for
example.

The predefined material list contains a selection of commonly used generic material types. Click on an entry to
assign a surface material to your model. Materials can be customized using the bounciness and friction spinners
described below.

o Bounciness: The bounciness or elasticity defines how easily an object bounces away on a collision. 0% will result
in objects that do not bounce at all, while 100% will yield highly elastic objects.

o

Friction (CoF): Friction defines how fast a slipping object slows down. The higher this value, the more friction the
object experiences while sliding over a surface and the quicker it will come to a halt.

|c_‘ Changing the surface material will only affect the way a model reacts in the physical simulation. It will not
change its visual aspect.

o Joints: Enables or disables joints to animate 3D objects. See chapter 15.7 for more information.
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15.6 Collision accuracy

The physics simulator typically uses an approximate shape representing the object so to increase the performance of the simulation. The collision
accuracy section allows you to control the precision of this shape. The default accuracy, global envelope, is appropriate for most packaging models
or consumer products. If however your model contains large cavities in which other objects are placed into (for example a tray or a display), then the
default mode is not appropriate anymore. The shape would cover the cavities and you would not be able to place any objects into them. For such
models, select the decomposed envelopes mode or the planar envelopes mode.

When an object is frozen in the scene, it will automatically have a highly accurate collision envelope.

15.6.1 Viewing collision shapes

You can easily view the shapes generated by the physics simulator by using the two envelope viewer buttons in the model browser panel:

Iil o Press the “Show model with collision envelope” button to display the model together with its physics envelope. Click the button
again to hide the envelope.

o Press “Show collision envelope” to display the physics envelope alone, without showing the original 3D model.

v Model browser i v Model browser ] v Model browser 4

EEEERERE] Eleacenda Geavendd

@a w u o s(@v 0
Global box Global envelope Global envelope
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15.6.2 Collision envelope - Global box

The accuracy of collisions between the 3D models will depend on the collision envelope that you have allocated to each of your models. The physical

simulation model offers you four types of collision envelope. You have to select the collision envelope suitable for the physical simulation to run
optimally.

Model browser s ||~ Model physics 4
T — » Global box: this mode approximates the objects’ shape with a box. This is a very high
I~ Lock object position performance mode, and is ideally suited for models that have an inherently box-like

CLERNRTTNT shape. If applied to models that are not box-shaped, this mode may generate visual
: . E ki . . . .
Mess! 11900 g errors in the physical simulation.

= Collision accuracy

Collision envelope:
| Global box - ‘

E’ When a 3D model is imported, the physical module automatically detects

~ i e whether it can have a box-type envelope. The global box collision envelope

= Packaging

is automatically selgcted. You still have the option of choosing another type
T W (&) Plastic of envelope at any time.
[ Glass
@@ @ O ) Aluminum
[ Construction
Imported Collada object 2 [ Wened
E Bounciness (%): I0.00 E
. _ Friction (CoF): |0.60 E
PO 2F ©O
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15.6.3 Collision envelope - Global envelope

Model browser =] nv Model physics [

e - = ¥ Enable physics
(
v_oBdwe | I Lock object position

» Global envelope: this mode fits a convex skin around the model, following its outline

mass: [Looo 2] kg as close as possible. The global envelope mode achieves both good performance and
fits models with arbitrary shapes.

= Collision accuracy

Collision envelope:

As such, it is a good default choice for most non-box shaped products. This mode
cannot be used with hollow models containing other objects (such as trays, hollow

e— boxes or displays, for example). The envelope will cover the cavity and you will not be
~ properties ; L "
able to place objects inside it.

’ |G|oba| envelope - ‘

El Packaging
L:J Carton
[53) Plastic
[ Glass
([@a «
[El Construction
Imported Collada object ) Winnd

O

:g The global envelope mode is applied by default to new imported models with
Eeees R | D the exception of models that can have a box-type envelope (see previous

PlOU® 2¥ DO Friction (CoF):  [1.10 chapter).

KNI L
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15.6.4 Collision envelope - Decomposed envelopes

Model browser =] “v Model physics 4
7 s : A v Enable physics
= Y, . 3 . . .
sacenda | I™ Lock object position ¢ Decomposed envelopes: this mode can fita model very closely by using a combination
Mass: [Looo 2] ke of multiple convex envelopes and thus allows a very precise simulation. It should be

used for models featuring large cavities.
~ Collision accuracy

collision envelope: o Quality: quality of the decomposed envelope.
‘Demmpcsed envelopes '|

o Concavities: Detail level for the decomposition of cavities.

Quality: Concavities:

‘ Coarse hd ‘ | Normal v|

Decomposed envelopes require high performance and may therefore significantly slow
down the physical simulation if there are too many of them. We advise you to only
activate this type of envelope if the envelopes above do not generate the required quality.

+~ Material properties

= Packaging
@@ & O [ carton

& |2 Glass
H (23 Aluminum
=]

Imported Collada object

E Construction
=1 winnd

In the example below, the object presents a global envelope versus a decomposed
T ) envelope. The global collision envelope is less accurate and the contours of the model
Blvolawiovo Bounciness (%): [20.00 [Z] are less well cut out but the simulation speed will be faster.

Friction (CoF): 0.32 E

Decomposed envelope - Coarse Global envelope

When you select the decomposed envelopes mode or you modify the quality or the cavities, the system will have to prepare the new
envelope. This operation is performed only once and the result of the calculation is saved in the library.
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15.6.5 Collision envelope - Planar envelopes

Model browser

v Model physics

PeQuoenwa

¥ Enable physics
" Lock object position

Mass: |1.000 E kg

=~ Caollision accuracy

Collision envelope:
| Planar envelopes '|
1l ! I ! 1 v 1, L 1
Quality: j—
(T I T T S |
Haoles:

“ Material properties

Qu

Imported Collada object

RlO®| 2| O

=] Packaging
[ Corton|
[ Plastic
[ Glass
(22 Aluminum
1 Construction
= Winnd

Bounciness (%): |0.00

0.60 E

Friction (CoF):

e Planar envelopes are used in models consisting of hollows or individual planar
elements, such as cardboard panels or metal sheets. Planar mode was specifically
designed for use with trays, displays and similar models.

Planar mode does not work with models not made of distinct planar elements. In this
case, the decomposed envelopes settings should be used instead.

o Quality: Quality of the planar envelope. The further you drag the slider to the
right, the higher the quality of the planar decomposition will be. In the example on
the left, you can thus increase the rounded cut of the cardboard box.

o Holes: Minimal area of holes to be decomposed. The further you drag the
slider to the right, the more you decompose the holes present in your model. In
example figure 15-04, the holes on the bottom of the tray will appear with a higher
decomposition of the holes.

Model browser
CPeacenwga |

= Model physics

-

¥ Enable physics
™ Lock object position

Mass: |1.000 E kg

= Collision accuracy

Collision envelope:

Planar ervelopes -

Qualiy:

Moles;:

“ Material properties

= Packaging
@ iz s (2 carton
Imported X3DW object E (L Plastic
L glass
E () Atuminum
= = construction
o = =
Pl ¥ v O
Bounciness (%): [0.00 2]
Friction (CoF): 045 2]
A Fig 15-04
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15.7 Joints and hinges

Nothing seems more natural than being able to open and close a door! The “joints” function integrated into the physical simulation will allow you to
animate the 3D objects of your project. Animated objects greatly increase realism and provide a better experience, especially in virtual reality. For
example, you can open and close a door, slide drawers, animate objects with motors, etc.

15.7.1 Preparing the scene

e Step 1: In order to properly animate a 3D object using the joints, make sure that the 3D model you wish to use is correctly modelled. For

example, if you want to open or close the different parts of a fridge with the joint system, the different parts of the fridge must be separate
3D models.

e Step 2: Then position the different 3D objects in the set using the classic creation and positioning tools (see chapters 5-10; 5-13). The
physical simulation is not active!

:ﬁ The fridge is configured as a standard shelf support (see chapter 6.7), the doors and the drawer are standard models. Check your
3D models’ collision envelopes beforehand (see chapter 15-6).

 Step 3: Using the “Model physics” section, configure the desired joint type on the different 3D models. In the example above, the fridge doors
have a Z-axis rotation joint and the drawer has a Y-axis slide.

» Step 4: Start the Physical simulation (chapter 15.1) in automatic mode and click on the “Drag objects by its pickup point’ icon (chapter
15.4.2) to manipulate joint objects, as in our example: open and close doors, pull drawers, etc.

The animation from the joints only works when the physical simulation is active. The same applies to virtual reality!
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15.7.2 Rotational joints

e In the “Model physics” drop-down menu, open the Joints section. This section will allow you to set the desired joint type on the currently
selected 3D model in the library (Fig. 15-05). By default, the 3D model is not equipped with one (disabled). Choose from the drop-down menu
the type of joint you wish to apply to your 3D model (Fig. 15-06).

5 |oints

| Disabled -|

Mew anchor

¥ Enable static collisions
™ Limited

Start: 0.00 = &
End: 0.00 = &

: Free moving |

A Figure 15-05

7 |oints

Disabled hd
Disabled -

Rotation X Axis
Rotation ¥ Axis
Rotation Z Axis

Sliding X Axis k -

A Figure 15-06

Rotation Z Axis hd

Local arigin

A Figure 15-07

o Disabled: Disables the joint on the selected model.

o Rotation on X,Y,Z axis: Activates a rotation on the selected axis (X,Y or Z). For example, | want to open or close
a conventional door, | will activate a door rotation joint on the Z-axis (up-down direction axis).

When activating a rotation, you will need to define a point around which to rotate. When you select the type of
rotation joint, a list appears of the anchor points associated with the 3D model. By default, the Local origin point
(Chapter 5.18) of the 3D model is selected. This point is not always the ideal point to perform the desired rotation.
To define a new rotation point, you will need to create an anchor point. This will be displayed in the list. Select it
to activate it.

FERE| vy BRIV C|& Store Visualzer 23 BIE

& Tools
+ Ubraries i
(& ubrary + 5]
[Bedroom 01 door Q

¥ Enable physics
I Lock object position.

Mass: [1000  [Ekg

-~ Collsion accuracy
Collsion envelope:

R
 Material properties.

BBedioom 01
0 Richard Bed 01X30W|
O Table 01.X30W
Ocarpet01xaDw ||
OLamp 01.X30W
ULamp 01_v2.x30W
U Poof 01.X3DW
U Books 0L.X3DW.

UPainting 01.X30W
UPainting 02.X30W.
0 Bathroom furniture 02—
| ® &edroom 01 door]
0 AM158_56.X30W.
0 AM149_007 Picture x|
& Badroom 02

Bounciness (%):  [0.00

i -0
JE BlLEn| &
'+ Model browser ]

EEEEEERE

Friction (CoF):  [0.45  [5]
Joints

Rotation Z Axis -

F il

sett oo B 2
o ez B 2
Enable friction B
Fricom: [o5 B
vedue SIS
Imported X30W object |
Inside door 02:x3dw I
&l
RlO® | 2L|DO ]
‘-@Q | A [ | Physics is runring in automatic mode @~ More Actions ~

& () |1 objectselected
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15.7.3 Sliding type joints

° Joints

Disabled

Disabled

Rotation X Axis
Rotation ¥ Axis
Rotation Z Axis

Sliding X Axis

A Figure 15-08

15.7.4 Setting up joints

¥ Enable static collisions
[ Limited

A Figure 15-09

¥ Limited
Start: I0.00 E
End: |115‘22 E

é

A Figure 15-10

| Free mowving -

Enable friction
Enable motor
Enable spring

Free moving

A Figure 15-11

o Sliding X,Y,Z axis: Activates an action to slide the object along a selected axis (X,Y or Z). For example, |
want to slide a drawer forwards and backwards, | will activate a sliding axis of the drawer on the X or Y axis
depending on the model (front to back direction axis) (Fig. 15-08).

o Activate static collisions: Static collisions will be activated on the object when you simulate the joints
(Figure 15-09).

For static collisions to work properly, the 3D models and their physical envelope must be very
accurate, otherwise the objects will get stuck together.

o Limited (Start/End): Allows you to limit the angle of rotation or the length of the sliding action of the 3D object,
by setting a start and end point of the movement. First position the 3D object in the scene where the action will
start. Click on the pen icon to indicate the position of the start of the action. Then position the 3D object where
the action will end and click on the pen icon to indicate the position of the end of the action.

If you choose a limited joint, we recommend that you deactivate static collisions.

» To control joint movement and behavior, a number of physical constraints can be applied. These constraints make
it possible to tailor joint operation to specific needs.

o Free moving (Fig. 15-11): By default, the joint is in free motion. This means there is no resistance applied to
the object’s articulation during its action. Click on the drop-down menu to select another type of articulation.
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B = o Enable friction (Fig. 15-12): Allows you to simulate resistance during movement. If you enable the friction,
you can define a friction force that is applied to the joint (Fig. 15-12). You can thus simulate a jammed door,
etc.

Friction: |0.35

A Figure 15-12

Enable motor R ‘

o Enable motor: You can simulate a rotary motor, a sliding motor (Fig. 15-13), land give it a speed and a

[ 00 torque. A speed is expressed in revolutions per second.

Torque: [100.00 |5

A Figure 15-13

R -] o Enable spring: This option simulates a spring by applying a defined force (Fig. 15-14). It can be used, for
. — example, to automatically close a door, create a lever that returns to its initial position, etc. By activating the
Force: ]1.00 “Invert spring direction” icon, you reverse the direction of the force exerted by the spring.

A Figure 15-14

If you have problems with joints when you start the physical simulation, please check the collision envelope of your different 3D
models (see chapter 15.5). Perhaps you have not activated the physics on the 3D model or you have locked the position of your 3D
model.

If the local origin point or the anchor point of a 3D object is inside the bounding box of a shelf frame or a generic furniture, the
object will be automatically selected along with the frame. This simplifies the manipulation of elements, such as refrigerator doors,
supermarket swing gates, etc.
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15.8 Interactive actions and automations

The “Interactive actions” function lets you automatically define and execute specific actions according to defined criteria, facilitating event automation
and enhancing interactivity and immersion in the 3D scene.

@ o Click on the “Interactive actions and automations” icon.

» The “Interactive actions” dialog appears (Fig. 15-15).

:g The interactive action you want to create will only work if the 3D models are adapted to the situation you want to implement.
For example, if you want to turn a lamp on and off, the 3D model of the lamp must have a dynamic light source (see chapter
13).

15.8.1 Creating a new automation

o D o The top window of the “Interactive actions” dialog groups together
all the automations present in the project.

8
\> Click on the “Add new entry” icon to add a new automation.

7 Trigger type 7 Trigger type
None - None % o Click on the “Remove entry” icon to remove an automation from
\ | Click on the “R t t tomation fi
< Actions T the project.
o The icon in front of the automation name enables you to

& ’ )

activate or deactivate this process. Double-click on the New
automation entry to edit it.

A Figure 15-15

The following steps allow you to choose the action or series of actions you wish to create in your project, and how they will be triggered.
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15.8.2 Select the type of trigger

You need to define the trigger type that will activate the action or series of actions. Click on the drop-down menu: “Trigger type” and select the one
that relates to the action you wish to create. Each trigger has its own specific parameters.

Interactive actions d
P New automation &
7 Trigger type
Mone T
Distance from an object
Enter or exit a zone
click on an object o
press a hotkey

A Figure 15-16

A Figure 15-18

o Distance from an object: Your action will be triggered when you come within a defined distance of a

specific object in your project.

[Distance from an abject =

[ Clickto selectan abject |

Distance: [100.0  [2] em

Click on the “Click to select an object’ button, then choose an object in
your project to define it as the trigger object for your action.

The “Distance” determines the threshold, at which the action is triggered
when you move closer to the trigger object.

o Enter or exit a zone: Your action will be triggered when you enter or leave a specific zone you've created

beforehand.

.
[Enter or exit a zone

[[Z creste anewzone |

=1

A Figure 15-17

[Enter or exit a zone

[ Z Replace curren tzone |

A Figure 15-19

By clicking on the “Create new zone” button, a blue surface selection
pointer appears (Fig. 15-17). Select a starting point by pressing the left
mouse button. Holding down the mouse button, move the mouse in the
desired direction to reveal a blue outline. This outline defines the hatcher
area in which the action will be active.

Move the mouse until you are satisfied with the size of the area.
Release the left mouse button to complete the creation. The zone will be
represented by a red rectangle (Fig. 15-18).

The zone features red square gizmos at each end. Click on these squares
to adjust the shape of the zone (Fig. 15-18). If you wish to replace the
zone, click on the “Replace current zone” button (Fig. 15-19) to create a
new zone. Press the Delete key to delete the zone.
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Interactive actions d
P New automation =

7 Trigger type

Distance from an object

Enter or exit a zone

click on an ohject W
Press a hotkey

o Clic on an object: Your action will be triggered when you click on a specific object you have previously

selected.

click on an object -]

Bk \

[ click on an object -]

[[=eroom I

= Click on the “Click on an object’ button, then choose an object in your
project to define it as the trigger object for your action. The action, or
series of actions, will be triggered each time you click on this object in
your project.

The name of the object you have selected will appear in the button.
Repeat the operation if you wish to assign the action to another object.

If you wish to use a frozen object as a trigger, you must first unfreeze it before you can select
it. Once selected, you can freeze it again!

o Press a hotkey: Your action will be triggered when you press a key on your numeric keypad. Currently,

keys 1 to 9 are available.

[Press a hotkey -

15.8.3 Define action or series of actions

= Click on the “Key” button and choose the number you wish to define as
the trigger for your action.

You must define the action or series of actions you wish to create in your project. An automation can group together several actions. For example, a
switch may turn on several lamps at the same time.

P New automation

7 Trigger type

|Nuns

7 Actions

The “Actions” window displays the list of actions grouped together in the automation selected in the
/ top window.

Click on the “Add new entry” icon to add an action. The “Add action” window (Fig. 15-20) appears,
displaying a list of available actions. Select the one you wish to create. If you want your automation
to perform several actions, repeat this step.

o Click on the “Remove entry” icon to delete an action linked to your automation.
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action

Available actions

\
—|

Control a dynamic light
Perform a physics animation
Activate a variation
A Figure 15-20
7 Actions
i
8

[C clickto selectan object

|Togg\e on when triggered

7 Actions

Physics animation

‘ [J Clickto select an object

Force; 1.00 o

=5

Physics.

Control a dynamic light: This action allows you to control a dynamic light according to the type of trigger
you have previously selected.

[ Slickto select an object

——

[Toggle on when triggered

= Click on the “Click to select an object’ button to choose the object (the
light source) in your project on which you wish to trigger your action. The

light control action will be performed only on this object.

Toggle on when triggerad
Toggle on when triggered
Togale off when triggerad
Turn on when triggered
Turn off when triggered

~= Toggle on/off when triggered: Each time you trigger the action, the light
source of the selected object is activated or deactivated.

= Turn on when triggered: Each time the action is triggered, the light
source of the selected object lights up.

= Turn off when triggered: Each time the action is triggered, the light
source of the selected object is switched off.

o Perform a physics animation : This action lets you create animations taking into account the physical
parameters (such as joints) of the object selected beforehand.

‘ (J Clickta select an object.

Force; [1.00

= Click on the “Click to select an object’ button, then choose an object in
your project on which you wish to trigger your physical animation.

| nside door 02 30w #3

Force:  [100  [Z]

@

The name of the object you have selected will appear in the button.
Repeat the operation if you wish to assign the action to another object.

To make physical animations work, you must first start

= Force: Defines a force on the object during the action.

= Inverse force direction: If the icon is activated, the force emitted on the
object is reversed.
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7 Actions

Activate variation

‘ Click to asslgn the currentvariation

L
&8

o Activate variation : This action lets you activate a previously selected variation to quickly show the
variation of a project.

= From the “Layers” drop-down menu, select the layer and variation you

Click to assign the current variation
| l wish to activate. Then click on the “Click to assign the current variation”
button, to assign the selected layer to the action.
= The name of the selected layer and variation is displayed in the button.
m - J | Repeat the operation if you wish to change layer or variation.

Interactive actions are saved per project and are assigned to one or more 3D objects positioned within the project. If you
delete an object assigned to an interactive action, it will no longer operate. You will then have to reassign a new 3D object
present in the project to the inactive interactive action.
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15

.8.4 Examples of interactive actions

Interactive action 01: We want the user to be able to turn a light on and off using a switch. Here are the steps involved in creating this automation.

Before you can activate or deactivate the light of a 3D model, make sure it has a light source and has been imported with the
dynamic light function activated.

P New automation

~ Trigger type

‘Chck on an object

‘ () Switch 01.X3DW #7

7 Actions

Light control - right
Light control - Isft

@

‘ ) AM15B_56.X3DW

‘Togg\e on when triggered

/o Step 1 : Creation of “New automation’.

Step 2 : Trigger type selection. Here, we’ve chosen: Click on an object. Next, we selected the switch in
the project by clicking on it, to define it as the trigger element.

Step 3 : Create an action. Among the available actions, we select the one we're interested in: Control

a dynamic light. Next, we click on a dynamic light in the project to define it as the object to be switched
on and off.

In our example, we’ve created a second identical action, this time associated with the second dynamic
lamp. Both actions are part of the same automation, and are triggered simultaneously by the same trigger.

o Action : You can turn the lamps on and off by clicking on the switch.

162

Store Visualizer 25.11



Interactive action 02: We'd like the gate at the entrance to a supermarket to open automatically as the user approaches, and close again once the
user has passed through. Here are the steps involved in creating this automation.

Before animating gates automatically, make sure that their components are separate models and that their physical properties
are correctly parameterized (joint, spring activation, etc.).

P New automation

*7 Trigger type

| Enter or exit a zone

| 7 Replace currentzone

~ Actions

/o Step 1 : Creation of “New automation’.

Step 2 : Trigger type selection. Here, we’'ve chosen: Enter or exit a zone. Click on the “Create a new
/ zone” button to define the action zone.

Step 3 : Create an action. We select the Perform a physics animation action, then click on one of the
gates in the project to define it as the object to be animated.

We’re renaming the action to make it easier to understand, as we’d like to add a second action
to the animation

Physics animation - Left gate &
Physics animation - Right gate

| () Left gate

Force: 1.00

1]

\

The animation applies a Force (previously defined) to the gate, allowing it to pivot around its joint and
open. By activating a spring in the 3D model’s physical properties, the gate will close automatically as
soon as we leave the area.

In our example, we’ve created a second identical action, this time associated with the second gate. Both

actions, part of the same automation, will be triggered simultaneously as soon as we enter the zone.

o Action : In order for the physical animation to be taken into account, you must first start the Physics
simulation. As soon as you enter the area, the gates will open, then close again when you leave
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Chapter 16 : Environment panel

E » Select the environment toolbar by clicking on the “Environment’ icon (Fig. 1-01) located on the bottom panel bar.
I_/ e The environment toolbar appears (Fig. 16-01), and is now active.

BIOOU B @QQld @ |

16.1 Tonemapping settings

Store Visualizer uses a high dynamic range rendering system (HDR). It is capable of simulating a much higher dynamic range of light than a typical
computer screen or projector can display. In order to accommodate this, Store Visualizer uses an exposure system, much like a real camera does.
Changing the exposure and tone mapping settings will adjust the way bright lights and high contrast areas are rendered. It will also define how colors

are reproduced.

Tonemapping system

(U Exposure [@ Adaptation {U Glare |

Exposure: |14.00 E Logarithmic exposure =

™ Auto exposure Contrast: 0.00 E
@ 4% ' " saturation: 195 [=
D — Yy ' ' ' Offsets 0.00

A Figure 16-02

~7+| e Click on the “Tonemapping settings” icon.
u * The “Tonemapping system” dialog appears (Fig. 16-02).

o Exposure Panel: The exposure tab controls the way high dynamic range lights are rendered on a low
dynamic range computer screen or projector.

o Exposure: Controls the overall brightness of the visualization.
o Contrast: Increases or decreases the image contrast.

o Tone mapping equation: Controls how light and colors are mapped to low dynamic range
(Logarithmic exposure is generally used).
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P e = Glare Panel: The glare settings can be used to add a glare or bloom effect around very bright light
= sources. This can often increase realism, as it simulates light intensities that cannot be reproduced on a
(U Exposure ‘ [} Adaptation [ O Glare | |
normal computer screen or projector.

¥ Enable glare

Intensity: [30.0 o Enable glare: Check to enable the glare / bloom effect.

o Intensity: Controls the strength of the effect.
¥ Extra bright glare

o Diffusion: Controls the size of the light beam around the light sources.

A Figure 16-03
oure o Color ambiance: a drop-down list offers a selection of color ambiances that apply to the brightness
effect, changing its color.

o Extra bright glare: Allows the effects of brightness / the bloom effect to be accentuated more.

16.2 Stereo and multi-display control

Store Visualizer can work with compatible stereo displays and projection systems. Contact your reseller to obtain further information about the Store
Visualizer stereoscopic rendering module.

LF‘H  Click on the “Stereo and multi-display control’ icon to enable or disable stereoscopic rendering.

:l§ Depending on the configuration of your hardware, stereoscopic rendering mode can be adjusted via: Preferences >
Extensions > Stereoscopic rendering > Stereoscopic rendering control (Chapter 23.7).
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16.3 Reflection points and zones
16.3.1 Default reflection point

In your 3D store project, the environment seen in all reflective objects is gathered from a point called the reflection point. You can create and move
the reflection points in the most suitable zones depending on the layout of your store. Placing the reflection point at the center of an important aisle
is a common approach.

=

=

&/

A

e Select the Environment toolbar by clicking on the “Environment’ icon (Fig. 1-01) located on the bottom panel bar.
¢ The Environment toolbar appears and is now active.

» Click the “Edit reflection spheres and zones” icon to reveal or hide the gizmos (Fig. 164-04) representing the reflection points in your
store. When creating a project, a default reflection point is placed in the centre of the scene. Use the object selection and manipulation
tools (see chapter 5) to select and move this reflection point through the store. The environment visible in the reflection of the objects
will depend on the position you will have chosen. If the reflection of the environment in the 3D models is not acceptable, move the point.
The environment shown in reflective objects will change according to the position you chose. Repeat the process until you are satisfied
with the results.

A Figure 16-04

o For performance reasons, the reflections you see in objects will not adapt to large changes of your store in realtime. Click on the
“Refresh reflections” button to synchronize the reflections if you made significant modifications in your store. Note that reflections are
automatically refreshed when a project is opened.

‘ < Be careful not to place the reflection point inside an object or a shelf, behind a wall or below the floor. This would result in
abnormal or missing reflections !
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16.3.2 Setting several reflection points

To improve the realism in the reflective parts of the objects positioned in your 3D virtual store, you can create and set several reflection points. Each
new reflection point will be assigned to a reflection zone. The reflection of the environment visible in the reflective parts of the objects will depend on
the position of the reflection point and will only affect objects positioned in the reflection zone assigned to it. You can, for example, create a zone for

each aisle.

o= | Reflective parts of objects not located in a specific reflection zone will reflect the environment of the default reflection point.

the environment surrounding the new reflection point.

~ | e Click the “Open reflection zone settings” icon to open the “Reflection zone settings” window (Fig. 16-05). A list showing the
@ reflection points appears. The default reflection point appears at the top of the list.

mouse button. While keeping it pressed, move the mouse in the desired direction to reveal a blue outline. This outline defines the new
reflection zone in which the new reflection point will be active. All the reflective parts of objects positioned in this new zone will reflect

Iﬁ'}:l « Click the “Add new entry” icon to add a new reflection zone. A blue selection pointer appears. Select a starting point by pressing the left

Move the mouse until you are satisfied with the size of the zone. Release the left button of your mouse to complete the creation. The
surface of the zone will be represented by a red rectangle (Fig. 16-06). You can access and modify the properties of each zone as well
as the reflection points using the dialog “Reflection zone settings” (Fig. 16-05).

Use the object selection and manipulation tools (see chapter 5) to select and move a point or a reflection zone. At its edges, the
reflection zone has gizmos in the shape of red squares. Click these squares to adjust the shape of the zone (Fig. 16-07).

w &

U Default reflection paint
= [ Reflection point 2

£ |
Zone: Reflection point 2

|
sl aflinleds el

A Figure 16-05

A Figure 16-06

A Figure 16-07

:ﬁ We recommend that you create
and manipulate the reflection
points and zones using the
“Layout view” mode (see
chapter 6.8).

ﬁ » Click the “Remove entry” icon to clear the reflection zone and its point. The default reflection point cannot be deleted.
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16.4 Adjust static elements

A 3D environment is made up of several static elements that can be modified in real time. The adjustable static elements of the templates supplied
with the software are generally the floor and the walls.

We can make other static elements appear, according to your requirements, in custom 3D environments.

» Click the “Adjust static elements” icon.
o The “Adjust static elements” window appears (Fig. 16-09).

Cl
|

B0

16.4.1 Material presets

A list of material presets supplied with the software enables you to quickly apply a new material to an adjustable static element. This list includes a
selection of typical floor and wall materials.

Select the adjustable static element that you want to modify, either by clicking on its
name in the material list or by using the material picker button. The example shows
(ED/ the floor material selected.

Adjust static elements

Presets IIAdjust ] Images |

wall back El Floor materials

x::: ‘;;t”t E Stone ties When you select a static element in the list, it will be briefly highlighted in

wall right [ ] white tiles the scene so that it can be identified more easily.
l:] Yellow tiles
Bl c-cties ¢ In the Presets section, select one of the available Floor Materials. An image enables
R Black & white tiles you to identify the material more easily.
- Gray tiles
B Grevties 2 Double-click the selected material to apply it to the static element. If you are not happy,
B ceioe tiles you can select another material and repeat the operation.

Concrete
Carpets
Marble
Wood

= wall materials
Brick
Plaster

Concrete wall

A Figure 16-09
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16.4.2 Adjust the static materials

Adjust static elements

wall back .

wall front Brightness
wall |l_9ft Reflectivity
wall right

Glossiness

Move

Resize

—?FESEts_i Adjust I\mages |

oo [F]fooe [
10 [2][1o0 ][

A Figure 16-10

» Adjust: This section enables certain parameters of the static element selected from the
list of editable materials to be modified.

The parameters of any preset material applied to a static element can also

be adjusted.

o Brightness: Enables the brightness of the material to be increased or
decreased.

o Reflectivity: Controls the reflectivity of the surface of the material. Drag
the cursor to the left to reduce the reflectivity of the surface or to the right to
increase the reflectivity.

o Glossiness: Modifies the glossiness of the reflection of the material. Drag
the cursor to the left to reduce the glossiness of the surface or to the right to
increase the glossiness.

o Move: Reposition the layer by moving it horizontally or vertically.

o Resize: Modify the horizontal or vertical dimensions of the layer.

Store Visualizer 25.11
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16.4.3 Modify static images

o Images: This section enables the images present in the previously selected static
element to be modified.

| o Show color/reflective/bump image: This icon will open the “Texture viewer”
window and display the image currently assigned to the respective layer.

o Load a color/reflective/bump image: This icon enables you to load a custom
image from your hard disk onto the respective layer.

o Color image: Enables the color layer to be activated or deactivated on the
surface of the static element. If the color image is deactivated, you will be able
to apply a color to the static surface, see Fig. 16-12.

Adjust static elements @
[presets [ Adust || Images |
wall back
wall left
wall right W Reflect image |:| QB
Bump strength 10.00 [~ Locklayers
A Figure 16-11
Adjust static elements =]
Presets | Adjust [ Images |
wall back il
i L]
wall right W Reflect image I:I QB

10.00 E [ Locklayers

Bump strength

/ Click the “Pick color’ button to select a color for the static surface.

o Reflective image: Enables a reflection layer to be activated or deactivated on
the surface of the static element.

o Bump image: Enables a bump layer to be activated or deactivated on the
surface of the static element.

o Bump strength: Scale that controls the bump depth. You can simulate both a

A Figure 16-12

positive and negative bump. A negative scale value will reverse the direction of
the bump.

o Lock layers: Locks the positioning and dimension parameters of the reflection
and bump layers to the values of the color layer.
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16.5 Sunlight

When a 3D environment has an exterior, sunlight is very important for bringing realism to it. This function enables you to control the position and
elevation of the sun in real time, thus modifying the shade of 3D objects exposed to the sun.

o Click on the “Open sun light settings” icon.
e The “Sun lighting” window appears (Figure 16-13).

o Click on “Enable sunlight” to start the sun simulation.

Sun lighting

¥ Enable sunlight

Position

Azimuth:

Elevation: |45.00 E
et j N )

I Lock to environment

Light
|10.00 EI Color temperature )
L VA T
0 a0 Intensity: |500 Lux

Color: 2500 E K

Shadow softness
i o
10

A Figure 16-13

o Azimuth: Controls the position of the sun in the sky on the horizontal axis. The value is expressed
in degrees.

o Elevation: Controls the height of the sun in the sky. At 90° the sun is at its highest position while at
0° the sun is at its lowest position on the horizon.

o Light: A drop-down menu lets you choose between various preset light environments.
o Intensity: Controls the light intensity of the sun in Jux.

o Color: Controls the color emitted by the sunlight in degrees Kelvin. You can also choose a custom
color if you select the Custom color preset in the drop-down menu.

o Shadow softness: Makes the appearance of shadows projected by dynamic objects more sharp or
less sharp.

For a 3D object to project shadows when exposed to the sun, the 3D object must have the “Cast dynamic shadow” function
activated. See chapter 5.6.2 for further explanation.
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16.6 Measuring tools

The measuring tools allow you to measure the distance between two points and to create grids to better position 3D objects in the environment. The
measuring tools can also be used as an anchor line when creating objects.

EF e Click on the “Open measuring tools” icon. Measuring tools n
* The “Measuring tools” window appears (Fig. 16-14). A @
» Select one of the measuring tools to activate it as well as to set its parameters.

A Figure 16-14
16.6.1 Create a new ruler

d * When you select the “Ruler’ measuring tool, a blue surface selection pointer appears (Fig. 16-16) along with the ruler control parameters
A (Fig. 16-15).

Measuri I
i o Snap to angles: the ruler snaps to the 4 main corners (00°, 90°, 180°, 270°) of its surface pointer.

& o Ruler is sticky: allows the ruler to be used as a snap when creating 3D objects.
¥ Snap to anales
¥ Ruleris sticky
[~ Hidden stays sticky o Show labels: displays the length of the ruler and its angle.

¥ show labels

o Hidden stays sticky: allows the ruler to be used as a snap when creating 3D objects, when it is invisible.

A Figure 16-15

TR ¢ Use the mouse to select the location where you want to create a new ruler. The blue pointer represents the
starting point of the new ruler. This starting point is indicated by a small blue cross in the centre of the pointer
surface.

The blue arrow at the edge of the pointer surface represents the FRONT of the new ruler (Fig. 16-16).
You can use the mouse wheel to change the orientation of the ruler when the surface is in selection

A Figure 16-16 mode. When creating the new ruler, the orientation of the pointer will determine the angle in degrees.

e e o s o 0 0 0 0 0 0

* Once the surface and the starting point are positioned, press the left mouse button. While holding it down, move
the mouse in the desired direction to display the new ruler. Release the left mouse button to finish creating the
ruler. The ruler you have just created is selected and appears in red.

A Figure 16-17
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16.6.2 Create a new grid

Q * When you select the “Grid” measuring tool, a blue surface selection pointer appears (Fig. 16-19) along with the grid control parameters
(Fig 16-18).

Measuring tools H o X 1Y Grid: Allows you to create a custom grid by directly entering its size.

Al ..@: -S You can change the X and Y distances of the grid at any time, by directly changing the values in the
“Measuring tools” dialogue.
* grid Ilm

varid  [1m o Grid is sticky: Allows the grid to be used as a snap when creating 3D objects (Fig. 16-21).
IV Grid is sticky o Show labels: Displays the measurements for the grid.

¥ Show labels

A Figure 16-18

* Use the mouse to select the place where you want to create a new grid. The blue pointer represents the starting point
of the new grid. This starting point is indicated by a small blue cross in the centre of the pointer surface (Fig. 16-19).

* Once the surface and the starting point are positioned, press the left mouse button. While holding it down, move
the mouse in the desired direction to display the new grid (Fig. 16-20). Release the left mouse button to finish
creating the grid. The grid you have just created is selected and appears in red.

A Figure 16-20

Grids and rulers can be created on the floor, walls or shelves.

A Figure 16-21
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16.6.3 Using a ruler or grid

Once you have created a ruler or a grid, you can change it, move it, make it visible or invisible, use it as a guide when creating objects, etc. All the
rulers and grids you have created in your project are listed in the scenegraph.

| (8 Project | & Tools [ [ Scene |

Yo T * Select the Scene section in the sidebar and open the “Scenegraph” drop-down menu (Fig. 16-22).

| Qv o Helpers brings together the various measuring tools currently positioned in the project.

Store The “Flag” icon displays which element is selected in the 3D scene. Click the icon to select or deselect
Shelves — the associated item:

H Products = If the icon is red (active) it means that the associated item is selected.

S| Helpers = If the icon is grey (inactive) it means that the associated item is deselected.

& Ruler tool

2 &Grdtoo—————————  The “measuring tool’ icon represents a single measuring tool. By clicking on it, you change its visibility:
Planogram sections

= If the icon is blue (active) it means that the associated measuring tool is visible.
A Figure 16.22 = If the icon is grey (inactive) it means that the associated measuring tool is invisible.

o If you wish to delete a measuring tool, select it and press the Delete key

* Use the object selection and manipulation tools (see chapter 5) to select and move a ruler or grid (Fig.16-23).
They have red square gizmos at the ends. Click on these squares to adjust their shape (Fig. 16-24). The angle
and dimensions adjust accordingly.

You can manually change the displayed value of length and angle of rulers and grids. Double-click on
the value to be changed and enter the new value.

A Figure 16-24
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Chapter 17 : Product viewer

The product viewer mode allows you to inspect the details of a product from all sides.

[\} o Select the object to inspect by using the selection mode (see chapter 5).
* To enable the product view mode, you may either :
o Click on the “Product viewer” button, located on the right hand side of the object manipulation toolbar.

L.Q o Or simply press the “p” key on your keyboard.

» The selected object(s) will leave the shelf and move towards the center of the aisle. It can then be closely inspected from all sides.

When in product viewer mode, a control window will appear (Fig. 17-01):

Reset orientation: Puts the object back into its original orientation it had on the shelf.

Center camera onto product: Center the product in the middle of the screen.

Change rotation pivot point: Modifies the rotation center of the object.

Second rotation axis is X: Performs a rotation around the Y and X axes.

Second rotation axis is Z: Performs a rotation around the Y and Z axes.

Open array control: Allows modifications of an object array while in product view mode.

Exit product viewer: Quits the viewer mode and returns the product back to the shelf (or press “p”).

Product viewer |E
® @|%Z|®

A Figure 17-01

O O O O O O O

[le=_| The product viewer can be used on single objects, groups or arrays.
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17.1 Product viewer settings

* Open the “More actions” menu located on the right hand side of the object manipulation toolbar.
» Select “Product viewer settings” or use the keyboard shortcut Shift+P. The settings dialog will appear (Fig. 17-02).
¢ You can now adjust the product viewer configuration for the current project.

d o Viewer metrics:

Product viewer settings

Viewer metrics = Distance: The distance the object will travel from its position on the shelf to the center of the aisle.
Distance: 60.0 cm
et 55 Elem You may also configure the movement trajectory by directly clicking on the curve graph.
Steepness: |15 [3
. ame| = Height: The height the object will float at when in product viewer mode.

Camera follow = Steepness: Changes the angle of the curve the object will take when travelling to the center.

¥ Enable camera follow Grosiiwe)
[

Hitoss o = Move time: The time the object takes to move from the shelf to the aisle (in seconds).
Automnatic disabling
Put the product back when farther than |5.0 : m o Camera follow:
_Toggle view | | Defauts | [ close ] = Enable camera follow: when clicked, the camera will automatically follow the object as it leaves

A Figure 17-02 or returns to the shelf.
= Move to camera: the object is positioned towards the camera, facing the user.

= Reaction speed: adjusts the camera follow speed.

o Automatic disabling: the product is automatically returned to its original position when the camera is
moved a certain distance away from the product.

» Toggle view: enters or quits the product viewer mode (you may also press the “p” key)

:ﬁ Independently configure the texture resolution of products when they are in product viewer mode.
Preferences>3D settings>Textures>Product viewer textures.
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Chapter 18 : Snapshot and print
18.1 Snapshot

A snapshot of the current view can be taken at any time and saved to disk as a standard image file. Supported formats include JPEG, PNG, TIFF and
others.

* Choose a viewpoint at the place you would like to take the screenshot.

* Right click on the rendering area to open the context menu.

e Select File > Snapshot
» Select the location and enter the file name you would like to save the snapshot under and specify the image format. Click on Save.

» A dialog with the snapshot settings will appear (Fig. 18-01).

Save snapshot e e
IENE CREEns ———— o Resolution: Choose the resolution of your snapshot image (screen size, x2, x4, x8, custom).
Resclucl o Quality: Additional anti-aliasing can be applied for best possible quality of your snapshot.

el o Width/Height: The image resolution the snapshot will be taken at. You can manually modify the resolution
by choosing the “custom” setting in the resolution dropdown.

Width: 680 ”
Height: 1050 : px

| oK | | Cancel |

A Figure 18-01
» Click OK to take the snapshot.
18.2 Quick snapshot

» The “quickshot’ feature will take additional snapshots using the previously selected settings. The file names will be numbered automatically.

* Open the contextual menu and select File > Quick snapshot ...
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18.3 Print

* Choose a viewpoint at the place you would like to take the screenshot.
* Right click on the rendering area to open the context menu.
o Select File > Print.

o Store Visualizer will use your configured PDF viewer application to print the image.
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Chapter 19 : Create a placement report

When working with the “Object array” feature, Store Visualizer can create a placement report from your arrays. Report functionality is usually provided
by customized plugins. This chapter describes the generic report process.

o Select the array you would like to create a report from.
* Open the “More actions” menu located on the right hand side of the object manipulation toolbar and select “Array settings”. You can also

press Shift-F, as described in chapter 5.21.
 Click on “Settings”, and select “Generate report’ to launch the “Report wizard”:

Report wizard

recluiei rigeir

Header | image [ Product | comments [ PDF Export |

Company name:
[company name 32 -] [Regular -

Product name:

(]

[Detergent bottles 28 : Regular  ~ IE'

Logos

% Enable vendor logo AP
/ 2 y .
IR Enable customer logo /

4

k& clickto load an image.

/’x
)

[ ccmack | [ new=> ||

Close

= |

A Figure 19-01

Report wizard

Step 1: Report header
e Company name: type the name of your customer.
¢ Product name: the report title, or the name of the products shown in the report.

» Click the “Load an image” button to add logo images to the report:
o Enable vendor logo: Includes your own logo on the top right of the report (your logo

image can be set through the report plugin Preferences > Plugins).
o Enable customer logo: Includes the client logo at the top left of the report.

:Ig You may freely configure the font size, type and color of the company and product name
entries, such as they will be included in the report PDF.

Step 2: Image

/ Click on the “Photo” icon to insert a screenshot of you current 3D view into the report.
In order to find a perfect camera view for the screenshot, just use the standard

[ <<Back |[ wet>> ] |

Close

— e g
navigation features as described in chapter 3.

A preview of the screenshot appears. If you are not satisfied with the result, simply repeat the
process with a different camera view.
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Report wizard,

E@ GERERateprod UCHERORE

Header | Image | Product | Comments | PDF Export | ]

Layout
{BEEEEE ,
[Single product view

[ Add model browser image... ]

<< Back H Next =>> | ‘

Close

Step 3: Product overview

o Select the product you would like to show in the “Model browser”.

| Choose a “Layout’.

Click on the layout element where a product should be added to, which will be shown with a red

border.

—1——e Click on “Add model browser image” to add the current model browser view.

« Different layouts are useful if you would like to show multiple views of the product or more than one product at the same time. It can also be
used to show close-ups of distinct product parts.

Report wizard

Ea. Cl=iplarzies afeeltielr f=gefs

Header | image | product | comments | PDF Export

Layoy
{ Two h;untaly dvided-views

[E) Add model browser image... |

s §

<< Back H Next >> | ‘

Close

Feport wizard

Header | image | Product | Comments | PDF Export |

Ea, GENEREtE prodicHrERort

Layout

|

[& Add model browserimage... |

<< Back H Next == | \

Close

Select the layout element where the product
should be placed by clicking on it. A red border
will validate your selection.

Pressing the “Add model browser image”
button will add the model and view angle
currently shown in the model browser to the
selected layout element.

You can switch the layout at any time. The inserted product views will be adjusted automatically.
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Report wizard

ProENEEHEPOt

Header [ Image | Product | Comments | PDF Export |

=] Step 4: Comments

[Times New Roman

~] [10 [=] [Regular '|E|EE|

A simple example containing transparent plastic bottles of dish

right shelf, Try adding some more |

elade generation date into report
Author name: |

washing liquid on the top shelf, and some spray bottles on the lower

Comments about the project can be added into this field. They will appear on the report PDF.
/ The font style, size and alignment of your comment can be configured freely.

| This check box will “Include the generation date into report”.

| << Back || Next > | |

Close

Report wizard

preductEport:

Header | Image | Product | Cornments | PDF Export |
PDF options

¥ Interpolate images

Image quality:
X Show report after export

<<gack || mexi=- | [ close

e Author name: The name of the author who created the report (optional).

Step 5: PDF export
* PDF options:
o Interpolate images: Increases image quality when the report PDF is zoomed onto.
o Show report after export: Opens the generated report with PDF reader after export.
o Image quality: Choose the quality of the images included in the PDF. Higher quality will
produce larger PDF files.

e Print the report directly without saving it first.

Store Visualizer 25.11

o Export the report as a standard PDF file.
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Company name . &

Detergent bottles -

Product placement report

T e
™

Langth Depth

Height

Objec! size

T.ET 4.08

16.52

Object count

3 B

Spacing

1.00 1.00

000

Total extend

2661 2954

1652

Scale: all stzes are givem in centimeters.

A Emgle exampls CONTIN TEASpArET Flaste bOwes of dish Shing Boud on the W S, and sme IV bortles on the
Lowes right shelf. Try adding Sones mote |

00 ostomrs 2018

Ruaport genaraied by Siors Visudoer b e vises.com

Step 6: The final generated report

The following elements make up your report:

e Company name: Your customer’s name.

® Product name: The name of the product shown on the report.
\ Vendor logo: Your logo image.

T~ Customer logo: The logo image of your client.

» Screenshot of your product in the 3D environment.

e Array placement: Placement metrics and surface area used by your
products on shelf. The data is taken from the array that was used to the
generate report.

o Layout: Views or close-ups of your product.
o Comments related to the project.

» Date the report was created.
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Chapter 20 : Create a standalone viewer

Sometimes you might want to share your projects with colleagues or clients that do not have Store Visualizer installed on their computer. While you

could take screenshots or generate a report as described above, it is often more effective to let them explore the project the same way that you
designed it in Store Visualizer - interactively and in real time.

With a few mouse clicks, you can create a 360° spherical image of your project in html format. This file can be easily copied, shared on your cloud
or published on your website. By double-clicking on the file, your customers will be able to view a 360° representation of your project in real time, from
a point you selected in advance, on their computer or mobile device.

O New * Right click on the Store Visualizer render area to open the main contextual menu.
@ undo & open ctrl-o
) Close .
& Seleet & save ey e Select File > Export.
Save as
& Move = . . .
& Rotate o Enter the name of the viewer file you would like to export.
i scale
i - = Click on Save. The “Spherical vi rter’ dial Fig. 20-01
_ r— e — e Click on Save. The “Spherical view exporter’ dialog appears (Fig. 20-01).
& quit Alt-F4
About...
e ncal s expartet 0 On the following screen, you will be able to add information about your project that your client will see when
S running the viewer. Note that all fields are optional, and you may leave them blank.

Tlei - Jcustomer demo - Apartment o Title: Name of the view exporter.

Compression quality: Resolution:

95% - High quality ad ‘ |Nurma| (8k) x

o Compression : The exported viewer file is compressed, so to keep it small and easy to send over
Overlay image the internet. This compression can sometimes impact the visual quality of your project when the

2 palie B g client views it. You can choose the amount of compression under compression quality. The higher
the quality the larger the resulting viewer file will be.

|E{] WTales graphics logo.png |

Logo position:

|Tup right corner v|

o Resolution: Allows you to define the resolution of the sphere. The higher the resolution quality, the
larger the size of the resulting visualization file.

‘ Export | ‘ Cancel |

A Figure 20-01 o Overlay image: Add an overlay image on your viewer to personalize your project.

o Click on export to generate the view exporter.
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Store Visualizer will create a *.html visualization file at the designated location. Double-click on the visualization file to start it. The viewer will work on
most web browsers on both your computer and your mobile device.

e An information panel will appear on your web browser, showing how to navigate the 360°
spherical image. The navigation mode varies depending on the type of device on which you
eustomeliemaEpartment start the html file. A web browser on a computer with a mouse (Fig. 20-02) or on a mobile device

00

with a touch screen (Fig. 20-03).

o After a click on Go, you will be viewing your project in real time.

Click and drag to look around, scroll to zoom

Go!

The project can not be modified in any way from within the viewer.

A Figure 20-02

Customer demo - Apartment

(]

Swipe to look around, pinch to zoom

A Figure 20-03
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Chapter 21 : Creating and editing a video

Store Visualizer has a module for creating and editing videos in real time. With this tool, you can produce video sequences for real-time presentations
or create video files.

» Select the navigation toolbar by clicking on the “Navigation” icon (Fig. 1-01) located on the bottom panel bar.
» The navigation toolbar appears, and is now active.

L€

» Click the “Toggle movie timeline visibility” icon to display the video editor above your toolbar.

21.1 Creating a new sequence

A sequence is a continuation of events arranged on a timeline. Different types of events affect the path of the camera, the movement of objects or the

control of the physics. The first step is to create a new sequence, to which you will then add the events. All the sequences you create will be stored
in your project.

o Click the “Create a new sequence” icon to create the starting point of your new video sequence. Store Visualizer will automatically
{F‘ create an initial camera event and an initial scene event. These appear on the timeline (Fig. 21-01) and are symbolized by a green
(camera event) and blue (scene event) semi-circle. These are the starting points of your video.

o The first camera event represents the current position of the real-time camera, i.e. the image currently visible in real time of your
project. The position of the camera of the first camera event (see chapter 21.2.3) can be adjusted at a later stage.

» The first scene event represents all the 3D objects positioned in the scene when the sequence was created, according to the active
Layers and Variations. For more information on scene events, please see chapter 21.4.1.

@8 [rew sequence I~ 0J & D & D0 o:00:00.0 &} Export movie Q—18 a2 v
1 0:00:00.0 |0:00:05.0 0:00:10.0 0:00:15.0 |0:00:20

U | | | | | | | | | | | | | | | | | | | | | | | | | | | 1 | | | | | | | | | |

First camera event

First scene event

4] 111 [«]»

A Figure 21-01
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21.1.1 Opening an existing sequence

op &8 |New sequence

4

A Figure 21-02

21.1.2 Deleting an existing sequence

&

21.1.3 Activate or deactivate a track

e Click the “Remove current sequence” icon if you want to delete the active sequence.

* The dropdown list of sequences (Fig. 21-02) lets you select the sequence that is currently active on the
Sequence 01 timeline. A project can contain multiple sequences.
Sequence 02
+ | New sequence

* The input field also lets you rename your sequences.

Each track on the timeline can be individually activated or deactivated. The events present on a deactivated track will not be included in the reading

oP &8 INew sequence

or exporting of the sequence. Click on the respective icon to toggle the activation status of a track. All tracks are active by default.

-] 0J& D @00 o:00:000

E E]’ Export movie (="} '—J =S
60:00:00.0 ‘0:00:05.0 ‘0:00:10.0 ‘0:00:15.0
I N I (N T O I R N N B | [ I R T (N T O L1

o
< D @D
4] [T [4]»

Camera track disabled
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21.2 Creating a camera event

A camera event is a camera point of view created from the position of the current view in real time. It appears on the track of camera events on the

timeline and is represented by a green marker with an icon symbolizing a camera. The continuity of camera events will define the path and speed of
movement of the camera during the sequence.

21.2.1 Adding a new camera event

» Use the classic navigation functions to move your camera to the point of view you want to add to the sequence.

» Then click the “Add new camera event’ icon situated at the front of the camera events track (Fig. 21-03). A new event corresponding
q}" to the current camera position will be added to the track (Fig. 21-04).

A Figure 21-03 A Figure 21-04

e You can add a camera event at any point on the timeline. Click and move the cursor along the timeline (Fig. 21-05) to define the
insertion point of the next camera event created by the “Add new camera event’ function (Fig. 21-06).

0:00:00.0

A Figure 21-05 A Figure 21-06

Empty spaces between camera events represent periods of time during which the camera
is not moving and is displaying its last position (Fig. 21-07).
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21.2.2 Manipulating and modifying camera events
» By default, a new event is created at the location of the cursor on the timeline. The length of the event corresponds to the time needed
by the camera to move from the point of view of the previous camera event to the point of view of the event created (Fig. 21-07)
depending on the navigation speed you are using at the time of creation (chapter 3.2).

A Figure 21-07

¢ You can manipulate and modify events positioned on the timeline at any time. With your left mouse button, click the camera event
to select it (Fig. 21-08), move your mouse from left to right while keeping the left button pressed to move the event on the timeline
(Fig. 21-09). Press Delete to delete the selected event.

0:00:00.0 0:00:00.0 0:00:0

A Figure 21-08 A Figure 21-09

:g When you move or modify the length of an event, all subsequent events will be moved unless you press Shift at the same
time (Fig. 21-10). The track of camera events is independent from the track of scene events. Only events on the affected
track will move.

o If you press Shift when you move or modify an event between other events on the timeline, it will move between the two events without
moving the events that follow it.

0:00:00.0 0:00:05.0 0:00:00.0 0:00:05.0
P ED TP G
CFl

A Figure 21-10
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* When you attach one camera event next to another, you create a continuity of movement between the positions of the two cameras (Fig.
21-11). This will be translated into a continuous movement, without stopping, between the camera events when reading and exporting
the sequence.

A Figure 21-11

» The transition time between two camera points is not fixed and you can vary it by dragging one or other end of the event.

The longer the camera event, the slower the movement of the camera, and vice versa.

o If you reduce the length of your camera event to the minimum, this will become an instant camera event (Fig. 21-12). The movement
of the camera between the previous camera event and this camera event will thus be instant.

0:00:00.0

A Figure 21-12
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21.2.3 Adjusting the camera

o If you are not satisfied with the point of view of your camera event, you can correct it using the camera events contextual menu. Select
the camera event you wish to adjust and click your right mouse button to open the “contextual menu”. Choose “Adjust camera’.
The camera event turns red while the position of your camera is being adjusted (Fig. 21-13). The adjustment is made using classic real-
time navigation functions. When you have finished adjusting the camera, re-open the camera events contextual menu and click “Adjust
camera” again. The camera event turns back to green and the new camera position is taken into account.

A Figure 21-13

21.2.4 Camera speed

e When you create a camera event, the speed of its movement will depend on the real-time navigation speed you use at the time of
creation. The longer the camera event, the slower the movement of the camera, and vice versa. To avoid variations in speed between
your various camera events, you can normalize the speed of the entire sequence or of several selected camera events.

Normalize camera speed =X

Adjust the movement speed of:
" The entire sequence
@ Selected events only

Target speed
Very slow
Slow

Fast
Very fast

‘ oK ‘ ‘ Cancel

A Figure 21-14

The first camera event, representing the point of view of your camera during the creation of the sequence, can also be
adjusted in the same way as the other camera events!

The adjusted camera event will retain the same length on the timeline. It is, however, likely
that the new camera position will be further away or closer than the old one. You can therefore
“Normalize speed’ of your camera event (chapter 21.2.4) to avoid having variations in speed
on the path.

* Select the camera event you wish to adjust and click your right mouse button to open the “contextual
menu”. Choose “Normalize speed’. The “Normalize camera speed” window opens (Fig. 21-14). Next,
choose whether you wish to modify the speed of movement of the entire sequence or just one or more
events. Select the desired speed of movement and click OK. The camera events will adjust on the
timeline.

A panoramic movement in a camera event does not constitute a movement of the camera,
but merely a rotation of it. The time to perform the rotation will always be one second by
default. Store Visualizer will always choose the shortest route to perform the rotation. If you
wish to modify the speed of rotation of the camera, simply adjust the length of the event on
the timeline.
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21.3 Viewing the sequence in real time

Throughout the creation of your video sequence you can view the actions of your camera and scene events using the timeline’s playback controls.
The cursor (Fig. 21-15) represents the insertion point of events or playback on the timeline. You can place the cursor at any point in the sequence. The
cursor may be active or inactive. If it is inactive, the cursor serves to determine the insertion point at the creation of a new event (see chapter 21.2).
If it is active, the cursor represents a playback head on the timeline. By moving it, you can freely view the results of your sequence.

A Figure 21-15

o Click the “Activate cursor’ icon to activate it. The timeline turns red. Next, move the cursor to view the video according to the location of
the cursor. Re-click the icon to deactivate the cursor. All interactive manipulations in the project (for example: navigation of the camera,
creation or movement of objects, etc.) will automatically deactivate the cursor.

» To view the video, make sure the cursor is positioned at the point at which you want playback to start and click the “Start or stop real-

time playback” icon. The timeline turns red (Fig. 21-15) to inform you that the cursor is now active. Click the icon again to stop playback
of the sequence.

During playback of the sequence, you can reposition the cursor along the timeline by

clicking the desired location. Playback will not be interrupted.

IN

D{I e The “Move cursor to the start/ to the end of the sequence” icons position the cursor at the beginning or end of the current
video sequence.

&

EEI: e The “Move cursor to the previous/to the next event’ icons allow the cursor to be moved between the camera events of the
current sequence.

Fade effects between scene events (see chapter 21.4.1) will not be visible when viewing in real time. The result will only be visible

on the exported video.
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21.4 Creating an event on the scene track
The scene track of the timeline brings together the three types of events linked to the manipulation of objects: the scene event, the physics event

et

. The first scene event, created automatically during the creation of the sequence, includes the positioning information

for all the 3D objects placed in your project.

21.4.1 Creating a scene event

A scene event represents all the modifications relating to 3D objects that you have made in your project since the previous scene event. The
modifications taken into account by a scene event are the creation of new objects, the creation of multiple objects, the deletion of objects, the
replacement of objects and the manipulation of objects (movement, rotation and change of scale).

o

* You can add a scene event at any point on the timeline. Click and move the cursor (Fig. 21-05) to mark the insertion point of your next
scene event.

o Next click the “Add an event to the scene track” icon situated in front of the scene events track and select “Add new scene event’
(Fig. 21-16).

A scene event is a complete automated copy of the scenegraph, taking into account

layers and variations active at the time the scene event is created. The scenegraph
includes all the information relating to the 3D objects placed in the project.

Add new scene event
Add new physics event

A Figure 21-16

» By default, when you create a scene event, it will be instant (Fig. 21-17). The modifications made by the event to the 3D objects present
in your project will be instant.

For example, if the scene event represents the creation of an object, the 3D object will

be created instantly. If the event represents the movement of an object, for example
the movement of a product from one shelf to another, the object will appear instantly
on the other shelf. You will not see the object moving from one shelf to the other.

A Figure 21-17
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* You can modify the duration of a selected scene event by dragging the end of the scene event (Fig. 22-18). The scene event will no
longer be instant, but progressive over the entire duration of the event. This will have an impact on the modifications represented by the
scene event, such as the creation of new objects, the manipulation of objects, etc.

For example, if you have moved a 3D object from one shelf to another, you will see the object moving
from one shelf to the other. The speed of movement will depend on the duration of the event. The
creation or deletion of a 3D object will take place via a fade during the scene event.

A P 2118 :)t(tgg:tlgg: you cannot view fades in real time. They will be created when the video is

« If you have made changes to the objects in your project and you wish that these are taken into account in an existing scene event, you
can update the event. Select the scene event you wish to update and click your right mouse button to open the “contextual menu”.
Choose “Update scene event’.

:g The first scene event created, representing all the 3D objects positioned in the scene
during the creation of the sequence, can also be updated in the same way as manually
created scene events!

Rename event...

(‘_‘\J | Bl pelete event

:g We advise you to lock your project’s Variarions before creating Scene events, so as not to alter your original project, since the Scene
event modifies the composition of the scenegraph.
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21.4.2 Creating a physics event on the entire scene
The physics event allows the physical simulation to be started during a defined period on the entire scene (by default) or on a selection of objects.
See chapter 15 for further physics details.

* You can add a physics event at any point on the timeline. Click and move the cursor (Fig. 21-05) to mark the insertion point of your next
physics event.

|.1|:Ir..| * Next, click the “Add an event to the scene track” icon situated in front of the scene events track and select “Add new physics event’
(Fig. 21-19).

The physical simulation linked to a physics event cannot be viewed by dragging the cursor
along the timeline. You have to start real-time playback (chapter 21.3) to view the simulation.

Add new scene event
Add new physics event s

A Figure 21-19

0:00:00.0 |0:00:c After a physics event has been created (on the entire scene or on a partial selection), we
recommend that you “Start real-time playback” (chapter 21.3) to view the result of the

physical simulation. After playback, add a new instant scene event after the physics event

(Fig. 21-20) to freeze the last position of the 3D objects affected by the physics.

Failing this, there is a risk of random interactions when the next scene event is added.

A Figure 21-20

» Drag the end of the physics event (Fig. 21-21) to modify its duration. The default duration of the physical simulation is 3 seconds. The
physical simulation is stopped automatically at the end of the physics event.

A Figure 21-21
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21.4.3 Creating a physics event on part of the scene

« By default, the physics event will be active on the entire scene. If you are working on a project containing a large number of 3D objects,
it may be preferable to simulate the physics on part of the scene.

o Select the 3D objects to which you wish to apply the physical simulation. Next, click the “Add an event to the scene track” icon
situated in front of the scene events track and select “Add new physics event’. A window will open (Fig. 21-22) to ask if you
want to assign the physics to the selection or to the entire scene. Click Selection. The physical simulation of the event created
will then only be activated on the objects selected during its creation.

Add new physics event

i - If you choose Scene, the physics event will assign the simulation
( i\ Should the new physics event affect the current selection only to the entire scene (See Chapter 21 42)
or the entire scene 7

| Selection ‘ ‘ Scene | ‘ Cancel

A Figure 21-22

o If you have already created a physics event affecting the entire scene, this can be transformed into a partial physics event.
Select the 3D objects to which you wish to apply the physical simulation. On the timeline, choose the physics event you wish to
modify and click your right mouse button to open the “contextual menu” (Fig. 21-23). Choose “Assign partial simulation’.
The physical simulation will then only be active on the previously selected objects.

0:00:00.0 _|0:00:05.0
P R N N NI V., I R N )

L
Assign partial simulation

Rename event...

T = =a Delete event
A Figure 21-23
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21.4.4 Creating a product viewer event

The allows the “Product viewer” function (chapter 17) to be integrated into a video sequence. Like the real-time viewer, the
event creates an animation in three parts of a product selected in advance. In the first part, the product will leave its original position and position
itself at the point you have set. During the second part of the animation, the product will perform a configurable gyration. At the end of the event, it will
return to its original position.

¢ You can add a product viewer event at any point on the timeline. Click and move the cursor (Fig 21-05) to mark the insertion point of
your next viewer event.

» Select the object you wish to animate.

o Next, click the “Add an event to the scene track” icon situated in front of the scene events track and select “Add new product viewer
q}" event’ (Fig. 21-24). The product viewer event appears on the timeline (Fig. 21-25). The event is split into three parts. The duration of
each part can be adjusted.

= 0:00:00.0 (=] 0:00:00.0
| 1 V. 1 1 | | 1 1 1 | I I I I I I T I
or
= 5
(<)
Add new scene event 'I"‘}l @>
[ Add new physics event

A Figure 21-25

A Figure 21-24

» The settings of the animation, such as height, distance and gyration, can be modified in the event properties (chapter 21.5).

o Store Visualizer allows you, if you wish, to automatically add cameras that will follow the product animated by a viewer event. Select
the event and click your right mouse button to open “the contextual menu”. Choose “Add camera events to follow the product’.
Two camera events will automatically be created on the camera track in parallel with the viewer event (Fig. 21-26). These cameras will
automatically be calibrated to follow the animation created by the event.

0:00:00.0 .@ Attention: tracking cameras cannot be added if another camera event is already

| | present above the viewer event. Remove or move the camera event to insert cameras
Q Q to follow the product.

(R

A Figure 21-26
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21.5 Event properties

o Each event present on the timeline has properties and settings that can be modified at any time.

¢ Select the event the properties of which you wish to modify.

o Next, click the “Open event properties” icon situated next to the timecode. The “Event properties” window will open.

21.5.1 Properties of camera and physics events

Event name:

Eventlength: [0.5 sec

Event name:

Eventlength: [3.0 sec

scene.

This physics event will affect the entire

o Event name: The name of the event.

o Event length: Total duration of the event on the timeline, in seconds.

The physics event properties window will also specify whether the event in question affects part
of the scene or the entire scene.

21.5.2 Properties of the scene event

Event name:

Event length:  |0.5 sec

Bathroom 31
Kitchen 133
Living room 24
Base layer 69
Bedroom 01 20
Bedroom 02 80

Mezzanine 57

o Layers used: Lists the names of the layers used in the selected scene event (see Chapter 10), as well
as the number of objects in each layer that will be affected by this event.

By default, all layers are added to the list and may be affected. You can “Add” or “Remove” layers from
your scene event. Select the Layer in the event properties you wish to modify. Right-click to open the
“contextual menu”. Select the desired entry.

Add marked layers
Remove layer from event

Store Visualizer 25.11
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21.5.3 Properties of the viewer event

Event name:

Event length: |3 o sec

Intro length: Il.O E sec
Extro length: |1.0 E sec
Distance: m cm
Height: m cm
Steepness: ITE
Gyration speed: ITE revfs
Gyration angle: ITE deg

o

(e]

o

Event name: The name of the event.

Event length: Total duration of the event on the timeline, in seconds.

Intro length: Duration of the first part of the event animation, when the object leaves its initial position.
Extro length: Duration of the third part of the event animation, when the object returns to its initial position
Distance: Maximum distance reached in the direction of travel of the object during the animation.
Height: Maximum height achieved by the object during the animation.

Steepness: The incline of the displacement curve of the object during the animation.

Gyration speed: Determines the speed of gyration in revolutions/second of the object during the second
part of the animation.

Gyration angle: Determines the angle of gyration.
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21.6 _Showing/hiding the path of the camera in the scene

The camera path defined by the events present on the camera track of the current sequence can be shown and manipulated graphically. The camera
positions associated with the events are represented by blue squares (or red when a camera event is selected). These positions are connected by
straight lines or curves. These represent the path taken by the camera during the playback or export of the video sequence.

@ o Click the “Show/hide camera path in the scene” icon situated above the timeline. The path of the camera (blue line) as well as the
position of the camera events (blue square) are displayed in the scene and can be modified. Click the icon again to deactivate the mode.

« You can freely move the positions of the cameras. Click the blue square symbolizing a camera event (Fig. 21-27) and move it to the
desired location. The movement will be in the horizontal plane. Press Ctrl during the movement to modify the height of the camera. The
path taken by the camera will alter according to your changes. This may affect the speed of movement. It is recommended that you
check the result of your modifications using the real-time playback of the sequence.

The shape of the lines indicates the type of camera event:

. o A straight line represents a camera event that ends with a
e T delay before triggering the next camera event.

o A curve represents a succession of connected camera
events.

| o A gap between two points indicates that the next camera
. event is instant.

Ao a0 o

A Figure 21-27

e The “Layout view” function (chapter 3.1.5) allows you to have a complete overview (Fig. 21-27) of your scene, of the position of your
camera events and of the path taken by them. You can therefore easily identify camera tracks that risk crossing objects, shelves, etc.
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21.7 Exporting the video

By default, when you export a video, you export the entire timeline with all the events on the active tracks. If you only want to export part of the timeline,
set an input point (IN) and an output point (OUT) on the timeline. This will only export active tracks between these two points!

0:00:00.0

e Click on the IN and OUT sliders and hold the mouse down to move them to the desired
position.

21.7.1 Exporting the video

» Click the “Export movie” icon situated above the timeline.
» Enter the name of the video file you wish to export. By default, the video will be encoded in H264.

e The “Movie export settings” window will appear (Fig. 21-28). Select the video encoding settings in the list of predefined options
(chapter 21.7.2) and then click Proceed to export the video.

* When the video is exported, you can view your video immediately by clicking Play (Fig. 21-29). Store Visualizer will automatically open
the video with your default multimedia player.

Movie export settings =]

Select a video encoding preset

Movie export =]

For the web (SD)
For the web (HD)

Quick preview v‘

Ry
E 1) The movie was successfully exported,

For broadcast or editing

| close ‘ Play |
I Video settings

-
|

High quality presentation H

| Video encoder n

A Figure 21-30
A Figure 21-29 o
A Figure 21-28

200

Store Visualizer 25.11



21.7.2 Predefined video encoding settings

Setting the video encoding is not always easy. We suggest that you choose from several predefined settings (Fig. 21-30) that refer to the use of the
video:

o Quick preview: You wish to view the result of your video quickly, without being too concerned about the quality and size of the
image.

o For the web (SD): You wish to broadcast your video on the web but do not want too high an image resolution (360p).
o For the web (HD): For broadcasting your video on the web in HD quality (720p).

o High quality presentation: Ideal for presentations. The video will have an HD image resolution (720p) and will use a higher
antialiasing filter.

o For broadcast or editing: Video of maximum quality and full HD resolution (1080p) for editing or for broadcasting on full HD media
(1080p).

o Custom: For advanced uses, you can personalize the encoding settings. See chapter 21.7.2.
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21.7.3 Video encoder and video settings

If the encoding settings presented above do not suit the desired use, Store Visualizer lets you personalize all the video encoding settings.

Movie export settings =]
T S S—— o Format: Lets you select a video encoder. The encoder selected by default is H264. The available
R -] formats depend on your operating system and the codecs you have installed.
= video encoder o Profile: Lets you choose the H264 profile used for encoding. This setting is only available on Windows.
L H_‘m Gvedeo | o Quality: Determines the encoding quality of the video. A video of minimum quality will be more
R [T °] compressed (its file will be smaller) but will have significant graphic artefacts (image pixilation).
e |G i o Framerate: Represents the number of images displayed in one second.
= i S o Image size: Proposes the standard image sizes. You can personalize the size if required.

Image size: [HD 1080p 16:9 (1920 x 1080) _~ |

o Antialiasing: An additional antialiasing filter can be applied to increase the quality of your video.
Antialiasing: |H\gh '|

o Resolution: This is the size of the image in pixels.
Resolution: |1820 E x |1080 pr 9 P

= Color management

Color space: |Autnmat\:

1 o Color space: The color space used to encode the video. In automatic mode, BT 601 is used for SD
™ Adjust for QuickTime gamma \ video and BT 709 for HD video. If you encounter problems connected with the color management of the
| = : ‘U video on a non-standard player, you can manually select the appropriate color space.
Procee Cancel
= — . ; o Adjust for QuickTime gamma: Tick the box if the exported video is intended to be displayed in
A Figure 21-31 QuickTime player.
Autormatic +
Automatic

SD - ITU-R BT 601/ SMPTE C
HD - ITU-R ET 709

The final quality of your video will depend on the video encoding settings. Attention: the higher the quality, the longer the export time
and the greater the size of the video file. All this also depends on the total length of the video.
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Chapter 22 : VR headset compatibility QpenxR. O VIVE 0Q Meta Quest

22.1 Introduction

Due to the quality of its real-time 3D graphic rendering, Store Visualizer simply had to be compatible with the new generation of VR headsets. Wearing
a Virtual Reality headset, users have the sensation of being immersed in the 3D virtual world.

Store Visualizer is compatible with the following headsets: Vive Focus Vision, Vive Focus 3, Meta Quest 3 as well as the older Meta Quest 2 and
HTC Vive Pro Eye headsets. The latter two headsets are still supported, but are no longer recommended.

e Install the headset drivers on your computer by following the manufacturer’s installation.

« To connect most modern Virtual Reality headsets to Store Visualizer, we use the OpenXR API. By default, the OpenXR extension is enabled in
the preferences. Make sure it is active by right-clicking on the render surface. The main context menu will appear. Select: File > Preferences
> plugins > OpenXR.

e When the VR headset and controller drivers are correctly installed, the OpenXR icon (or the icon of the connected headset) appears at the
bottom right of the information bar. This icon indicates the status of OpenXR: unavailable when no headset is connected, inactive when the
headset is connected but not in use, and active when the VR headset is currently in use.

, DpenXR una\railahlel VR inacti\re| VR active

« To start the simulation, place the VR headset on your head. The simulation switches to Active mode. If the headset does not automatically
detect that it is on your head, press the F12 key to activate or deactivate it. You can also click on the OpenXR icon.

Further information on installing Meta Quest and Vive Focus headsets can be found on our Help page.

It is strongly recommended that you take into account the required configurations concerning the computer hardware to be used,
depending on the 3D project you wish to view to avoid latency effects! Note that for a few seconds at the start of use, the simulation
could be slow due to the stabilization of the LOD cache.

Prolonged use of a VR headset can cause a number of undesirable symptoms (e.g., epileptic seizure, migraines, etc.). Please
carefully read the manufacturers’ warnings in that respect before using this type of device.

cici
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22.2 Moving around the 3D environment using VR

There are two ways to move around the 3D environment in VR. Either you navigate using a controller because you are physically constrained to a
fixed position (sitting or standing) or you move physically in what will be called the room scale mode.

22.2.1 Moving using controllers

 To navigate around the 3D environment while remaining in a fixed position (sitting or standing), use the controller combined with your headset.

o Move using the controller:

= Click and hold the or of the on the controller to move forwards or backwards.

o Rotate the view:

= Simply turn your head with the VR headset and you will move in the direction you are looking.

= Gently tap the on the controller to the or to rotate the 3D view 45° in the desired direction.

Activate this function in: Preferences > Plugins > OpenXR > Navigation > Enable manual turning in room
scale.

:g Moving around the 3D environment using a VR headset while remaining in a fixed position may increase undesirable symptoms. To avoid
these symptoms, it is advisable to move slowly and avoid going through 3D objects.
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22.2.2 Moving around a simulation space (room-scale)

e To navigate around the 3D environment by physically moving around the simulation space, please follow the VR headset manufacturers’
instructions in order to configure your movement space most effectively!

o Move around the 3D environment:
= Walk normally in the simulation space.

o Rotate the view in the 3D environment:
= Turn your head with the VR headset.

:Eci For safety reasons, VR goggle manufacturers have developed what they call the Guardian system in order to mark out a simulation area
that is not to be crossed. We recommend that you configure the Guardian system as effectively as possible! This system creates a virtual
grid that is displayed in VR if you are about to leave the simulation area set up. Keep in mind that the Guardian system only alerts you when
you are about to leave the simulation area you have defined. It does not prevent you from leaving it, nor does it warn you of any obstacles
that you may collide with, that you may knock against or that may cause you to fall, including those at height.
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22.3 Interacting in VR

Interaction with 3D objects in the virtual world is done using controllers. With these you can pick up 3D objects, observe them, move them and much
more. If you have two controllers, you can also pass 3D objects from one hand to the other, pick up a 3D object in each hand, etc.

Activate the Physical simulation in automatic mode (see chapter 15) to increase realism during your interactions. Collision between 3D
objects and gravity will be taken into account.

o Pick up a 3D object using the controller:

= |f the controller(s) are active, a 3D controller representing them will appear in the VR simulation.

= Approach the 3D object you want to pick up. Extend your arm with your controller towards the 3D object, as if you
actually wanted to pick it up.

= Click on the frigger on the controller to pick up the 3D object. If you are the correct distance away, it will attach to
the controller. You can now turn your hand in any direction, the 3D object will remain attached to the controller. Click
the trigger on the controller a second time to release the 3D object.

= In some cases, the 3D object you have picked up is not well positioned on your controller. In that case, press the
or on the controller to realign the 3D object. It will then automatically position itself on top of the controller.

The user will only be able to interact with 3D objects defined as standard models and that are not frozen!
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Chapter 23 : Preferences

To access the Preference pages, right click anywhere on the gray empty area (the 3D render area). The main contextual menu will appear. Select
File > Preferences. The “Preferences” dialog window will appear.

23.1 System settings

Transparency and refraction
5 5 Plugins

HTC Vive

Stereo settings

Oculus Rift

Placement report

[EICI;

Preferences X
CHTETE GUI settings
= & system settings [+] ¥ Use native dialogs Therme:
 enabl ol s
It eraiiviy, ¥ Sidebar open by default
Project
Eu\ur management Cire
= 5 Paths & directories
File paths [Mormal (98 DPI/ 100 %) -~
Search paths \
=1 £ 3D settings =| [Language
Textures I~ Get languags from system
Quality and performance
Shadows and lighting [English f United States [en-us] -
Reflections

Welcorme screen \

{ I~ show weleome screen at startup

[ canca \]

\
Normal (96 DPI/ 100 %) v

Normal (96 DPI/ 100 %)
Large (144 DPI 150 %)
Wery large (192 DPI/ 200 %)

* GUI settings (User interface settings)

o Use native dialogs: Use the native windowing system of the host operating system
for Store Visualizer dialogs.

o Enable tool tips: Enable the display of help tooltips when hovering over Ul items.

o Sidebar open by default: Open the sidebar when starting Store Visualizer.

o Theme: The user interface color theme (Light or dark colors).

e User interface size

o Normal: Use the normal option on displays with a standard DPI, such as full HD
displays.

o Large and very large: use these options on high DPI displays, such as 4K displays.

e Language
o Selects the user interface language.

* Welcome screen
o Shows the welcome screen everytime Store Visualizer starts.

Store Visualizer 25.
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Preferences

Category

= & System settings
User interface
Project
Color management
= £ Paths & directories
File paths
Search paths
= 30 settings
Textures
Quality and performance
Shadows and lighting
Reflections
Transparency and refraction
= &5 Plugins
HTC Vive
Stereo settings
Qeulus Rift
Placement report

Navigation settings

W Invert vertical mouse
¥ Limit vertical angle
™ Enable walkthrough

Sensitivity

Navigation devices

¥ 3D multi-axis controllers
I Multitouch Navigator

Q

Object selection

Wirewidth; 1 ' 1
i1 ! . !

Wire size:

» Navigation settings

o Invert vertical mouse: Invert the vertical movement axis of the mouse for navigation.

o Limit vertical angle: Limit the vertical viewing angle to the bottom - top range,
avoiding over-turning of the navigation camera.

o Sensitivity: Changes the sensitivity of the mouse tracking movements. Move the
cursor to the left to reduce the sensitivity of the mouse and to the right to increase the
sensitivity.

\

Navigation devices: List of all navigation devices connected to your computer that are
recognized by Store Visualizer. Select the device from the list and click the “Configure
selected device” icon to adjust its parameters.

* Object selection

o Wire width: The width of the selection gizmo.

o Wire size: Size of the selection gizmo.

Preferences

Category

1 (& System settings
User interface
Interactivity
Color management
=1 £ paths & directories
File paths
Search paths
=1 3D settings
Testures
Quality and performance
Shadows and lighting
Reflections
Transparency and refraction
= &5 Plugins
HTC Vive
Stereo settings
Oculus Rift
Placement report

R

x
Project settings

Default distance unit: |cm i

Default weight unit:

Default author: [

Default report form

[0 defadlt - ask me as needed -

* Project settings
o Default distance unit: The default distance unit used by Store Visualizer.
o Default weight unit: The default weight unit used by Store Visualizer.
o Default author: The default author assigned when creating new projects.

o Default report form

o The report form used by default (only available when multiple report form plugins are
loaded).
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23.2 Paths and directories

Preferences X
— e |_» Search paths: Search paths define the locations where Store Visualizer will search for
ategory . .
= System settings 2| | [Texture search paths 7 resources when loading a project.
User interface
SDATAPATH/TxCach .
e T £ o Texture search paths: Search paths for texture files.
Color management $PROJECTPATH/Textures & )
= B paths & drectories S e o Scene search paths: Search paths for 3dw scene files.
e |
o | | |SoaTapaT atarialsaps o Library search paths: Search paths for I3dw library files.
Textures $SVSPATH/MatsHa\S/MapS 3
Qualtyand performance o HDR sphere search paths: Search paths for vtcep spherical environment files.
adows and lighting
Reflections
Macro | Description [ | . :
o SUmtron | Pathco tser doumens folder o Planogram asset search paths: Search paths for planogram files.
LLTC”@,T; $DATAPATH  Path to application data folder
Stereo settings = FPROJECTPATH Path to loaded project
Oculus Rift =]
Placement report =]

23.3 Graphics system information

Preferences X

Category Graphics system information

=1 (8 System settings = . . . . . . .
T [7| wendor  vibiA Corporation * 3D settings: this page displays information relating to your graphics card, as well as to
S Model NVIDIA GeForce RTX 4090/PCle/SSE2 the basic system (graphics card model, graphics memory, OpenGL driver, processor and
Color management eTon | e basic system memory).

= £ Paths & directories OpenGL 46
File paths GLSL 16
Search paths

E| i OpenxR Oculus [1.113.0]
Textures i

Quality and performance

Main system information
shadows and lighting

Reflections CPU Model  12th Gen Intel(R) Core(Th) 19-12900K
Transparency and refraction
o Memory 65291 MB
= & Plugins

Stereo settings

Meta Quest Systern report
OpenXR

Consumer insights

(EI0]
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23.4 Textures

Preferences

Category

F1 & System settings
Userinterface
Interactivity
Project
Color management

= (3 Paths & directories
File paths
Search paths

=1 3D settings
Quality and performance
Shadows and lighting
Reflections

= £ Plugins
HTC Vive
Stereo settings
Gculus Rift
Placement report

Transparency and refraction

General settings

¥ Enable optimal resizing
¥ Convert 16hit maps to 8bit

Filter:

Best available i

Texture detail level

= Reqular textures
Limit reselution:
Cornprassion:
= High detail textures
Limit reselution:
Cornpression:
= Static textures
Limit resolution:
Compression:
Product viewer textures

10241024
Onily large textures

20482048

Only large textures

2048x2048
Only large textures

fE EE EE

» General settings: The following settings trade memory usage and performance for quality:

o Convert 16 bit maps to 8 bit: Convert 16 bit textures to 8 bit textures while loading
(reduces memory usage).

o Filter: The filter type used for textures (default: best available). A high setting (anisotropic
or better) is very important for good quality.

o Texture detail level: In order to control memory consumption, we have divided the
textures (material layer images) into 2 groups: regular textures and high detail textures.
This selection is made by library (see chapter 5.9.2).

e Regular textures: Limits the resolution and compression level of standard textures.
Standard textures are the images present in the color layers of the materials.

o Control maps: Enables the resolution of Control maps (reflection layer images) to
be limited.

o Normal maps: Enables the resolution of Normal maps (bump layer images) to be
limited.

« High detail textures: Limit resolution and compression level of important and high priority

textures (including those from high priority libraries).

o Static textures: Limit resolution and compression level of the textures from the static

environment.

e Product viewer textures: Enables the resolution and compression level of a product’s

textures to be selected when using the product viewer.

Texture resolution: Store Visualizer can handle texture resolutions of up to 8K. It is very important and preferable to limit texture resolution

depending on the type of project you are building. The higher the texture resolution, the higher the memory consumption on the graphics
card. See chapter 24.3.1.
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23.5

uality and performance

Preferences

Category

= (& System settings
User interface
Interactivity
Project
Color management
= £ paths & directories
File paths
Search paths
= () 3D settings
Textures
shadows and lighting
Reflections
Transparency and refraction
= E3 Plugins
HTC Vive
Stereo settings
Oculus Rift
Placement report

Ir

[EIDIM

|9 samples (M+SSAA) v‘

Antialiasing filter ‘

Texture settings

™ Use on the fly BC7 compression when available
[ Use seamless cubemaps if supported

Video memory strategy
[Balanced memery and performance -]

=5

» Antialiasing filter: Selects the type and quality of the anti-aliasing filter used to reduce
jagged edges in the rendering. Antialiasing will significantly increase the quality of the
rendering, but its use can decrease performance (see chapter 24.3.2).

Antialiasing filter

2 samples
4 samples
8 samples
9 samples (M+SSAA) -

Other 3D parameters: The other 3D Parameters windows contain parameters specific to visual control. These data are automatically
adjusted to your system when Store Visualizer is installed. Modifying these settings can seriously degrade performance and render the

application faulty or unstable. These parameters must not be modified without prior advice from technical support.
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23.6 Plugins > Virtual Reality headset

23.6.1 OpenXR

Store Visualizer supports several virtual reality headsets, such as the Vive Focus 3, the Meta Quest 3, as well as their respective controllers. These
devices are managed via the OpenXR API, which is enabled by default.

Preferences

Category

=1 & System settings
User interface
Interactivity
Project
Color management
2 & Paths & directories
File paths
Search paths
=1 3D settings
Textures
Quality and performance
shadows and lighting
Reflections
Transparency and refraction
= 3 Plugins
Stereo settings
Meta Quest

Consumer insights

[<[v]

x

General settings
¥ Enable OpenxR support
¥ Use eystracker if available

I~ Enable eyatracker test setting

|

¥ Disable product reflections

|

Navigation
¥ Enable manual turning in room scale ‘

23.6.2 Meta Quest 2

Preferences

Category

515 System settings
User interface
Interactivity
Project
Color management
2 E Paths & directories
File paths
Search paths
=1 ) 30 settings
Textures
Quality and performance
Shadows and lighting
Reflections
Transparency and refraction
= &5 Plugins
Stereo settings
OpenxR
Consumer insights

o]

General settings
I™ Enable Meta Quest support
¥ Enable proximity sensor

¥ Automatically disable ASW

[¥ Disable product reflections

Calibration

Calibrated for reom scale

|
|
[
|

Navigation
¥ Enable manual turning in room scale ‘

o Enable OpenXR support: Allows you to enable or disable the OpenXR API, particularly
if you wish to use an older headset.

o Use eyetracker if available: Allows you to enable or disable the eye-tracker integrated
into the virtual reality headset, if it is equipped with one.

o Enable eyetracker test setting: Enables a function that allows you to test the eye
tracker.

o Disable product reflections: In order to enhance performance at the expense of
quality, you can deactivate product reflections on reflective surfaces.

o Navigation: Enables use of the joystick positioned on the controller for easier
navigation in room scale mode. Using your thumb, gently tap the joystick to the left or
right to rotate the 3D view 45° to the left or right.

The extension for Meta Quest 2 VR headsets remains available. You may prefer it over the
OpenXR APL. If you wish to use it, we recommend manually disabling the OpenXR plugin,
then enabling the Oculus Rift HMD plugin.

Calibration x
Wh‘:fw“”jﬂ“’““”m'wm“‘"g? Older headsets required calibration. Please follow the
Seated experience . . .
SFrr calibration steps if prompted.

Room scale uses the Oculus Guardian system.

For calibration, please use the Oculus setup tool m We no |Onger provide SuppOI‘t for these types Of
headsets.

oK
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23.7 Stereoscopic rendering

Preferences

User interface
Interactivity
Project

Category
B {8 System settings -

Stereo rendering control

W Enable stereo mode

Output device:

[Quad buffered stereo (qBS) -

Color management
= £ Paths & directories
File paths
Search paths
= () 3D settings
Textures
Quality and performance
Shadows and lighting
Reflections
Transparency and refraction
= &5 Plugins
HTC Vive
Oculus Rift
Placement report

]

For a full explanation on the operation and use of stereoscopic rendering mode for Store
Visualizer, please consult the document created by Esko by clicking the following link:

SV - Stereoscopic rendering information.
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23.8 Quickbar settings

You can change and customize the quickbar and create your own user profiles.

L

Vertical mode
Position

Close quickbar
Edit...

Beginner

+ Advanced

A Figure 23-01

Vertical mode: detaches the bar from its initial position and displays it in a vertical position.
Position: allows you to move the quickbar to another position on the screen or to make it float.

:n ; ¢ Click on the “Quickbar settings” icon located in the quickbar.
* A drop-down menu appears from which you can select different options (Fig. 23-01), such as the possibility to change user profiles, etc.

Close quickbar: closes the quickbar.
Edit: opens the “Edit quickbar’ window (Fig. 23-02). This window allows you to create and edit your own user profile.

Edit quickbar

|Eeg|nﬂer

B

Fege edE@DD

Bre @

<Separator>
Project

Create new project

Open a project

Save project modifications
Take snapshot

Undo

Redo

Open product manual

Medels and library

Import & 30 model

Import an image

Create a shelf

Open a library

Model to library

Toggle product meta data info panel
Physics

Start or stop physics simulation
Physics drag mode

Sleep physics simulation
Layers

Current active layer selector

P
-

-
=

(I [ Teal»

[l LT ) )

@

Create new project
Open a project
Open a library
Import a 30 model
Impert an image
Create a shelf

Open product manual

A Figure 23-02
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Chapter 24 : Performance

24.1 Minimum system requirements

The primary cause of performance issues is the use of inadequate equipment. Ensure your computer meets the minimum requirements for Store
Visualizer. We recommend that you contact one of our salespeople and consult the website for more information on the equipment to be acquired,

taking into account your needs: Store Visualizer system requirements.

24.2 Graphics memory

Store Visualizer requires a powerful graphics card to display real-time 3D rendering. The graphics memory of the card will be used to store among
other things the images/textures of your 3D models. If you want to work on complex projects with many different 3D models, with high resolution
textures, opt for a graphics card with a lot of graphics memory. Modern graphics cards offer a range of between 8 and 48 GB of graphics memory.

24.2.1 Graphics system information

To easily find information about your graphics card, click on the “Graphics System Information” icon (Fig. 24-01). Select Graphics system
information from the drop-down menu (Fig. 24-02).

L ST = e Graphics system information: located at the bottom right of the interface, this icon opens the
BlUE 28|90 Preferences>3D settings window, which contains all the useful information for your computer: type of
» Model lighting b graphics card, graphics memory of the card, processor and memory of the basic system. See chapter

v Model physics 4 24.3.
= M « Optimize video memory: Allows you to manually unload unused video memory if it has not been
| © rittinactve | | ()] unloaded automatically. When you make changes to your project, such as turning layers on or off,
A Figure 24-01 loading or closing 3D model libraries, your video memory consumption changes. Up to a certain

percentage level, your video memory will only increase and will not be emptied automatically.
Graphics system information You can manually unload the video memory at any time by clicking on Optimize video memory. A
Optimize video memory message in the information panel will show you how much video memory has been freed up (Fig.
A Figure 24-02 24-03).

QI@%@EO@‘HS@M:

ﬁ L',l ||Optimizmg wideo memory, 3026.2 MB were freed I
A Figure 24-03
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24.2.2 Graphics memory gauge

A gauge shows the graphic/video memory consumption of your project using a color code. The color of the gauge is never fixed and varies according
to the changes you make to your project such as: importing new 3D models, opening or closing 3D libraries, activating or deactivating a layer, a

variation, etc.

I T
POy 2| 20
I Model lighting 4
+ Model physics 4

%I More Actions  «
| © Riftinactive |=_‘ |@]|

Graphics memory gauge: this gauge, located at the bottom right of the interface, indicates the
graphics memory consumption of your project. The more graphics memory your project consumes, the
more the gauge fills up and gradually turns red.

| = EET Ty Taf

%I More Act\cns/A

Position your mouse over the gauge for a few seconds to display a help bubble with a percentage of

[Graphics memory usage is at 7% (962MB

the current graphics memory use.

When your memory consumption is very high, an additional message will appear in the information panel, warning you that you may have performance
problems (Fig. 24-04). Please refer to Chapter 24.2.1 for a solution.

o |l @L,,JI

L 80008 ®0Q & B

ﬂ r_’_) | You are running low on video memory at 96% | You may experience severely degraded performance.

A Figure 24-04

Attention: the gauge only takes into consideration the graphics memory used by Store Visualizer. It does not take into account the
graphics memory used by other software (such as CAD software, etc.) that may be operating at the same time as Store Visualizer.
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24.3 Controlling graphics memory consumption
24.3.1 Layer image resolution management

In the Material editor chapter, you learned that each 3D model was made up of material layers (color, reflection, gloss, relief and transparency) and
that these could be controlled by an image. Each image is stored in the graphics card memory. The memory consumption of each image depends on
its resolution. The higher the resolution of the image, the more graphics memory it consumes.

There are several ways to control layer image resolution:

¢ 3D model import: When a 3D model is imported, all images present in the material layers of the model will be imported at their maximum
resolution. The maximum resolution supported by SV is 8K.

» Preferences>3D settings>Textures: Set the texture detail level correctly. Textures are the material layer images explained above. Itis strongly
recommended that you limit the resolution of your textures according to your needs. For example, if you imported a 3D model containing a color
layer with an image with a resolution of 8K, you can limit it to 1K or 2K. You can also limit the resolution of Control maps (reflection layer images)
and Normal maps (bump layer images). The resolution of these textures rarely needs to be as high as the color layer image.

In order to control your memory consumption, we have divided the textures into 2 groups: regular textures and high detail textures.
This selection is made by library (see chapter 5.9.2).

By default, regular textures are limited to 1024x1024 resolution with Control and Normal maps at 768x768. High detail textures are limited to
2048x2048 resolution with Control and Normal maps at 1024x1024.

24.3.2 Antialiasing

Antialiasing is a filter used to reduce the jagged edges of the rendering. This filter will significantly increase the quality of the rendering, but this will
be to the detriment of performance.

Since part of the antialiasing (up to 8 samples) is performed by the graphics card driver, Store Visualizer cannot display in the gauge
the direct impact of antialiasing on the graphics memory! If you experience performance issues, do not hesitate to check the level
of antialiasing used and reduce it.
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24.3.3 Geometrical complexity of 3D models

As described in chapter 5.4, the geometrical complexity of your 3D models also affects performance by using graphics memory. It is therefore very
important to create optimized 3D models! Models have to contain the quantity of polygons required to achieve the required visual quality, but no more.
Adding more polygons will not increase visual quality but can significantly degrade rendering performance. Many 3D models available on the internet
are not suitable for real-time simulation.

¥ Libraries 4 To get an idea of the complexity of the 3D models you have imported, activate the “Show complexity”
m‘ @ function (chapter 5.1). A gauge representing the geometrical complexity of each 3D model is displayed in
= front of them. The complexity of a model changes depending on the quantity of polygons in the model and

Dews “ also depending on the visual effects used (e.g. transparency). The higher the complexity of a model, the

L‘_’a_d"‘ more the gauge will be filled and will turn red. Using numerous complex models in your 3D environment will

adversely affect rendering performance

+  Show complexity

es

ElWater - Plastic bottles
U PET water bottle
F B heattlac

YEIB L& D

& [y

24.3.4 Screen display resolution

The display resolution of your screen can also impact the rendering performance of Store Visualizer by consuming your graphics card’s memory. On
conventional HD screens (1080p) consumption is minimal. On the other hand, if you work on 4K and especially 8K screens, the Windows operating
system will consume a huge part of your card’s graphics memory. Unfortunately, this memory consumption is not taken into account in the Store
Visualizer gauge.

If you are working on an 8K screen and are experiencing performance issues, consider investing in a graphics card with maximum
graphics memory.
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24.3.5 Virtual reality

The use of a Virtual Reality (VR) headset has a significant impact on graphics memory consumption. Unfortunately, as headsets are managed by an
external driver, the consumption is not taken into account in the Store Visualizer graphics memory gauge.

The use of Virtual Reality generally consumes between 1 or 2GB of additional graphics memory.

24.3.6_Sunlight

The use of sunlight (described in chapter 16.5) affects the rendering performance of Store Visualizer. If you experience performance issues, do not
hesitate to turn off the sunlight to see if the loss of performance is due to the sunlight.
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Chapter 25 : Icons and functions

25.1 Navigation panel

<;] Switch to previous camera

@ Navigation 31 O Switch to next camera 37
Enable free look mode 31 2=+ | | Toggle movie timeline visibility 185

O =
= | | Orbit around target 32 Toggle layout view 34
& =l 81
S Select orbit target point 32 f Rotate view 81

© )
Height 33 More actions > Edit camera settings 38
Speed 36 More actions > Film and lens settings 40
';[IF' Add a new camera 37 More actions > Align camera to nearest axis 34

37
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25.2 Object panel

%

- Object control 41 : Snap and alignment settings 90
N @
Change manipulation mode 64 | Change transform coordinate system 68
75
I:} Select objects 64 | Anchor: change transform pivot point 68
Create a new object 62 — | | Replace model of all selected objects 69
" E Create an object array 70 LQ Product viewer 175
@ Move selection 65 More actions > Delete 69
@ Rotate selection 65 More actions > Array settings 70
Scale selection 66 More actions > Panel positions 82
Auto select 67 More actions > Snap frames to frames 90
K Affect X axis 65 More actions > Store layout view 81
W Affect Y axis 65 More actions > Product viewer settings 176
f
Affect Z axis 65

Store Visualizer 25.11
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25.3 Environment panel

E Environment 164 Lﬁ| Stereo and multi-display control 165

@ Environment type settings - @ Refresh reflections 166

:3 Tonemapping settings 164 @ Edit reflection spheres and zones 166

{"j Open sun light settings 171 @ Open reflection zone settings 167

]| | Adjust static elements 168

=

25.4 Physics panel

;a. Physics 141 @ Put scene to sleep 144

D Start simulation 141 {rg Toggle between physics or conventional move 145

Stop simulation 141 {gﬁ Drag object by its pickup point 146

— || Add all currently selected objects to the simulation | 143 Ii' Show model with collision envelopes 148
., || Change simulation mode 142 Show collision envelopes 148

&
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25.5 Interface
EJ Help 14 @ Graphic system information 215
ﬂ Show information about the project 28 | Graphics memory usage (%) 216
Q Save project modifications 25

25.6 Sidebar
= System Open the “System” tab.
Tools Open the “Tools” tab.

Scene Open the “Scene” tab.

C| 1S
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25.7 File

o In the system sidebar, select: System > File.

Open project from list

Show preset information

Remove project from list

Ge| ||| B

Clear entire project list
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25.8 Command history

e In the system sidebar, select: System > Command history.

Undo entry

&)

Redo entry

Goto history entry

Redo all inactive entries

Collapse all entries below current

ol |52 ||| [

Remove all entries above current

IC
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25.9 Libraries

 In the system sidebar, select: Tools > Libraries.

E Models 42 Ej Copy 42
ﬁ Assemblies 42 & Cut 42
q Search entry 42 th Paste 42
Library 42 Delete from library 42
15 55 | |88
- | | Important library 61 Toggle library icon view 57
2 =
@ Import model or resource 43 Change icon size 57
@ Import image 49 | Create folder 56
E Create a new model or resource 83
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25.10 Model browser

 In the system sidebar, select: Tools > Model browser.

— .| | Rotate model 51 Edit shelf metrics 80
© 7
@ Pan model 51 Manage areas of interest (AOI) 51
Q Zoom model 51 D Model complexity (number of faces) 50
Center model 51 = Model contains reflection or refraction 51
— || Model side views 51 Select by current model 51
& =
—— | Model view options 51 Refresh the model and textures 51
@
::E] View or assign model sides 52 ? Show or edit anchor points and lines 87
(u]
EF Show model dimensions 51 :—! Edit raytracing surfaces 126
- Show model with the range of the lighting 132 = Level of detail settings 53
Y 0
e
Iil Show model with collision envelopes 148 @ Select reflection environment 51
Show collision envelopes 148
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25.11 Scenegraph

e In the system sidebar, select: Scene > Scenegraph.

q Search entries 103 @ Freeze or unfreeze objects 105
? Filter entries 104 'EI Group object 106
@ Refresh filter 104 Open group 103
w Select none 104 E Object array 103
[:f} Select all 104 Hl}:l Group objects 106
W Selected object 103 a Dissociate current group 106

= Show / hide object 105 Explode current group 106
- "

228

Store Visualizer 25.11



25.12 Material editor

e In the system sidebar, select: Scene > Material editor.

Pick material from a model 108 = View (color/ reflectivity/ glossiness/ embossing/ | 114
b q opacity) image

Material actions 108 Modify (color/ reflectivity/ glossiness/ embossing/ | 114
I:j '{Ir:' opacity) map
- Open material presets 108 Modify (color/ reflectivity/ glossiness/ embossing/ | 114
E 117 opacity) map

25.13 Material presets

 In the system sidebar, select: Scene > Material editor > Open preset windows > Material presets.

';[IF' Create a new preset from current material 117 Eﬁ Activate selected preset 117
ﬁ Remove selected preset 17 @ Default materials 117

Create a new folder 117 . User materials 117
= &
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25.14 Creating and editing a video
« In the Navigation toolbar, click the Toggle movie timeline visibility icon.

) Toggle movie timeline visibility 185 Move cursor to the start / to the end of the sequence | 191
= 0d
'{,I:' Creating a new sequence 185 @ Move cursor to the previous / to the next event 191
a Deleting an existing sequence 186 '{,I:' Add new camera event 187
Activate or deactivate a track 186 Add an event to the scene track 192
=
Activate cursor 191 —— | | Open event properties 197
]
D Start or stop realtime playback 191 EF Showing / Hiding the path of the camera in the 199
scene
25.15 Model meta data
 In the system sidebar, select: Scene > Model meta data.
Add new fields 134 Show product meta data 134
'{rl:' 135 E;I 139
Import meta data 134 = Edit product meta data info panel 140
@ 136 Lﬂ
ﬂ Remove selected fields 134
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Chapter 26 : Shortcuts

F1 Help EJ
F2 Product manipulation mode
F3 Shelf creation mode
F4 Store design mode
Space [ Enable free look mode o
s Select objects Q
c Create a new object LJ}
f Create an object array u‘%
[
m Move selection @
r Rotate selection —_
&
a Scale selection
e Replace model of all selected objects k.{]
o] Product viewer Lq
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v Orbit around target =
j @
X Affect X axis K
y Affect Y axis ‘Q‘j’"
z Affect Z axis 2
t Layout view % I
k Pick a material from a model b
o Model to library
L Auto select
Delete | Remove all selected objects
or
Ctri+d
Shift+f | Array settings
Shift+p | Product viewer settings
Shift +m | Duplicate object + move
Shift +r | Duplicate object + rotate
Alt+r | 45-degree rotation of the selection
Alt+m | Move the selection by 5 cm/ 5 inches
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Ctrl+i | Import model or resource

Ctrl+o | Open file

Ctrl+s | Save

)| | &) | & ||

Ctrl+p | Print

Ctrl+z | Undo P
Ctrl+y | Redo S
Ctrl+x | Cut &
Ctrl+c | Copy E:I
Ctrl+v | Paste tﬁ

Ctrl+f | Freeze current selection

Ctrl+g | Group current selection

j Pick an object to mark in the scenegraph

Shift + j | Shows the objects currently selected in the scenegraph
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Shift | Toggle between physics or conventional move :
+m (Physics module) {1%1
Shift | Toggle weak collisions z
+w (Physics module) Qj}
d Drag object by its pickup point v
(Physics module) et
Ctrl + Switch to previous camera
Left <'Ij
Ctrl + Switch to next camera
Right E:>
b Toggle sidebar visibility
i Toggle fullscreen mode
F11 Enabled / disabled full screen mode
F12 Enabled / disabled VR headset
Shift+s | Stereoscopic On/OFF —
Alt+F4 | Quit —
)
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Third party licenses

This product includes Qt.
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